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Chapter
44 Using the SDL Editor
This chapter describes the functionality, menus, dialogs and win-
dows of the SDL Editor. You can also find information about how 
to use the editor for creating and drawing SDL (Specification and 
Description Language) diagrams.
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General

Editor Information
The editor described in this chapter handles SDL diagrams.

Another editor is capable of handling four different types of diagrams, 
namely the Object Model (OM) diagrams, State Chart (SC) diagrams, 
Message Sequence Chart (MSC) diagrams, and High-level MSC (HM-
SC). That editor is described in chapter 40, Using Diagram Editors.

SDL Diagrams
The SDL Editor can handle any number of SDL diagrams of any type. 
Virtually all of the Z.100 recommendation is supported.

The SDL Editor supports three kinds of SDL diagrams:

• Interaction Diagrams
• Flow Diagrams
• Overview Diagrams

The editing functionality that is available depends on what type of dia-
gram the SDL Editor is handling. 

This chapter describes the functionality the SDL Editor provides when 
you edit interaction and flow diagrams.

In Figure 350–Figure 352, you can find an example of interaction dia-
grams (in the example there is one system diagram and two block dia-
grams) and the resulting overview diagram.
1778 ,um-st1 Telelogic Tau 4.5 User’s Manual July 2003



 General
Figure 350: System diagram
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Figure 351: Block diagrams
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 General
Interaction and Flow Diagrams

The SDL Editor works with SDL diagrams in graphical form, SDL/GR, 
and allows graphical editing of symbols, lines and text. 

You may open multiple windows in an SDL Editor to be shown at the 
same time; each window will hold an SDL page. This can be useful if 
you want to edit different diagrams and pages and refer between them, 
or if you want to see the interface between two processes on different 
hierarchical levels. This is the normal mode in which diagrams are ed-
ited. 

Interaction diagrams are: system, system type, block, block type, sub-
structure, package diagrams. 

Flow diagrams are: process, process type, service, service type, proce-
dure, operator, macro diagrams.

Figure 352: Resulting overview diagram
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Overview Diagrams

You can also use the SDL Editor to view SDL overview diagrams. An 
SDL overview diagram consists of a number of diagrams that are built 
up into a diagram subtree in which the symbols are drawn in a nested 
fashion, giving a more comprehensive overview of a required set of di-
agrams. You may have multiple SDL overview pages associated to one 
SDL system, at different SDL levels, and thus presenting different 
views of the system. You generate overview diagrams in the Organizer 
(using the SDL Overview command), and you can open the overview di-
agrams for display in the SDL Editor. Various parameters allow you to 
generate overview diagrams to meet your requirements.

Once an SDL overview diagram is generated, you cannot modify it in 
the same way that you would normally edit interaction and flow dia-
grams (unless you regenerate it). However, you can do limited editing 
on the text of overview diagrams in the SDL Editor. 

Essentially, the editor works in read-only mode with regard to graphical 
operations. General restrictions in editing Overview diagrams are:

• There is no symbol menu.

• Only textual elements can be modified, not symbols and lines.

SDL Pages
The pages that the SDL Editor displays are always contained within an 
SDL diagram. An SDL diagram can contain any number of pages, but, 
must contain at least one page, and can be any of the following types.

• Block interaction, process interaction, service interaction, package 
(the interaction pages)

• Graph, service, procedure, macro, operator (the flow pages)

• Overview

Relationship between Diagrams and Pages

Pages and diagrams must be associated with each other according to the 
rules of SDL. There follows a list of what type of pages can be added to 
different diagrams and what type of pages can be pasted into those dia-
grams.
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Diagram 
type

Page types that can be 
added to the diagram

Page types that can be 
pasted to the diagram

system block interaction block interaction
package

block block interaction
process interaction

block interaction
process interaction
package

substructure block interaction block interaction
package

service service service
graph
procedure
macro
operator

process graph
service interaction

graph
service interaction
service
procedure
macro
operator

procedure procedure procedure
service
graph
macro
operator

system type block interaction block interaction
package

block type block interaction
process interaction

block interaction
process interaction
package

service type service graph
procedure
macro
operator
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SDL Page Order

The SDL pages that are contained in an SDL diagram are listed and han-
dled according to the order they were added when they were created.

This order is reflected in some of the menu choices that are related to 
SDL pages. Also, the structure displayed by the Organizer will adopt 
the same order. See “Chapters” on page 46 in chapter 2, The Organizer.

SDL pages can be renamed and rearranged by the Edit menu choice in 
the Pages menu.

process type graph
service interaction

graph
service interaction
service
procedure
macro
operator

macro macro macro
service
graph
procedure
operator

operator operator operator
service
graph
procedure
macro

package package package
block interaction

overview overview (one page only) -

Diagram 
type

Page types that can be 
added to the diagram

Page types that can be 
pasted to the diagram
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 General
Tracing Simulations (Graphical Trace)
Graphical trace, GR trace, is a method to follow the execution of tran-
sitions in SDL/GR source diagrams. It is mainly intended to be utilized 
together with the simulator’s Step-Symbol command and should nor-
mally only be used for a small number of processes to limit the amount 
of information displayed. The GR trace facility will always show the 
next SDL symbol within the transition to be executed. After a nextstate 
or stop operation (e.g. between two transitions), the nextstate or stop 
symbol is still selected.

The GR tracing is activated from the SDL Simulator. The SDL Editor 
selects the symbol currently being executed. The Simulator automati-
cally highlights the symbol and displays it. You can use either SDL to 
see what is being traced, or MSC to see the interaction between process-
es.

If you use an MSC to trace the simulation, the instances concept of MSC 
is mapped to the instances concept of SDL processes. The mapping 
rules which govern how SDL events are transformed into MSC sym-
bols, lines and textual elements are described in “Mapping Between 
SDL and MSC” on page 1682 in chapter 40, Using Diagram Editors.

GR trace will take place in an SDL Editor window containing the ap-
propriate diagram. If the SDL Editor does not hold the current page, but 
if the diagram can be found in the Organizer, then the page will be 
opened by the SDL Editor. 

If the Organizer cannot find the diagram, or the SDL Editor cannot find 
an appropriate symbol to select, due to, for example, modifying the di-
agrams after the generation of the simulator, error messages will be is-
sued by the Organizer or SDL Editor, but the simulation program will 
continue to execute without tracing graphically. 

Setting Breakpoints in Simulations
During simulations, the SDL Editor can show all breakpoints that have 
been set in the Simulator. It is also possible to set and remove break-
points directly in the SDL Editor by using the special Breakpoints menu 
that will be shown while this function is operating. The functionality is 
activated by the Connect-To-Editor command in the Simulator. 
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Compliance with ITU Z.100
The SDL Editor complies with the SDL rules as defined in the ITU 
Z.100 recommendation. Virtually all parts of the recommendation are 
supported by the SDL Editor. More information on the SDL support 
compared to Z.100, see “Compatibility with ITU SDL” on page 9 in 
chapter 1, Compatibility Notes, in the Release Guide.

Syntax Rules when Editing
Some of the SDL syntax rules are enforced during editing when you cre-
ate diagrams, add pages to these diagrams, add symbols and lines to 
your pages and edit the text inside the symbols and lines. 

Next follow the syntax checks that are performed by the SDL Editor:

• The SDL Editor checks that names on diagrams and pages adhere to 
the SDL definition. 

• The type of a page that you add to a diagram must comply with the 
diagram type.

• The set of the symbols you are allowed to add to a page is in accor-
dance to the page type. Also, the SDL Editor ensures that symbols 
are interconnected in a way that is syntactically correct. 

• The text that is entered into a symbol or a line is instantly checked 
for syntax errors. When an error is located a red bar will underline 
the text where the error occurs.

Turning Syntax Checking On and Off

The syntax checking for entered texts, for what symbols you are al-
lowed to use, and how you can interconnect symbols can be disabled 
and enabled again.

To disable or enable syntax checking:

1. The operation applies on one diagram at the time. Therefore, make 
sure you are editing the correct diagram.

2. Select the Diagram Options menu choice from the View menu. In 
the dialog which is issued, toggle the Layout Syntax Check and/or 
Textual Syntax Check button on or off and click OK.
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Syntax checking in Kernel Heading and Reference symbol

The syntax check for texts in the kernel heading or any reference sym-
bol is always on independent of the diagram options setting.

Pasting and Syntax Checking

Only symbols that are valid according to what is displayed within the 
symbol menu may be pasted into a page. Non-valid symbols will be 
omitted whether or not syntax checking is enabled.

Identical Symbols – Different Syntax

When layout syntax checking is on, the SDL Editor automatically de-
termines from the context what kind of symbol it is. If syntax checking 
is off, the symbols are always treated as in connector and enabling con-
dition, respectively.

SDL Grammar Help
The SDL Editor provides a versatile context-sensitive support function 
– the Grammar Help window. The grammar help window is available 
to assist you when entering and editing the syntax of SDL text elements 

Note: No Retroactive Syntax Checking

Turning the switch from off to on will not perform a retroactive syn-
tax check for not allowed interconnection of symbols. Only the ob-
jects that you insert while syntax checking is enabled are checked. 
However, the syntax check on texts will be performed on all the 
texts when syntax check is set to on.

SDL contains some symbols which appear identical, but are distin-
guished by their syntax. The symbols are:

• The in connector and the out connector

• The continuous signal and the enabling condition.

Note: No Layout Check means Syntax errors

When disabling the layout syntax check and using connectors in the 
diagram mean that it will not be possible to analyze the diagram 
without errors as all connectors are treated as in connectors. Thus 
never turn off this switch if you want to analyze the diagram.
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that are correct according to Z.100 definition. It simplifies writing state-
ments with the correct SDL syntax.

The SDL Grammar Help facility is described in “Using Grammar Help” 
on page 1906.

Signal Dictionary Support
The SDL Editor also provides a means of access to a signal dictionary 
where the signals that are already defined can be accessed. The Signal 
Dictionary window provides functions for listing SDL signals that are 
available when looking up or down in the SDL hierarchy or by looking 
at the current diagram. Also, you can ask the tool to list signals that are 
used in the current diagram or defined and visible according to the SDL 
scope rules.

Furthermore, the signal dictionary has the ability to import messages 
from a Message Sequence Chart (each MSC message will be mapped to 
an SDL signal) and to import an external signal dictionary.

For more information on this topic, see “Using the Signal Dictionary” 
on page 1917.

The SDL Editor User Interface and Basic 
Operations

The SDL Editor User Interface
The SDL Editor consists of a main window and three auxiliary win-
dows: 

• The Grammar Help window where SDL textual grammar support 
helps you entering correct textual expressions.

• The Signal Dictionary window which gives you access to signals al-
ready defined in the SDL hierarchy.

• The Entity Dictionary Window which provides you a name reuse fa-
cility as well as information for link endpoints.

The SDL Editor also contains the symbol menu, where you select the 
symbols (objects) that are to be inserted into the page, and the text win-
dow, where you may edit textual objects.
1788 ,um-st1 Telelogic Tau 4.5 User’s Manual July 2003
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The general Telelogic Tau user interface is described in chapter 1, User 
Interface and Basic Operations. 

Figure 353: The SDL Editor window (in Windows)
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July 2003 Telelogic Tau 4.5 User’s Manual ,um-st1 1789



Chapter 44 Using the SDL Editor 
Figure 354: The SDL Editor window (on UNIX)
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 The SDL Editor User Interface and Basic Operations
 Drawing Area

Figure 355: The Drawing Area
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The drawing area (see Figure 355) is the part of the window that dis-
plays the symbols, lines and text that constitute an SDL page (an SDL 
diagram can contain multiple pages). Most of the graphical notation that 
is used in the SDL Editor is inherited from the Z.100 definition. In ad-
dition, some tool specific notations have been added to facilitate the 
work with the SDL suite tool set in general, and the SDL Editor in par-
ticular.

The Drawing Area Boundaries

The drawing area is delimited by its boundaries, which correspond to 
the size of the SDL page. Within a diagram, each page has an individual 
size. No objects are allowed to be placed outside these boundaries. The 
drawing area uses a light background color, while the area outside the 
drawing area uses a grey pattern.

The Frame

You can select and resize the frame. All objects, except the package ref-
erence symbol, gates and printout page number must reside entirely 
within the frame.

The Kernel Heading

The kernel heading identifies the diagram type and its name. Alterna-
tively, an SDL qualifier expression can be used. You can edit but not 
move the kernel heading. The SDL Editor performs a textual syntax 
check based on the grammar used in this heading.

The SDL suite supports the following syntaxes for the kernel heading:

Case Syntax

1. SYSTEM <name> [: <type expression>]

2. BLOCK <identifier>

3. PROCESS <identifier> [<number of instances>]

4. SERVICE <identifier>

5. <procedure preamble> PROCEDURE <identifier>

6. SUBSTRUCTURE <identifier>

7. MACRODEFINITION <name>
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For an explanation and reference to the notation used in the table above, 
see the Z.100 recommendation.

The kernel heading is repeated trough all pages contained in an SDL di-
agram.

The Page Name

The page name identifies the name of the SDL page and, within paren-
theses, the total number of SDL pages contained in the current SDL di-
agram. 

The contents of the page name are assigned by the tool. You can not se-
lect, move, or edit the page name.

Printout Page Number

This object is created by the SDL Editor to inform you about the phys-
ical page numbering that will be the result of an SDL page which is larg-
er than the paper format that is defined. You can neither select nor edit 
it. Page numbering follows a “down first, then right” fashion.

8. SYSTEM TYPE <identifier>

9. [<virtuality>] BLOCK TYPE

10. [<virtuality>] PROCESS TYPE

11. [<virtuality>] SERVICE TYPE

12. OPERATOR <operator identifier>

13. PACKAGE <name>

Figure 356: The page numbering in the SDL Editor
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2
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Grids

The SDL Editor uses two grids for an easy positioning of symbols, lines 
and textual elements.

• The symbol grid, that can be set by an SDL Editor preference, has a 
minimum resolution of 5 * 5 mm. All symbols adhere to the symbol 
grid.

• The line and text grid has a resolution of 2.5 * 2.5 mm, i.e. half the 
symbol grid. All lines and textual objects adhere to the line grid.

Default Size of Symbols

The symbols are assigned default sizes when added to the drawing area:

• For interaction pages, the predefined size of a symbol is by default 
30 * 20 mm. 

• For flow pages, the predefined size of a symbol is by default 20 * 
10 mm. The width / size relationship is always 2:1. 

You can change the default symbol size in the SDL Editor preferences.

Color on Symbols

For each symbol type there is a preference for setting the color of the 
symbol. It is only the graphical part of the symbol and not the associated 
text(s) that will use the color setting. On UNIX, the setting is only valid 
on screen and all symbols will use the black color when printed on pa-
per. In Windows, when using MSW Print the colors will be sent to the 
printer as well. For more information, see “The SDL Suite Specific Pref-
erences” on page 260 in chapter 3, The Preference Manager.

Note:

The size of a class symbol is automatically calculated by the SDL 
Editor, and may thus differ from the default size.
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Keyboard Accelerators
In addition to the standard keyboard accelerators, described in “Key-
board Accelerators” on page 35 in chapter 1, User Interface and Basic 
Operations, the SDL Editor features the following:

Quick-Buttons
In addition to the generic quick-buttons described in “General Quick-
Buttons” on page 24 in chapter 1, User Interface and Basic Operations, 
the SDL Editor tool bar contains the following quick-buttons:

Accelerator  Reference to corresponding command

Ctrl+D Opens the next page in the diagram, similar to 
“<Page Name>” on page 1954

Ctrl+G “Split Text” on page 1943

Ctrl+I “Insert Paste” on page 1941

Ctrl+L “Show High-Level View/Show Detailed View” 
on page 1949

Ctrl+M “Mark as Important/Mark as Detail” on page 
1944

Ctrl+U Opens the previous page in the diagram, similar 
to “<Page Name>” on page 1954

<Delete> “Clear” on page 1942 (i.e. remove, delete)

Ctrl+1 “Show Organizer” on page 15 in chapter 1, User 
Interface and Basic Operations

Ctrl+2 “Connect to Text Editor” on page 1959

Text window on / off
Toggle the text window between visible and hidden, as described in 
“Window Options” on page 1950.

Symbol menu on / off
Toggle the symbol menu between visible and hidden, as described in 
“Window Options” on page 1950.
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Scrolling and Scaling
You can scroll the view vertically and horizontally by using the scroll-
bars. The view may also be scrolled automatically when you move the 
cursor beyond the current view, for example when you move an object 
or add a symbol. 

If you move the cursor close to the edge of the current view, the auto-
matic scrolling is slow. If you move it further beyond, the scrolling is 
quicker.

You can scale the view by specifying a scale or by zooming in and out.

To specify a scale:

1. Select Set Scale from the View menu.

2. In the dialog that will be opened, you can either:

– Use the slider for setting the scale and then click the Scale but-
ton.

Reference page
Open the page where this diagram is referenced, similar to “Edit Refer-
ence Page” on page 1954. 

Log Window
Pop up the Organizer Log window.

Previous page
Open the previous page in the diagram, similar to “<Page Name>” on 
page 1954.

Next page
Open the next page in the diagram, similar to “<Page Name>” on page 
1954.

Toggle scale
Toggle the scale between a scale to show the complete page in the win-
dow and a scale of 100%.

– Click the Overview button to adjust the drawing area to the size 
of the window. (This has the same effect as the Scale Overview 
quick-button.) The smallest scale is 20%.
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To zoom in or out:

Moving Selection with Arrow Keys
You can move the selection using arrow keys in the SDL editor if there 
is one single symbol or line selected. (In this context, we regard a flow 
symbol together with its attached flow lines to be one symbol.)

Note that you can only move the selection when in symbol editing 
mode. In text editing mode, the arrow keys will move the cursor posi-
tion within the text. To get into symbol editing mode, click on the sym-
bol outside of a text area. If you are in text editing mode, you can go to 
symbol editing mode by pressing the escape key. If you are in symbol 
editing mode, you can go to text editing mode by pressing the tab key. 
Pressing the tab key immediately after that will either select another text 
for the same symbol to edit or go back to symbol editing mode.

You can move to the next page by moving forward from the last symbol 
on the current page. You can move to the previous page by moving 
backward from the first symbol on the current page.

Two shortcuts are available for fast-forward moving to colored symbols 
(symbols not using black as a border color and white as a background 
color) on pages in the current diagram:

• Shift+arrow key to move to the next/previous colored symbol.
• Shift+alt+arrow key to move to the next/previous colored symbol 

on another page than the current page.

Symbol Menu
The symbol menu contains the SDL symbols that you can place into the 
drawing area.

On UNIX, the symbol menu is a fixed-sized, non-moveable auxiliary 
window, associated with the drawing area and placed to the right of it. 
Each editor window has its own symbol menu. 

In Windows, the symbol menu is a fixed-sized, moveable window that 
can be placed anywhere on the screen, not necessary within the limits 

• Click the quick-button for zoom in or zoom out.
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of the editor window. A single symbol menu is shared by all instances 
of the editor currently running. 

Basically, when you select a symbol in the symbol menu and click it 
into the drawing area it is added to the diagram. How to work with sym-
bols is described in “Working with Symbols” on page 1835.

The contents of the symbol menu depends upon the type of diagram that 
is displayed in the SDL Editor window and the settings of the SDL Ed-
itor preferences depends upon whether the symbols should be used or 
not.

• For process, process type, procedure, macro definition and opera-
tor diagrams (the flow diagrams), the default symbol menu looks 
like the left picture in Figure 357. 

• For interaction diagrams (system, block, substructure, service, 
package, system type, block type and service type), the default sym-
bol menu looks like the right picture in Figure 357.

For a reference to these symbols, see “Symbols on Interaction Pages” 
on page 1819 and “Symbols on Flow Pages” on page 1821.

The symbol menu can be made invisible and visible again with a menu 
choice, Window Options, or a quick-button In Windows: When visible, 
the symbol menu will always be placed on top of the editor window.
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Syntax Checking on SDL Symbols

If layout syntax checking is enabled, some of the symbols displayed in 
the symbol menu may be dimmed. This indicates that those symbols are 
not valid within the current context, and that you cannot select them.

• When layout syntax checking is disabled, you can select all sym-
bols.

Figure 357: The Symbol menu

Flow pages
symbol menu

Interaction pages
symbol menu
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• When layout syntax checking is enabled, the following rules apply:

Type of page Unusable symbols (dimmed)

System /
System type

process reference
service reference
block substructure reference
system type reference
gate

Block diagram / 
Block interaction page

process reference
service reference
block substructure reference
system type reference
gate

Block diagram / 
Process interaction page

block reference
service reference
system type reference
gate

Service procedure start
procedure return
macro inlet
macro outlet
gate

Process diagram / 
Graph page

procedure start
procedure return
macro inlet
macro outlet
gate

Process diagram / 
Service interaction page

block reference
process reference
block substructure reference
system type reference
block type reference
process type reference
gate
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Procedure start
stop
macro inlet
macro outlet
gate

Block type diagram /
Block interaction page

process reference
service reference
block substructure reference
system type reference

Block type diagram /
Process interaction page

block reference
service reference
system type reference

Macro gate

Service type procedure start
procedure return
macro inlet
macro outlet

Process type diagram / 
Graph page

procedure start
procedure return 
macro inlet
macro outlet

Process type diagram / 
Service interaction page

block reference
process reference
block substructure reference
system type reference
block type reference
process type reference

Type of page Unusable symbols (dimmed)
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Operator state
input
save
output
procedure call
enabling condition / continuous signal
create request
priority input
procedure reference
start
stop
macro inlet
macro outlet
gate

Package block reference
process reference
block substructure reference
service reference
gate

Type of page Unusable symbols (dimmed)
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Working with Diagrams
This section describes the methods you use when performing the fol-
lowing tasks on SDL diagrams:

• Creating a Diagram
• Including a Diagram
• Opening a Diagram 
• Saving a Diagram
• Saving a Copy of an SDL Diagram
• Closing a Diagram
• Printing a Diagram 
• Displaying an Opened Diagram
• Reorganizing a Diagram.
• Transforming the Type of a Diagram

Creating a Diagram
You can create diagrams from within other diagrams. When created, 
they form part of the current active system in the SDL Editor, and their 
presence is instantly reflected in the Organizer. This is achieved by in-
serting SDL diagram reference symbols.

You can also create diagrams as separate unrelated new entities. They 
will however not be incorporated in the Organizer.

Creating a Related Diagram from Another Diagram

1. Open the SDL diagram from where to start. 

2. Insert the SDL reference symbol.

3. Assign the symbol a name.

4. Deselect the reference symbol. The Organizer’s diagram structure is 
updated accordingly. 

5. Double-click the newly added reference symbol. You should speci-
fy what action to perform, either:

– Create a new diagram in the SDL Editor from scratch.

– Copy an existing file.

Select an option and click OK.
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The SDL Editor will now create a new diagram, possibly a new win-
dow, and display the newly created diagram. 

6. Save both the parent and the child diagram later on in your editing 
session, to make changes permanent.

Example in an Organizer Structure

As an example, in the Organizer structure in Figure 358, a system is 
shown with only one block diagram.

Suppose the system diagram is being edited. We now add a new block 
reference symbol, name it Block_B and deselect it. The Organizer dia-
gram structure becomes:

The SDL suite shows, with the [unconnected] identifier, that the 
newly added reference symbol is not yet connected to any physical file.

Now, double-click the Block_B symbol. Specify whether you want to 
create a new file or to connect the newly created block to an existing 
file.

Make sure the Show in Editor radio button is on and click OK. In some 
cases a new dialog appears, where you are to specify the name and type 
of the first SDL page to add to the diagram (an SDL diagram must con-
tain at least one SDL page). 

Assign a page name (see “Adding a Page” on page 1888) and click OK. 

A new block diagram with the name Block_B is created. The SDL Ed-
itor responds by issuing a window showing this diagram. Also, the Or-
ganizer’s diagram structure is updated, showing the new diagram icon, 
inserted at the corresponding place in the SDL hierarchy. 

Figure 358: A basic system shown in the Organizer

Figure 359: Having added a reference symbol
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Figure 360 on page 1805 shows the result:

• A newly created diagram, empty except for the diagram heading

• The resulting diagram structure

– The parent diagram needs to be saved (marked with a gray pat-
tern)

– The child diagram needs to be saved.

Creating an Unrelated New Diagram

1. Select New from the File menu of the SDL Editor. A dialog will be 
opened.

2. Enter the name of the new diagram in the Diagram Name field. The 
name should be in keeping with SDL naming conventions.

Figure 360: The newly created diagram and the resulting diagram structure
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3. Choose the type of diagram from the diagram type menu.

4. Click New. In some cases a new dialog box is shown where you can 
add a page, as each diagram must have at least one page. See the sec-
tion “Adding a Page” on page 1888 for this. 

A window on the newly created diagram is opened.

Including a Diagram

Including a Diagram into the SDL Hierarchy

When you have created a diagram, it needs to be brought into the SDL 
hierarchy to be available for future selection in the Organizer. Other-
wise, you will only be able to open it from the SDL Editor.

1. Create the diagram using the New command from the SDL Editor. 
Save the diagram on file.

2. Open the diagram that will have a reference to the newly created di-
agram.

3. In the diagram you just opened, add a diagram reference symbol 
with a type and name that matches the newly created diagram. A 
new icon appears in the Organizer structure. 

4. With the Organizer Connect command, connect the new icon with 
the file on which the diagram is stored. See “Connect” on page 91 
in chapter 2, The Organizer.

Once a reference symbol is placed in the newly created page of the new 
diagram in the SDL Editor, the Organizer is updated to reflect this. This 
indicates that the SDL hierarchy is updated.
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Including a Diagram into the Organizer

If a diagram is not managed by the Organizer (i.e. not contained in the 
Organizer structure) you must first include it into the Organizer, before 
you can start the SDL Editor.

1. Select the place in the Organizer where you want to add the SDL di-
agram. It will be added as a new root diagram after a selected doc-
ument or chapter, or at the top level of a selected module.

2. Select the Organizer’s Add Existing command from the Edit menu. 
A file selection dialog will be opened.

3. Select a SDL diagram file. 

The SDL diagram is added to the Organizer structure, and opened 
in the SDL Editor.

Opening a Diagram
There are several ways you can open a diagram for editing, depending 
on where you are and what you need to access.

Lock Files and Read-Only Mode

When you open a diagram or document file, i.e. a.ssy, a lock file 
a.ssy.lck is created. If another user tries to open the same diagram or 
document file before you close it, a dialog will appear informing the 
other user that the file is in use. 

There are two choices in the dialog:

• Open the file in read-only mode.

• Reset the lock and open the file in read-write mode. (This alterna-
tive should only be used if the existing lock file is obsolete.)

The read-write mode is the normal editing mode. In read-only mode, 
you are not allowed to make any changes to the diagram.

You will also enter read-only mode if you open a diagram file that you 
do not have write permission for. The read-only mode is indicated by 
the words read-only in the window title.

If you want to edit a diagram that is in read-only mode, here are two al-
ternative actions:
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• Change the file access rights in the file system to give you write per-
mission for the diagram file. Then change from read-only mode to 
read-write mode with the Revert Diagram operation.

• Use File >Save As to save the diagram in a new file with write per-
mission.

Opening a Diagram File from the SDL Editor

1. Select Open from the File menu or click the quick-button for Open. 
A file selection dialog is opened.

2. Select a file in the files list and click OK. If the file is already opened 
by the SDL Editor, a message is issued.

Opening a Diagram from the Organizer

You can open a diagram in different ways:

• Select an SDL diagram icon or the text line next to it in the Organiz-
er. Select Edit from the Organizer’s Edit menu.

• Double-click on an SDL diagram icon in the Organizer.

Opening a Diagram – via Organizer – to Show Analyzer Reports

When analysis has been performed, you can show the source of Analyz-
er error reports in an SDL Editor. 

• Select Show Error from the View menu in the Organizer Log Win-
dow. An SDL Editor window is opened with the source of error (i.e. 
an SDL symbol) selected.

Note:

The status bar at the bottom the SDL Editor provides information 
about the diagram type and name stored on the file which is selected 
in the file list.
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Opening a Diagram via a Reference Symbol

You can open a diagram from the SDL Editor by double-clicking on a 
reference symbol, or by using the Navigate command.

1. Locate the SDL reference symbol referring to the diagram you want 
to open.

2. Double-click the symbol or select it and choose the Navigate com-
mand from the Tools menu. The diagram is opened.

Opening a Diagram from the Simulator

If you have performed a GR trace in the SDL Simulator, invoking the 
Show-Next-Symbol or Show-Previous-Symbol simulator commands 
will display either the next symbol to be executed or the previously ex-
ecuted symbol in a diagram in an SDL Editor window. 

Opening a New (Nonexisting) SDL Diagram

To open a new SDL diagram, you either use an unconnected SDL dia-
gram icon or add a new SDL diagram icon.

Opening an Unconnected SDL Diagram Icon

To open an existing but unconnected SDL diagram icon:

1. Select an unconnected SDL diagram icon in the Organizer.

2. Double-click the SDL diagram icon. A dialog is opened.

3. Make sure the Show in editor option is set. Click OK. A new, empty 
diagram is opened. 

– To copy the contents of an existing SDL diagram file before 
opening the new diagram, select the option Copy existing file 
and enter a filename.
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Opening a New SDL Diagram Icon

To add a new SDL diagram icon to the Organizer and opening that icon:

1. Select the place in the Organizer where you want to add the SDL di-
agram. The diagram will be added as a new root diagram after a se-
lected document or chapter, or at the top level of a selected module.

2.  From the Organizer’s Tools menu, select the Editors > SDL Editor 
command. A new SDL diagram icon is added to the Organizer 
structure, and the new diagram is opened in the SDL Editor.

– Alternatively, select the Organizer’s Add New command from 
the Edit menu. A dialog is opened. Select a SDL diagram type, 
enter a name in the New document name field and click OK. The 
Add Page dialog is displayed, see “Adding a Page” on page 
1888.

Opening an Existing SDL Page

To open a specific page, the SDL pages must be visible in the Organizer 
diagram structure.

1. To display page icons in the Organizer, select the Organizer’s View 
Options command from the View menu. In the dialog, make sure 
Page symbols is highlighted and click Apply.

2. Select the icon representing the SDL page in the Organizer.

3. Double-click the SDL page icon. The SDL diagram page is dis-
played.

Saving a Diagram
There are several ways to save a diagram. The effect is saving any 
changes made to either one specific diagram, or all diagrams modified 
during the current session. 

Saving a Diagram in the SDL Editor

• Select Save from the File menu or click the quick-button for Save.

If the diagram is newly created, a file selection dialog is issued 
where you can specify the file to save the diagram on.
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Saving All Diagrams in the SDL Editor

You can make a global save of all the diagrams that are open in the cur-
rent session and have been modified.

• Select Save All from the File menu. All diagrams which are modi-
fied are saved.

Saving a Copy of an SDL Diagram
You can save the diagram being edited into another file. You may either 
continue working with the original file or with the newly created copy.

Continue Working with the New Copy

1. Select Save As from the File menu. A file selection dialog is issued. 

– The file name which is suggested is the same file as the original 
was stored on, appended with an integer suffix (1, ..., N) in order 
to build up a unique file name.

2. Click OK. The SDL diagram is copied to the specified file, the file 
containing the original is closed, and the window where you made 
the save remains open for editing the newly created file.

Continue Working with the Original

1. Select Save a Copy As from the File menu. A file selection dialog is 
issued. 

– The file name which is suggested is the same file as the original 
was stored on, appended with an integer suffix (1, ...,N) that 
guarantees a unique file name. 

2. Click OK. The SDL diagram is saved on the specified file, and the 
window where you made the save remains open for editing.

Closing a Diagram
Closing a diagram also means closing all instances of all windows dis-
playing any page contained in that diagram.

• Select Close Diagram from the File menu.

If you have modified the diagram, a Close dialog is shown where 
you can save the modifications before closing the diagram.
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Printing a Diagram
You can print an entire SDL diagram or a selection of pages or objects 
contained in the diagram. You print multiple SDL diagrams from the 
Organizer.

See “The Print Dialogs in the SDL Suite and in the Organizer” on page 
308 in chapter 5, Printing Documents and Diagrams.

Displaying an Opened Diagram
You can open the diagram that is currently read by the SDL Editor. (The 
diagram that you would like to see may reside in a window which is not 
on top of the screen.)

The Diagrams menu shows all SDL diagrams and pages (up to a maxi-
mum of the last nine to have been used). If more than nine pages are 
open, a tenth menu choice, List All, provides access to a list dialog 
where all diagrams and pages are listed.

Reorganizing a Diagram
The SDL Editor can reorganize the layout of an SDL diagram, for in-
stance if you run out of space on any of the pages that build up the dia-
gram. 

To reorganize an SDL diagram:

1. Display the diagram you want to reorganize.

2. Select Tidy Up from the Tools menu. A dialog is opened.

3. Click Tidy Up. The SDL Editor reorganizes the diagram (this may 
take some time, depending on how complex your diagram is).

4. Check the diagram before continuing working with it (you can undo 
the operation from the Edit menu).

Transforming the Type of a Diagram
A useful operation when e.g. transforming to a more object-oriented 
version of the SDL system is to change the SDL88 diagrams into type 
diagrams and make instantiations of these types. The following shows 
some examples how to perform such an operation and similar ones 
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where you want to change the type of a diagram or want to work with 
an SDL structure that is almost a copy of an already existing hierarchy.

Example 1

Assume that the system S consists of block B, which contains process 
P. The exercise to solve is to transform the block into a block type BT 
and put this into a package P and instantiate the block B from BT. 

There is no direct command to accomplish this task in the SDL suite; 
instead there are many solutions, more or less complicated and time 
consuming. The proposed one is easy to use and will take advantage of 
the possibility to cut and paste complete sub-hierarchies, thereby elim-
inating loosing file connections and the need for making manual con-
nections to existing files.

Solution: Open the system S, add a new block type symbol and name it 
BT. Open the block B and change the kernel heading from “block B” to 
“block type BT”. Note that the sub-hierarchy in the Organizer, previ-
ously below B, has now been moved to BT. In system S, change the text 
in the block symbol to “B:BT” to make it an instance of BT and cut the 
block type symbol to the clipboard. Create a package diagram named P 
and paste the block type into this diagram.

To make the new system complete you need to add the text “use P;” in 
the package reference symbol in system S, define the gates inside the 
block type BT and use these gates to connect the existing channels for 
the block B. If needed, you can change the filename of the block type 
with the Save As command in the SDL Editor to use a filename that re-

Figure 361: The Organizer view

The system to start with

After transformation
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sembles the block type name and also use the file name extension that 
conforms to the SDL suite conventions.

Example 2

This is a variant of example 1. Assume we want to keep the original di-
agram but want to have a new block type BT in package P that is a copy 
of the existing B.

Solution: In package P place a new block type symbol and name it BT. 
Double click on it and in the appearing Edit dialog tick the Copy exist-
ing file option and use the file connected to the existing block diagram 
B. Click Continue in the warning about recommended file name exten-
sion. In the opened diagram, change the kernel heading to “block type 
BT”.

For all diagram references in BT (in the example there is only one), use 
the Connect command in the Organizer to connect them to the existing 
files. In the Connect dialog be sure to use the Expand Substructure op-
tion to get automatic connections for possible sub-hierarchies. 

As an alternative to connecting the diagram references you can copy the 
reference symbols from block B and paste them into block type BT, 
then you will get automatically all the connections for sub-hierarchies 
below the pasted references.

Note that in either case you will use the same file connection for process 
P in our example for both the original process and also for the process 
P referenced in the block type, meaning that if you change the contents 
of this file you will change both the behavior of the block B and the 
block type BT, which might lead to unexpected results. If you want 
unique file connections you should take a copy of the existing file, for 
example copy P.spr to P1.spr, and reconnect one of the processes 
to this new file instead.
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Example 3

The SDL system consists of system S, block B, process P and procedure 
subPr inside P. You want to transform most of the process including its 
procedure subPr into a new procedure Pr defined in the system S.

Solution: This solution is similar to the solution to example 2. Open the 
system diagram S and place a procedure reference symbol named Pr. 
Double click it and open a copy of the existing file connected to process 
P. Edit the kernel heading to contain the text “procedure Pr”. Save the 
procedure as a new file. Connect all referenced procedures inside Pr or 
copy the procedure references from the process P to get all the sub-hi-
erarchy file connections. Finally edit process P and procedure Pr to 
make them useful in their new context.

The symbol is dashed and the change is immediately reflected in the Di-
agram Structure (this is only true if the Dashed Diagram option is on in 
the Organizer’s View Options).

• You may at any time undash a dashed symbol. Select the symbol 
and select Undash from the Edit menu. 

• If the symbol (prior to the dash operation) was connected in the Or-
ganizer the following dialog will appear:

Figure 362: The Organizer view

The system to start with

After transformation
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• If you click OK, the substructure will be removed. However, you 
may undo this.

Figure 363: Removing substructure by dashing
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About Symbols and Lines
Following is a description of the components in the drawing area. See 
also appendix 45, Symbols and Lines – Quick Reference, on page 1987.

The Additional Heading Symbol

The additional heading symbol is not defined further according to 
Z.100. In the SDL Editor, it looks like a dashed text symbol or it is 
shown without any border; this is controlled by the Editor preference 
ScreenZ100Symbols. The symbol is editable and resizeable, but cannot 
be moved. Its intended use is to define:

• Inheritance and specialization, using the following keywords:
– INHERITS
– ADDING
– ATLEAST

• Formal parameters for a process / procedure, using the keyword 
FPAR

Symbol Ap-
pearance

Symbol 
Name

References to Z.100

Addi-
tional 
heading

Z100: 2.2.5    Additional heading
Z100: 6.1.1.3  Process type
               heading
Z100: 2.4.4    Formal
               parameters,
               Signalset
Z100: 6.3      Specialization
Z100: 6.3.1    Inherits
Z100: 6.3.2    Virtual,
               Redefined, 
               Finalized
Z100: 6.3.2    Virtuality
               constraint
               (atleast)
Z100: 6.2      Actual context
               parameters
Z100: 6.2      Formal context
               parameters
Z100: 6.2.1 - 6.2.9  
               Formal context 
             para
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• Directives to the SDL to C Compiler. A directive uses the SDL com-
ment notation and a hash character, such as:
/#INCLUDE file.pr */ 

• SIGNALSET and instance information.

The additional heading symbol is either repeated through all pages con-
tained in an SDL diagram or it is only shown on the first page. This is 
controlled by the editor preference AdditionalHeadingOnlyOn-
FirstPage and can also be specified with the SDL Editor command Di-
agram Options.

Note that the combined text in the Kernel Heading and the Additional 
Heading symbol must use the syntax as specified for a heading in 
SDL/PR to be accepted in the SDL Analyzer.

The Package Reference Symbol

The package reference symbol is available on system and package dia-
grams only. It is located outside the frame, on top and to its left. It con-
tains references to package(s) containing definitions that are to be in-
cluded in the SDL system.

You can select and resize, but not move the package reference symbol. 

Other SDL Symbols
These are the symbols that describe the structure or behavior of the SDL 
diagram. They must be placed inside the frame.

You can draw symbols in color, see “Color on Symbols” on page 1794.

Syntax Checking on Symbols

The SDL Editor checks that the symbols you add to a diagram are in ac-
cordance with the syntactic rules imposed by SDL. Symbols that are not 
allowed in a diagram / page of a specific type are dimmed in the symbol 

Symbol Ap-
pearance

Symbol 
Name References to Z.100

Package 
reference

Z100: 2.4.1.2  Reference in 
Package
Z100: 2.4.2    Reference in 
System
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menu. Also the text entered is checked for syntax errors. See “Layout 
syntax check” on page 1951.

Symbols on both Interaction Pages and Flow Pages

Symbols on Interaction Pages

Symbol Ap-
pearance

Symbol 
Name

References to Z.100

Class Not included (Z100 11/99)

Symbol Ap-
pearance

Symbol 
Name

References to Z.100

Text Z100: 2.5.4      Signal
Z100: 2.5.5      Signal list
Z100: 5.2.1      Newtype
Z100: 5.3.1.9    Syntype
Z100: 5.3.1.13   Synonym
Z100: 5.3.1.12.1 Generator
Z100: 4.13       Remote 
variable
Z100: 4.14       Remote 
                 procedure

Comment Z100: 2.2.6

Text exten-
sion

Z100: 2.2.7
(depends on the symbol connected to)

Text Refer-
ence

None

Block refer-
ence

Z100: 2.4.2    Block definition
Z100: 6.1.3.2  Block def based 
               on block type
Z100: 6.1.2    Type expression
Z100: 6.2      Actual context
               parameters

PR
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Process ref-
erence

Z100: 2.4.3    Process 
               definition
Z100: 2.4.4    Number of
               instances
Z100: 6.1.3.3  Process def 
based
               on block type
Z100: 6.1.2    Type expression
Z100: 6.2      Actual context
               parameters

Block sub-
structure ref-
erence

Z100: 3.2.2

Service ref-
erence

Z100: 2.4.4

System type Z100: 6.1.1.1

Block type Z100: 6.1.1.2

Process type Z100: 6.1.1.3

Service type Z100: 6.1.1.4

Operator ref-
erence
(an SDL/GR 
extension 
defined in 
the SDL 
suite)

Z100: 5.3.2  Referenced 
operator
             in SDL/PR

Symbol Ap-
pearance

Symbol 
Name

References to Z.100

substructure

system

operator
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Symbols on Flow Pages

Gate Z100: 6.1.4  Gate
Z100: 2.5.5  Signal list

Symbol Ap-
pearance

Symbol 
Name References to Z.100

State or 
nextstate

Z100: 2.6.3     State
Z100: 4.4       Asterisk state
Z100: 4.5       Multiple
                appearence of 
                state
Z100: 2.6.8.2.1 Nextstate
Z100: 4.9       Dash nextstate

Text Z100: 2.5.4      Signal
Z100: 2.5.5      Signal list
Z100: 5.2.1      Newtype
Z100: 5.3.1.9    Syntype
Z100: 5.3.1.13   Synonym
Z100: 5.3.1.12.1 Generator
Z100: 2.6.1.1    Variable
Z100: 2.6.1.2    View
Z100: 2.8        Timer
Z100: 4.13       Remote 
variable
Z100: 4.13       Imported 
                 variable
Z100: 4.14       Remote 
                 procedure
Z100: 4.14       Imported
                 procedure

Input Z100: 2.6.4    Input
Z100: 4.6      Asterisk input
Z100: 4.14     Remote procedure
               input
Z100: 6.3.3    Virtual 
               transition
z100: 5.4.3    Variable
z100: 5.4.3.1  Indexed variable
z100: 5.4.3.2  Field Variable

Comment Z100: 2.2.6

Symbol Ap-
pearance

Symbol 
Name

References to Z.100
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Save Z100: 2.6.5   Save
Z100: 4.7     Asterisk save
Z100: 6.3.3   Virtual save

Text exten-
sion

Z100: 2.2.7
(depends on the symbol connected to)

Output Z100: 2.7.4

Decision Z100: 2.7.5      Decision
Z100: 5.3.1.9.1  Range 
condition
Z100: 2.2.3      Informal text

In-connec-
tor or out-
connector

Z100: 2.6.7       In-connector
Z100: 2.6.8.2.2   Out-connector

Task, set, re-
set or export

Z100: 2.7.1   Task
Z100: 5.4.3   Assignment
Z100: 2.8     Set, Reset
Z100: 4.13    Export

Procedure 
call

Z100: 2.7.3   Call
Z100: 2.7.2   Actual parameters

Macro call Z100: 4.2.3

Create re-
quest

Z100: 2.7.2 

Transition 
option

Z100: 4.3.4      Transition 
option
Z100: 5.3.1.9.1  Range 
condition

Symbol Ap-
pearance

Symbol 
Name

References to Z.100
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Continuous 
signal or en-
abling con-
dition

Z100: 4.11 Continuous signal
Z100: 4.12 Enabling condition

Start Z100: 2.6.2  Start
Z100: 6.3.3  Virtual transition

Priority in-
put

Z100: 4.10     Priority input
Z100: 2.6.4    Stimulus
Z100: 6.3.3    Virtual 
               transition
z100: 5.4.3    Variable
z100: 5.4.3.1  Indexed variable
z100: 5.4.3.2  Field variable

Stop Z100: 2.5.8.2.3 

Procedure 
start

Z100: 2.4.6

Inlet Z100: 4.2.2

Return Z100: 2.6.8.2.8

Outlet Z100: 4.2.2

Procedure 
reference

Z100: 2.4.6    Procedure
               definition

Symbol Ap-
pearance

Symbol 
Name

References to Z.100
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Graphical Properties of Symbols

You can select and move all symbols that are available in the symbol 
menu, and you can assign the symbols arbitrary locations.

You can resize certain symbols; these are indicated by filled selection 
squares. Other symbols can only be partially resized or cannot be re-
sized at all1; this is shown by grayed selection squares.

Operator ref-
erence 
(an SDL/GR 
extension 
defined in 
the SDL 
suite)

Z100: 5.3.2  Referenced 
operator
             in SDL/PR

Gate Z100: 6.1.4  Gate
Z100: 2.5.5  Signal list

Note:

The operator reference symbol is not part of the current Z.100 rec-
ommendation. It has been added to the SDL Editor as a convenience 
for the user. It makes operators visible in the SDL structure which is 
handled by the Organizer and facilitates thus navigating. 

The operator reference symbol does not, however, refer to the 
operator diagram implicitly. References to operator diagrams 
must be explicitly entered in SDL/PR, as stated in Z.100.

1. The size of non-resizeable symbols is computed by the SDL Editor to fit the text 
contained in the symbol.

Symbol Ap-
pearance

Symbol 
Name

References to Z.100

operator
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No symbol is allowed to overlap any other symbol except the text sym-
bol and the additional heading symbol.

Text / Additional Heading / Package Reference Symbols

The text, additional heading and package reference symbols look like a 
piece of paper. When all of the text within a text symbol is in view, the 
upper right corner is “folded” down. When any portion of the text with-
in a text symbol cannot be seen (because the text symbol is too small), 
the upper right corner is clipped or diagonally cut off. See Figure 364.

Clipped text symbols are printed in their whole on a separate sheet of 
paper.

Comment / Text Extension Symbols

The comment and text extension symbols can be shown either in full 
size enclosing the complete text or clipped (collapsed) where the sym-
bol is in the minimum size and only the first part of the text is visible. 
The clipped symbol is visualized as if the lower right corner has been 
cut off. See Figure 364. 

Block Substructure Symbol

The appearance of this symbol differ from the drawing rules in Z.100. 
The non editable text “substructure” is drawn inside the symbol. With-
out this extra text it is impossible to distinguish the block symbol and 
the block substructure symbol by their visual appearance.

Figure 364: Resizeable and non-resizeable symbol

This symbol can be
resized...

...while that one can
be either full sized or
clipped...

...and the third one
can be resized by
dragging the lower
right corner.

substructure
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The appearance can be set to be according to Z.100 by the Editor pref-
erences ScreenZ100Symbols and PrintZ100Symbols. Setting these to 
on means that the extra text will not be drawn or printed.

Symbol Text Attributes

Most SDL symbols have one or multiple text attributes. A text attribute 
should be filled with an SDL/PR expression (textual expression) that is 
syntactically correct according to Z.100. Depending on the correctness 
of the text, the SDL suite tool set has the ability to perform the following 
operations:

• Syntactic Analysis
• Semantic Analysis
• Pretty-printing
• Generation of reports
• Generation of code.

Syntax Checking on Text Attributes

You are not forced by the SDL Editor to fill text attributes with text. 
However, a context sensitive syntax check is performed for each text at-
tribute. The first located syntax error is indicated by a red bar underlin-
ing the text where the error occurs. 

A global syntax check for the complete diagram is performed by the 
SDL Analyzer.
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Reference Symbols
Diagram reference symbols allow to build an entire SDL system by re-
ferring to diagrams that are structurally related. Reference symbols are 
the following:

• Block reference
• Process reference
• Block substructure reference
• Service reference
• System type
• Block type
• Process type
• Service type
• Operator reference
• Procedure reference
• Text Reference

These symbols are handled by the SDL Editor in order to ensure consis-
tency between the SDL diagrams and the SDL structure that is handled 
by the Organizer. Because of that, the SDL Editor imposes the restric-
tion that a reference symbol must be unique within an SDL diagram 
(this restriction is not in conflict with Z.100).

You are permitted to have diagram reference symbols that are not as-
signed any name.

The SDL Editor performs a number of checks when you edit an SDL 
reference symbol. Furthermore, when you double-click a reference 
symbol, the SDL diagram that the symbol refers to will be opened.

See also “Working with Diagram Reference Symbols” on page 1835.

Instantiation Symbols
You may use any of the following reference symbols for the instantia-
tion of a type:

• Block reference
• Process reference
• Service reference.

operator

system

substructure

PR

x:y

x:y

x:y
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An instantiation symbol differs from a “normal” reference symbol in 
the sense that the syntax of the symbol’s text differs. The syntax is: 

a:a_type

where a_type is the name of the SDL type diagram (block type, process 
type or service type diagram) that is instantiated into the diagram with 
the name a.

Instantiation symbols are visualized in the Organizer structure. The Or-
ganizer structure is updated to reflect the nature of the changes applied 
to the SDL diagram, in a similar fashion as for diagram reference sym-
bols (see “Reference Symbols” on page 1827).

The names of instantiation symbols must be unique within an SDL dia-
gram. 

See also “Working with Diagram Instantiation Symbols” on page 1835.

Dashed Reference Symbols
Any of the following reference symbols may be dashed:

• Block reference
• Process reference
• Service reference.

Dashed symbols are visualized in the Organizer structure. The Organiz-
er structure is updated to reflect the nature of the changes applied to the 
SDL diagram, in a similar fashion as for diagram reference symbols (see 
“Reference Symbols” on page 1827).

The names of dashed reference symbols must be unique within an SDL 
diagram. 

See also “Working with Dashed Symbols” on page 1836.

Lines
Lines are the graphical objects that interconnect symbols. One line only 
is available in the symbol box, namely the gate, which is handled as a 
symbol. You can insert it by selecting it and placing it into the drawing 
area.
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You insert the other lines by selecting a symbol and dragging the handle 
that appears on the source symbol and connecting it to the target sym-
bol. (Some symbols have multiple handles). 

Lines are always connected to symbols, they are not allowed to exist on 
their own.

You can select, move and reshape lines. Some layout work is performed 
automatically by the SDL Editor. 

A line is allowed to overlap any other object.

Lines in Interaction Diagrams

Figure 365: A handle

Figure 366: Lines (1)

A handle

Channel (bidirectional)Channel to 
environment

Channel substructure
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The following lines are defined in interaction diagrams (see Figure 366 
and Figure 367):

• channels
• channel substructures
• signal routes
• create requests
• text extension lines
• comment lines

You can reshape each of these lines and you can also move the connec-
tion points.

Figure 367: Lines (2)

Create request

Signal route to

(bidirectional)
environment

Text extension line Comment line
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Lines in Flow Diagrams

On flow diagrams, the following lines are defined (see Figure 368):

• flow lines
• comment lines
• text extension lines

Line segments on flow pages always use a 90-degree angle. You can 
add segments on a line, but connection points are fixed.

Syntax Checking on Lines

The SDL Editor checks that the target symbol is in accordance with the 
syntactic rules imposed by SDL. If not, the SDL Editor will refuse to 
connect the symbol. When you edit the text attributes are instantly 
checked for syntactical errors.

Figure 368: Lines (3)

Comment line

Text extension line

Flow line

Flow line
July 2003 Telelogic Tau 4.5 User’s Manual ,um-st1 1831



Chapter 44 Using the SDL Editor 
Textual Objects
Textual objects are the textual attributes that are related to a symbol or 
a line. Each of these attributes is prepared by the SDL Editor – you need 
of course to fill in their textual contents. 

Textual attributes are indicated by a small rectangle which appears upon 
selection of the symbol or line the attribute belongs to.

You can select and edit textual objects. You can move them freely, as 
long as their location does not violate the rules defined by Z.100. 

Textual objects are allowed to overlap any other objects.

Textual Objects in Interaction Diagrams

The following textual objects are defined in interaction diagrams:

Graphical Appearance Textual objects

• Name of a diagram reference symbol
– Includes the number of instances 

for a process reference symbol

• Name of a diagram type reference 
symbol

• Name of a diagram instantiation sym-
bol (e.g. inst:blk_type)
– Names of graphical connection 

points in diagram instantiation 
symbol (e.g. CON1)
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Textual Objects in Flow Diagrams

In flow pages, the following textual attributes are defined:

• Name of a channel or signal route 
(e.g. CH)
– Signal list on a channel / signal 

route (there are 2 signal lists if the 
line is bidirectional, e.g. Sig1 and 
(Siglist))

– Connection point for channel / 
signal route to / from environ-
ment, e.g. CON

• Name of a gate, e.g. GA
– Signal lists on a gate (there are 2 

signal lists when the gate is bidi-
rectional, e.g. Sig1 and Sig2)

Graphical Appearance Textual objects

• Decision expressions connected to a 
decision symbol or transition option, 
e.g. Expr1 and Expr2.

• Name of a gate, e.g. GA
– Signal lists on a gate (there are 2 

signal lists when the gate is bidi-
rectional, e.g. Sig1 and Sig2

Graphical Appearance Textual objects
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Graphical Connection Points
Connection points are text objects which are created automatically by 
the SDL Editor when you draw a channel or signal route to the frame or 
to an instantiation symbol.

They are handled in a similar way as other text attributes. You are free 
to fill connection points on the frame or not. The alternative is to define 
textual connection statements between channels and signal routes in a 
text symbol.

Change Bars
A change bar is a vertical line to the left of a text in an SDL diagram. It 
visually identifies changes in the SDL system.

A solid change bar indicates that the text has been changed. A dotted 
change bar indicates that a text or its associated symbol has been 
moved.

The change bars associated with the diagram name and the page name 
act as change bars for the complete page. As soon as a change has been 
made to a page, change bars for the diagram name and the page name 
are added.

You can turn change bars on and off and also clear them from the Orga-
nizer. See “Change Bars” on page 145 in chapter 2, The Organizer.
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Working with Symbols
The main operations provided by the SDL Editor on symbols is de-
scribed in this section.

• Working with Diagram Reference Symbols
• Working with Diagram Instantiation Symbols
• Working with Dashed Symbols
• Selecting Symbols
• Adding Symbols
• Inserting a Symbol into a Flow Branch 
• Navigating in Flow Diagrams
• Navigating from Symbols
• Cutting, Copying and Pasting Symbols
• Moving Symbols
• Resizing Symbols
• Mirror Flipping Symbols 
• Adjusting Symbols to the Grid
• Editing the Diagram Kernel Heading.

In addition, text editing functions are provided for the text associated 
with the symbols.

Working with Diagram Reference Symbols
When you perform certain modifications to the diagram reference sym-
bols listed in the left margin (system type, block, block type, substruc-
ture, service, service type, process, process type, procedure and text ref-
erence symbols), the SDL Editor checks with the Organizer to verify 
that the modifications are valid. This occurs in the following situations:

• Adding a Diagram Reference Symbol
• Adding an Operator Diagram Reference Symbol
• Renaming a Diagram Reference Symbol
• Removing Symbols

Working with Diagram Instantiation Symbols

Instantiating a Diagram Type

The implication of an instantiation symbol is that the description of the 
type diagram is actually instantiated, i.e. a physical copy is created. This 

system

PR
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copy may then be given additional properties using SDL’s inheritance 
and specialization mechanisms.

When a diagram type is to be instantiated, do as follows:

1. Make sure the type diagram is visible according to the SDL scope 
rules.

2. Insert a diagram reference symbol. When specifying the name of the 
symbol, use the syntax <instance_name>:<type_name>.

3. When the symbol is deselected, the diagram structure is immediate-
ly updated to show the instantiation (this is only true if the Instance 
Diagram option is on in the Organizer’s View Options).

Working with Dashed Symbols

Dashing and Undashing a Reference Symbol

Dashed reference symbols are used to refer to an object that is defined 
elsewhere in one of the supertypes of the current subtype. 

To dash a reference symbol:

1. Select the reference symbol.

2. Select Dash from the Edit menu. 

Selecting Symbols
With the SDL Editor, you often perform actions that apply on a selec-
tion. This section discusses topics related to selection of symbols.

Selecting a Flow of Symbols

You often want to select a flow of subsequent symbols in a flow page, 
including all branches - the tail of the flow. To select a flow of symbols:

1. Click on the symbol where the flow starts.

2. Select Select Tail from the Edit menu. The tail of the flow is select-
ed. See Figure 369, where the left picture shows only one selected 
object and its associated connections, whereas the right picture 
shows the selected symbol and its connections plus the selected rest 
of the flow diagram – the Selected Tail.
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Selecting a Symbol That Has Associated Objects

Consider the following when you select a symbol which has lines or text 
associated with it: 

• When you select a symbol, you implicitly select the associated ob-
jects as well. A text cursor is inserted directly in the text associated 
with a symbol, and the text window will be updated to contain the 
text.

• If you point to a line associated with a symbol, you will select the 
line, not the symbol. The process of selecting lines is described in 
“Selecting Lines” on page 1866. 

• If you point to the text associated with a symbol, the resulting selec-
tion depends upon the type of the symbol.

Figure 369: Selecting the tail of a subtree

Before Select Tail... ...and after
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Displaying Selected Symbol Attributes

Selected symbol attributes are displayed as follows:

• When you select a symbol from which you can draw lines, it is dis-
played with a handle which you use when drawing lines from that 
symbol. Handles are shown in Figure 370.

• Text attributes associated with a selected symbol are marked by a 
rectangle around the text, as shown in Figure 371. For class sym-
bols, this only applies when text attributes contain no text.

Figure 370: A selected symbol’s handles

The handle of a channel
The handle of a channel
substructure

The handle of a The handle of a 
signal route create request

The handle of an The handle of an 
association aggregation
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• In an interaction page, a line is marked by drawing filled selection 
squares at the line’s starting point, ending point, and each break-
point. In the middle of each line segment is a tiny selection square 
that provides an easy way to create new breakpoints. See 
Figure 372.

• In a flow page, a selected flow line is marked by drawing filled se-
lection squares in the middle of each line segment. This indicates 
that you can move the individual line segments (but not the flow line 
as a whole). See Figure 373.

Figure 371: A selected symbol’s text attributes

Figure 372: The selection squares of a line in interaction pages

Figure 373: The selection squares of a line in flow pages
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Adding Symbols
You may place symbols into the drawing area in either manual mode or 
in automatic mode. 

Adding Symbols in Manual Mode

This section describes how to do this in manual mode. The automatic 
mode is described in “Adding Symbols in Automatic Mode” on page 
1842. 

Selecting and Placing a Symbol

1. Click the symbol in the symbol menu.

2. Click at the desired location in the drawing area. Overlap of sym-
bols is not allowed.

The symbol is drawn and adjusted to the symbol grid.

Entering Symbol Text Attributes

Once a symbol has been added, you can enter the text into the symbol’s 
text attributes. The symbol remains selected. Enter the text required di-
rectly using the keyboard or edit the text inside the text window. 

Connecting the Symbol to Another Symbol

Once the symbol is at the desired location it can be connected to another 
symbol as required.

To connect two symbols:

1. Add the source symbol, i.e. the symbol from where you want to 
draw the line.

2. Point the mouse onto the handle of the source symbol, and start 
dragging the handle. As soon as mouse motion has begun, you can 
release the mouse button. Point to the target symbol and click the 
mouse button. The line is drawn to the symbol and required text at-
tributes are added to the connecting line. The box without brackets 

Note:

The line will be drawn only when the SDL syntax rules allow the 
symbols to be interconnected.
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is reserved for the name of the channel, while the box with brackets 
[ ] is for the signal list.

 

3. Fill in the text attributes.

Conversely, once you have placed a symbol in the drawing area, you 
can follow the same procedure from a symbol resident in the drawing 
area to the new symbol.

Connecting the Symbol to the Environment

1. Hold the mouse pointer on the handle of the symbol, drag it to the 
frame (environment) and release the mouse button. 

2. Enter text in the channel or signal route and connection point boxes. 

Figure 374: Having connected two symbols

Figure 375: Having connected the symbol to the environment

The text attributes are added 
by the SDL Editor

A connection point box is added
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Adding Symbols in Automatic Mode

The automatic mode is particularly useful when you want to add sym-
bols sequentially or in parallel in a symbol flow. Both situations are de-
scribed below.

Adding in Sequence

To add symbols sequentially within a flow page, proceed as follows:

1. Select the source symbol in the drawing area.

2. Double-click the target symbol in the symbol menu. 

The target symbol is added to the source symbol, and a flow line is 
drawn between the two symbols if the syntax rules allow it. 

3. Fill in the text in the target symbol.

The target symbol is positioned directly beneath the source symbol if 
possible. Otherwise, the added symbol is placed in the first available lo-
cation to the right. 

After this operation, the target symbol is automatically selected and the 
source symbol is de-selected.

Adding in Parallel

To add symbols in parallel in a flow page:

1. Select the source symbol in the drawing area.

2. Press <Shift> and double-click the target symbol in the symbol 
menu. 

The target symbol is added to the selected symbol. The source sym-
bol remains selected. 

Figure 376: Adding in sequence

Select the source
symbol...

...then double
click the 
target symbol
in the symbol
menu.
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You can repeat this procedure in order to add additional symbols to the 
selected symbol. The target is positioned immediately below the source 
symbol, if possible. Otherwise, the target symbol is placed in the first 
available location to the right.

Using Default Placement

You can also take advantage of the auto-placement by double-clicking 
a symbol without having to connect it to other symbols.

Insufficient Space Left

When you insert a symbol using the double-click facility, there may not 
be any space left to perform the operation, The SDL Editor informs you 
of this with a message.

You have the following options:

• Click OK to increase the page. The Drawing Size dialog will be 
opened, where you can specify the new size of the SDL Page.

If you select this method, the SDL page may not fit any longer into 
the paper that you have set up with the Print preferences. The result 
may be an SDL page that requires multiple sheets of paper when 
printing it (unless you rescale it).

• To Cancel the operation. Try to find a more suitable location for the 
new symbol and use manual placement (see “Adding Symbols in 
Manual Mode” on page 1840).

Figure 377: Adding in parallel 

Select the
source
symbol...

...double
click the
target symbol
in the symbol
menu.
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Adding a Gate Symbol

The gate symbol differs slightly from other symbols when you add it. 

Adding a Gate in Manual Mode

1. Select the gate symbol.

2. Move the pointer into the drawing area. The gate is immediately dis-
played and connected in a 90-degree angle to the frame and the en-
vironment.

3. Move the mouse to a suitable location. The gate symbol follows the 
mouse motion and is automatically reconnected.

4. Click the mouse.

5. Enter the name of the gate and the signals it conveys.

Adding a Gate in Automatic Mode

You may add and connect a gate to a channel or signal route with a dou-
ble-click. The channel or signal route must not be already connected to 
a gate or connection point.

1. Select the channel or the signal route. 

2. Double-click the gate symbol in the symbol menu.

3. If required, redirect or bidirect the gate so that it matches the direc-
tion of the channel or signal route.

4. Enter the name of the gate and the signals it conveys.

Note: Coalesced Gates and Connection Points

See “Connecting a Gate Symbol with a Channel or Signal Route” on 
page 1853 if you get a message with the text “A Gate has coalesced 
with a connection point...”.
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Adding a Diagram Reference Symbol

When you add a diagram reference symbol, the SDL Editor checks that 
the name and type are unique within the SDL diagram. The SDL Editor 
will refuse any duplicates. The newly added reference symbol is then in-
serted into the Organizer’s diagram structure.

1. Select the symbol to be added from the symbol menu and add it to 
the diagram.

2. Type in the name of the symbol.

3. Deselect the symbol. The SDL Editor checks that the name and type 
are unique within the SDL diagram being edited. 

If the new reference symbol is accepted, it is inserted into the dia-
gram structure, located beneath the referring diagram. 

Adding an Operator Diagram Reference Symbol

In a data type construct it can be stated that an operator diagram is ref-
erenced elsewhere. This means that the operator will not be described 
in the current place, but in an operator diagram. 

The SDL Editor does not know that the operator is referenced in a data 
type. The operator reference symbol is available for this situation. It is 
a convenience that has been added to the SDL suite tool set to facilitate 
navigating within an SDL system. Its presence in an SDL diagram does 
not modify the meaning of the diagram.

You add an operator reference symbol in a similar manner as when add-
ing any other reference symbol. See “Adding a Diagram Reference 
Symbol” on page 1845.

Adding a Text Reference Symbol

The Text reference symbol is used to include SDL PR into the SDL sys-
tem.

You add an operator reference symbol in a similar manner as when add-
ing any other reference symbol. See “Adding a Diagram Reference 
Symbol” on page 1845.

operator

PR
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Inserting a Symbol into a Flow Branch
The SDL Editor allows you to insert symbols into a flow branch. When 
inserting symbols, the SDL Editor will rearrange the page in order to 
prepare the required space for inserting the symbol. This can be done in 
different ways:

• By pushing the tail of the branch downwards. This is the preferred 
method.

• By increasing the size of the SDL page. 

Inserting a Symbol into a Flow Branch

1. Select the symbol in the symbol menu.

2. Point to the line interconnecting the symbols where the new symbol 
is to be inserted.

3. Click the mouse.

Inserting a Symbol by Double-Click

To insert a symbol into a flow branch by double-clicking it:

1. Select the line that interconnects the two symbols. Alternatively you 
can select the symbol preceding the line, see “Insert Paste” on page 
1941.

2. In the symbol menu, double-click the symbol to be inserted.

Figure 378: Inserting a symbol into a flow branch

Select the
symbol in the
symbol menu
and bring it to
point to the
flow line...

...release the
mouse and the
symbol is
inserted.
1846 ,um-st1 Telelogic Tau 4.5 User’s Manual July 2003



 Working with Symbols
Navigating in Flow Diagrams
For certain symbols you can use the Navigate command in the Tools 
menu or double click on the symbol to navigate around in the diagrams. 
These symbols are:

• Create request, procedure call and macro call
• State and nextstate
• Inconnector and outconnector
• Reference symbols; see further “Navigating from a Diagram Refer-

ence Symbol” on page 1848

Navigating from Create Request and Procedure/Macro Call 

For a create request, procedure call or macro call the Navigate com-
mand will show the corresponding process, procedure or macro dia-
gram. The diagram is found by searching in the Organizer structure for 
all relevant diagram types matching the name used in the symbol. If one 
and only one match is found this diagram will be shown in the editor. If 
there exists more than one diagram a dialog is issued.

Navigate to the desired diagram by selecting it in the dialog.

Figure 379: Inserting a symbol with double-click

Note: Navigating from a Class Symbol

Navigating from a class symbol is possible only by using 
Tools>Navigate. See further “Navigating from Class Symbols” on 
page 1849

Select the line
where to insert
a symbol...

...double-click
the symbol to
be inserted in
the symbol menu.
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Navigating from State/Nextstate

For a state or nextstate the Navigate command will show other occur-
rences of the same name(s) in other state or nextstate symbols within the 
same diagram. If only one symbol matches the name search this symbol 
will be shown. If more than one symbol have the same name, a dialog 
is shown.

Navigating from Connectors

For an outconnector, the Navigate command will show the correspond-
ing inconnector in the same diagram having the same name as the out-
connector.

Similarly for an inconnector; you can navigate to all occurrences of out-
connectors within the same diagram having the same name as the incon-
nector.

Navigating from Symbols 

Navigating from a Diagram Reference Symbol

When you double-click or choose the Navigate command on a diagram 
reference symbol, the SDL diagram that the reference symbol refers to 
is opened, provided that the diagram is included in the Organizer struc-
ture.

This feature allows easy navigation down an SDL hierarchy.

See also “Navigating from an Instantiation Symbol” on page 1848 and 
“Navigating from a Dashed Symbol” on page 1849.

Navigating from an Instantiation Symbol

You may use instantiation symbols to navigate in the diagram structure.

When you choose Navigate in the Tools menu or double-click on an in-
stantiation symbol, the SDL Editor matches the name of the type re-
ferred to in the instantiation symbol against the existing type diagrams 
in the Organizer structure. The following happens depending on how 
many type diagrams that match the given diagram name.

• One and only one diagram is found: This diagram will be shown. 
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• No diagram matches the name: A dialog will appear which offers 
the possibility to open the Type Viewer window which can be used 
to navigate among the inheritance and redefinition trees extracted 
from the SDL system:

• More than one diagram is found: A dialog will appear showing 
the file names of all the found diagrams. Additionally the possibility 
to show the Type Viewer window is available.

Navigating from a Dashed Symbol

When you select Navigate in the Tools menu or double-click a dashed 
symbol, a scenario similar to the action of navigating from an instanti-
ation symbol takes place. See “Navigating from an Instantiation Sym-
bol” on page 1848

Navigating from Class Symbols

For a class symbol, the Navigate command will show other occurrences 
of the same name(s) in other class symbols within the same diagram. If 
only one symbol matches the name search, this symbol will be shown. 
If several symbols have the same name, a select dialog is shown.

Cutting, Copying and Pasting Symbols
The clipboard of the SDL Editor allows you to cut or copy a selection 
of symbols. The selection may then be pasted to:

• The same page
• Pages of the same diagram, provided the page types match
• Other diagrams, provided the diagram types match

See also “Cutting, Copying and Pasting Reference Symbols” on page 
1851.

Cutting and Pasting Symbol(s)

A dialog may appear when cutting or pasting an object with link end-
points. See “Deleting an Object” on page 461 in chapter 10, Implinks 
and Endpoints or “Pasting an Object” on page 461 in chapter 10, Im-
plinks and Endpoints.
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Limitations when Pasting

Pasting is not always possible. Note the following cases, and refer to 
“Relationship between Diagrams and Pages” on page 1782.

• The selection cannot be pasted if the page is too small. In this case, 
you need to enlarge the page. See “Resizing a Page” on page 1892.

• You are not allowed to paste symbols so that they overlap existing 
symbols in the drawing area. If you attempt to do this, the Paste op-
eration is cancelled. Try another suitable location.

• You are not allowed to paste flow symbols into an interaction page 
and vice versa. In this situation, the Paste menu choice is dimmed. 

Pasting on Flow Pages

On a flow page, symbols are pasted along with the flow lines that inter-
connect them.

Pasting on Interaction Pages

On an interaction page, symbols are pasted along with the lines that in-
terconnect them. Any lines that connect the pasted symbols to the envi-
ronment will also be drawn.

Pasting Symbols into a Flow Branch

On a flow page, symbols can be pasted into a flow branch in a similar 
manner as “Inserting a Symbol into a Flow Branch” on page 1846. 

1. Copy or Cut one or more symbols in a flow page. The symbols must 
be connected and placed below each other. 

2. Go to the page where you want to insert the symbols and select a 
symbol or a flowline.

3. Select Insert Paste from the Edit menu.

Note: Effect of Syntax Check when Pasting

Some symbols may not be pasted if the syntax check is on. The clip-
board buffer content must comply with the SDL syntax rules. Any 
symbols which do not comply will be omitted. (The clipboard 
buffer content may have been copied from a page edited with syntax 
checking turned off.)
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4. The pasted symbols will be placed below the selected symbol and 
inserted into the flow branch. Any previously following symbols 
will be automatically shifted downwards to make place for the in-
serted symbols.

Cutting, Copying and Pasting Reference Symbols

When you cut or copy a reference symbol, the possible sub-hierarchy 
shown in the Organizer below this reference symbol is also placed in the 
clipboard. When pasted in the same diagram or in another diagram this 
sub-hierarchy will be restored at the new position.

When you copy or paste a diagram reference, it is assigned a new name 
that consists of the original name, preceded with the prefix CopyOf. The 
prefix is repeated as many times as necessary in order to build a name / 
type combination that is unique within the SDL diagram being edited. 
If the cut/copied symbol had an underlying structure this structure is re-
stored after the paste.

Cutting, Copying and Pasting Class Symbols

When cutting, copying or pasting a class symbol, one or more operators 
with a defined body code may be completely removed, i.e. there is no 
longer any class symbol that refers to a specific operator. If so, the fol-
lowing dialog is shown:

Note:

When a reference symbol is cut, the sub-hierarchy that is shown in 
the Organizer will be removed. However, the hierarchy will be re-
stored if you select Paste or Undo.
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You have the following options:

• Accept the deletion of the listed operators and their defined body 
code by pressing OK.

• Cancel the issued operation by pressing Cancel and try to correct the 
error.

Moving Symbols
You may move one or more symbols in a single operation. The lines and 
text objects that are related to the symbol will be moved accordingly in 
order to preserve as much as possible of the original appearance. When 
you move a symbol, its position is automatically adjusted to fit exactly 
into the symbol grid.

Symbols are not allowed to be moved to positions where they would 
overlap other symbols.

Figure 380: Checking with user if OK to remove operators

Caution!

By confirming the deletion of the operators, you accept that the list-
ed operators, and possibly defined body codes, will be permanently 
removed. No Undo option is available.
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Moving Symbols and Text Attributes

You can move symbols and text attributes by pointing and dragging to 
the desired position. To grab the text attribute the pointer must be at the 
border of the text extent.

You cannot move text within flow symbols and class symbols.

Connecting a Gate Symbol with a Channel or Signal Route

When you move a gate symbol in order to reconnect it to a line or vice 
versa (channel or signal route that is connected to a connection point), 
the following takes place:

• If the connection point is not assigned any name, the SDL Editor 
connects the gate symbol and the line.

• If the connection point is assigned a name, a conflict occurs, since 
the line cannot be connected to the connection point and the gate si-
multaneously. The following dialog is issued:

Figure 381: Prompting to solve connection conflict

Moving the 
gate G1 down 
to the signal 
route SR...

...or moving 
the signal 
route and the 
connection 
point Conn 
up to the 
gate G1 pro-
duces the fol-
lowing mes-
sage:
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You have the following options:

– To keep the gate G1 and to connect the line to it. The connection 
point Conn is removed.

– To keep the connection point Conn and to connect the line to it. 
The gate G1 is removed.

• Click OK to reconnect the line and symbol accordingly.

Resizing Symbols
The procedure for resizing a symbol differs slightly depending on 
whether the symbol is a flow page symbol or an interaction page sym-
bol. When you resize a symbol, its size is automatically adjusted to fit 
exactly into the symbol grid. Any lines connected to the symbol are sim-
ilarly adjusted to preserve as much as possible of the original appear-
ance. 

The text, the additional heading, the package reference, comment, class, 
and text extension symbols are handled differently. Their size is deter-
mined by the SDL Editor to fit the text they contain.

Specifying Default Size of Symbols

You define the default sizes for symbols in the Preference Manager:

• For interaction pages, the predefined size of a symbol is 30 * 20 
mm. 

• For flow pages, the predefined size of a symbol is 20 * 10 mm. The 
width / size relationship is always 2:1.

Resizing Interaction Page Symbols

1. Point to a corner of the rectangle that delimits the symbol. From this 
point on, the corner that you are pointing to is movable, while the 
opposite corner is fixed.

2. Drag the corner until the symbol has the desired size. An interaction 
symbol cannot be adjusted to a size less than 15*10 mm.

Note:

The situation above also occurs if you add a new gate symbol and 
place it on a connection point.
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3. Release the mouse button. The symbol is redrawn with its size ad-
justed to fit exactly into the symbol grid. The lines connected to a 
resized interaction symbol are automatically adjusted to preserve a 
nice appearance.

Resizing Flow Page Symbols.

1. Point to a corner of the rectangle that delimits the symbol. From this 
point on, if you pointed to any of the lower corners, the top of the 
symbol is fixed (and in a similar way, if you were pointing to any of 
the upper corners, the bottom of the symbol is fixed).

2. Drag the corner until the symbol has the desired size. The symbol 
shrinks or swells both horizontally and vertically, the proportions 
remaining 2:1. A flow page symbol cannot be adjusted to a size less 
than 20*10 mm. 

3. Release the mouse button. The symbol is redrawn.

Resizing the Class Symbol

The class symbol contains three text boxes. Whenever the text in any of 
the boxes grows bigger than the symbol, the class symbol is automati-
cally re-sized.

Resizing Text / Additional Heading / Package Reference /
Comment / Text extension Symbols

The text, additional heading and package reference symbol look like a 
piece of paper. When all of the text within a text symbol is in view, the 
upper right corner is “folded” down. When any portion of the text with-
in a text symbol cannot be seen (because the text symbol is too small), 
the upper right corner is clipped or diagonally cut off. See Figure 382 
on page 1856.

Clipped text symbols are printed in their whole on a separate sheet of 
paper.

These symbols react in the same way for resizing. There are several 
ways you can resize these symbols:
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Adjusting to a Specific Size 
(only for Text / Additional Heading / Package Reference)

1. Place the mouse pointer on the filled selection square at the bottom 
right corner of the symbol.

2. Holding the left mouse button down, make the symbol smaller by 
pushing to the left or larger by pulling the corner to the right. 

Toggling Between Minimum and Maximum Size

You may rapidly toggle between a text symbol’s maximum and mini-
mum size. This can be accomplished in two ways:

• Select the symbol and choose the Collapse/Expand command in the 
Edit menu.

• Double-click on any part of the symbol.

Mirror Flipping Symbols
The input, priority input, output, comment and text extension symbols 
are drawn by default as displayed in the symbol menu. In some cases, 
the layout of the connecting lines would be nicer if the symbols were 
drawn flipped L/R.

1. Select the symbol.

2. Choose Flip from the Edit menu. The symbol is flipped L/R.

Figure 382: Minimizing and maximizing a symbol

...and maximal size.

The “folded corner”

The symbol’s
minimal size...
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Adjusting Symbols to the Grid
The drawing area of the SDL Editor provides two grids for easier posi-
tioning of objects. These are the symbol grid and the line grid, which are 
invisible. 

After you move or resize symbols, the position of the upper left corner 
of each symbol is positioned on the closest intersection in the symbol 
grid. In addition, resizing a symbol will adjust the size so that it matches 
the resolution of the grid, horizontally as well as vertically. The resolu-
tion of the symbol grid is variable and can be set with the Preference 
Manager. The default is 5 * 5 mm for interaction pages, and 25 mm 
* 15 mm for flow pages. 

You can temporarily disable the grid by toggling the Use Grid to off in 
the Diagrams Options dialog.

Handling Symbols of Different Sizes

Since symbols adhere to the symbol grid, mixing symbols of different 
sizes may imply that symbols cannot be aligned symmetrically, and that 
enlarging symbols becomes impossible due to overlap of symbols al-
ready laid out. 

You can align symbols of different sizes by disabling the symbol grid.

Figure 383: Flipping a symbol

Note:

By using the Preference Manager you can specify whether the out-
put symbol in the symbol menu should point to the left or to the 
right, or you can have both. The same applies for the input and pri-
ority input symbols.

Flipping the text ex-
tension symbol mir-
rors it and redraws
the connecting line
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Editing the Diagram Kernel Heading
You can rename, retype and re-qualify a diagram with the SDL Editor, 
by modifying the diagram’s kernel heading.

See also “Transforming the Type of a Diagram” on page 1812 for more 
complicated transformation of diagram types. 

The SDL suite accepts a number of syntaxes for kernel headings, 13 in 
all. See “The Kernel Heading” on page 1792.

Changing the Name of a Diagram

This is the bottom-up method you would use when renaming diagrams 
in an SDL structure.

1. Select the kernel heading.

2. In the text window, edit the kernel heading text.

Figure 384: The kernel heading

Note:

Changing the kernel heading of a diagram may have a large impact 
on the diagram’s meaning. Also, the SDL diagram structure where 
the diagram is included may be affected to a large extent. You may, 
however, want to change the kernel heading in order to create a new 
diagram that you will use in a different context than the SDL struc-
ture it originally is tied to, or in order to perform a simple rename of 
diagrams.

System Type AccessControlOOA
The kernel heading
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3. Deselect the kernel heading. The SDL Editor checks that the name 
is still valid according to SDL rules. Any syntax error will cause a 
dialog with the following alternatives to be issued:

– Clicking OK, you are returned to the text window where you 
should correct the error.

– Clicking Revert, the kernel heading is reverted to its original 
contents.

– Clicking Ignore, the erroneous kernel heading is accepted. The 
error will probably lead to other kind of error reports, typically 
when verifying the diagram with the Analyzer tool.

The Organizer detects that the name of the diagram no longer 
matches the name that is expected in the diagram structure, and 
marks the diagram icon as mismatch. (A warning is also added to 
the Organizer Log window.)

4. To correct the mismatch, you have to update the name of the refer-
ence symbol accordingly. Use the command Edit Reference Page to 
bring the page with the reference symbol into view. Locate the ref-
erence symbol and rename it accordingly.

For renaming diagrams in a top-down fashion., see “Renaming a Dia-
gram Reference Symbol” on page 1863.

Changing the Type of a Diagram

It is possible to re-type a diagram, provided the old and the new types 
are “compatible” from the SDL Editor’s point of view. The basic com-
patibility criteria is that the old and new type of diagram must both be 
interaction diagrams or both be flow diagrams. Also checks are made 
on the pages that are contained in a diagram (some diagram types are 
allowed to have different types of pages in the same diagram, see “Re-
lationship between Diagrams and Pages” on page 1782. The table below 
summarizes the type changes that are allowed.

case A diagram of type... ...can be changed to any of:

1. SYSTEM SYSTEM TYPE 
BLOCK 
SUBSTRUCTURE 
BLOCK TYPE 
PACKAGE 
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2. BLOCK BLOCK TYPE 
SYSTEM 
SUBSTRUCTURE 
SYSTEM TYPE 
PACKAGE 

3. PROCESS PROCESS TYPE 
SERVICE 
PROCEDURE 
SERVICE TYPE 
MACRODEFINITION 
OPERATOR 

4. SERVICE SERVICE TYPE 
PROCESS 
PROCEDURE 
PROCESS TYPE 
MACRODEFINITION 
OPERATOR 

5. PROCEDURE PROCESS 
SERVICE 
PROCESS TYPE 
SERVICE TYPE 
MACRODEFINITION 
OPERATOR 

6. SUBSTRUCTURE SYSTEM 
BLOCK 
SYSTEM TYPE 
BLOCK TYPE 
PACKAGE 

7. MACRODEFINITION PROCESS 
SERVICE 
PROCEDURE 
PROCESS TYPE 
SERVICE TYPE 
OPERATOR 

8. SYSTEM TYPE SYSTEM 
BLOCK 
SUBSTRUCTURE 
BLOCK TYPE 
PACKAGE 

9. BLOCK TYPE SYSTEM 
BLOCK 
SUBSTRUCTURE 
SYSTEM TYPE 
PACKAGE 

case A diagram of type... ...can be changed to any of:
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10. PROCESS TYPE PROCESS 
SERVICE 
PROCEDURE 
SERVICE TYPE 
MACRODEFINITION 
OPERATOR 

11. SERVICE TYPE SERVICE 
PROCESS 
PROCEDURE 
SERVICE TYPE 
MACRODEFINITION 

12. OPERATOR PROCESS 
SERVICE 
PROCEDURE 
PROCESS TYPE 
SERVICE TYPE 
MACRODEFINITION 

13. PACKAGE SYSTEM 
BLOCK 
SUBSTRUCTURE 
SYSTEM TYPE 
BLOCK TYPE 

case A diagram of type... ...can be changed to any of:
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To change the type of a diagram:

1. Select the kernel heading.

2. In the text window, edit the kernel heading text to apply a new type. 
See the table above for allowed transformations.

3. Deselect the kernel heading. The SDL Editor checks that the type is 
still valid according to the table above. Any violation of these rules 
will cause a dialog with the following alternatives to be issued:

– Clicking OK, you are returned to the text window where you 
should correct the error.

– Clicking Revert, the kernel heading is reverted to its original 
contents.

– Clicking Ignore, the erroneous kernel heading is accepted. The 
error will probably lead to other kind of error reports, typically 
when verifying the diagram with the SDL Analyzer.

Changing the Qualifier of a Diagram

By changing the qualifier that appears in the kernel heading, you can 
change the context of the diagram.

The SDL suite accepts the two Z.100 notations for a qualifier, namely 
with and without the surrounding “<< >>”.

Example 304: An SDL Qualifier ––––––––––––––––––––––––––––––––

PROCESS TYPE <<SYSTEM MYSYS/BLOCK MYBLOCK>> Myproc

Alternatively:

PROCESS TYPE SYSTEM MYSYS/BLOCK MYBLOCK Myproc

––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

To change the qualifier:

1. Select the kernel heading.

2. In the text window, edit the kernel heading text to apply the new 
qualifier.
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3. Deselect the kernel heading. The SDL Editor checks that the new 
qualifier is syntactically correct. Any syntax error will cause a dia-
log with the following alternatives to be issued.

– Clicking OK, you are returned to the text window where you 
should correct the error.

– Clicking Revert, the kernel heading is reverted to its original 
contents.

– Clicking Ignore, the erroneous kernel heading is accepted. The 
error will probably lead to other kind of error reports, typically 
when verifying the diagram with the SDL Analyzer.

Renaming a Diagram Reference Symbol
When you change the name of a diagram reference symbol, the SDL 
Editor checks that the new name is not in conflict with existing symbols. 
If the reference symbol passes this check, the Organizer structure is up-
dated accordingly.

When renaming diagrams in a top-down fashion, you start by changing 
the name of a reference symbol. After the reference symbol is renamed, 
you should also update the referenced diagram’s kernel heading accord-
ingly to maintain consistency in the diagram structure.

To rename a diagram reference symbol and the referred diagrams:

1. Select the symbol to be renamed.

2. Change the name of the reference symbol.

3. Deselect the symbol. The SDL Editor checks that the name and type 
are still unique within the diagram.

If the new name of the reference symbol is accepted, the diagram 
structure is updated to reflect the nature of the change. 

4. To ensure that the change also applies to the referred diagram, you 
should use the Organizer command Update Headings (see “Update 
Headings” on page 99 in chapter 2, The Organizer). This command 
verifies and possibly changes the name in the diagram kernel head-
ing against the expected name (which is the one that now is shown 
in the reference symbol). The mismatch between the name of the di-
agram is reported in a dialog:
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– Correct the mismatch by clicking Update. 

Note that if you select not to update the kernel heading, you simply 
postpone the problem.

For renaming in a bottom-up way, see “Changing the Name of a Dia-
gram” on page 1858.

Removing Symbols
When you remove a diagram reference symbol, the underlying structure 
is also removed from the Organizer structure. However, the hierarchy 
will be restored if the remove operation is restored by doing Undo.

1. Select the symbol(s) to be removed. 

2. Select Clear from the Edit menu. The symbol(s) are removed, as 
well as the lines that were connected to these symbols.

Figure 385: The mismatch in headings is reported
1864 ,um-st1 Telelogic Tau 4.5 User’s Manual July 2003



 Working with Symbols
Printing Symbols
A selection of symbols can be printed. This allows for instance to print 
only the portion of a diagram which is of interest.

1. Select the symbols to be printed. 

2. Select Print from the File menu.

3. In the Print Dialog, click the Setup button. The Print Setup dialog 
will be issued. In the dialog, select the Print only selected symbols 
option.

4. Adjust, if necessary, other Print options and click the OK and Print 
buttons. See “Printing a Diagram” on page 1812 for more informa-
tion. 
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Working with Lines
The main operations provided by the SDL Editor on lines, and their as-
sociated text attributes are: 

• Selecting Lines
• Drawing Lines
• Re-Routing and Reshaping Lines 
• Redirecting and Bidirecting Lines
• Adjusting Lines to the Grid

In addition, text editing functions are provided for the text associated 
with the lines.

Operations on lines are performed slightly different depending if you 
are editing

•  flow pages
•  interaction pages

The main difference between the two is that flow pages may only allow 
vertical and horizontal lines. 

Some restrictions also apply when connecting symbols in flow pages, 
depending upon whether or not the syntax checking is enabled

Selecting Lines
You select lines and extend and reduce selections of lines with standard-
ized selection commands.

Selecting a Line That Has Associated Objects

When you select a line, you implicitly select the associated attributes as 
well. To be able to edit a text attribute you must click on the text at-
tribute and a text cursor will be inserted directly in the text, at the same 
time the text window will be updated to contain the text. 

Displaying Selected Line Attributes

Selected line attributes are displayed as follows:

• Each text attribute is displayed inside a text selection rectangle.
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• The following attributes are displayed with a filled selection square:

– Each arrow (on interaction pages only)

– Each line breakpoint (on interaction pages only)

– The middle of each line segment (on interaction pages only a 
tiny selection square marks the handle to create a new break-
point)

– The middle of each line segment (on flow pages only)

Selecting Overlapping Objects

On a page, objects may overlap each other. A layer order is defined so 
that it is possible to determine how overlapping objects are stacked. 

Drawing Lines
This section describes how to interconnect symbols with lines. Two 
modes are supported in the SDL Editor.

Drawing a Line with Layout Syntax Checking Enabled

The way that you draw a line differs somewhat depending upon whether 
you are working on an interaction page or a flow page. The differences 
will be pointed out later in this section.

When syntax checking is enabled, you are only allowed to draw lines 
that are correct according to the SDL rules. When syntax checking is 
disabled, the rules are less strict.

Designating the Start Point

1. Select the symbol from which the line will originate.

2. Point to the handle and drag it to begin forming the line. The line 
that is formed ends where the mouse pointer is located. Note that the 
mouse button can be released as soon as you have moved the mouse 
pointer.
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Designating the End Point

1. Designate the start point. See previous section.

2. You can route the line and specify where it will end either automat-
ically or manually.

• To route the line automatically:

– Click any valid target symbol to specify where the line should 
end. 

A symbol is valid if the syntax rules enforced by the SDL Editor 
at edit-time allows the drawing of a line from the first symbol to 
the second symbol.

• To route the line manually, indicating where line breakpoints are to 
be inserted, follow the steps below. 

1. To enter manual mode, click any location in the drawing area 
other than a valid destination symbol. 

2. Click each location where you want to insert a line breakpoint. 

3. Click on a valid destination symbol.

As long as you do not point to a valid destination symbol, the 
line will be routed from the selected symbol to the current 
mouse position. The automatic line drawing facility will deter-
mine the layout of the line until you have inserted the first break-
point. 

Figure 386: Drawing a line in manual mode
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Drawing Multiple Lines

When you draw lines between symbols and keep the <Control> key 
pressed, the start point for the next line to draw is automatically trans-
ferred to the target symbol. 

This feature provides the easiest way to draw multiple lines in rapid suc-
cession.

Differences between Flow and Interaction in Line Drawing

The way that you draw a line differs somewhat depending upon whether 
you are working on an interaction page or a flow page:

• On an interaction page, you can draw lines in all possible directions. 

• On a flow page, you can only draw lines horizontally or vertically. 
The last line breakpoint, even if determined manually, will be ad-
justed so that the destination symbol is connected correctly, normal-
ly in the middle of the upper edge of the symbol. Exceptions are 
made for comment and text extension symbols, which are connected 
to the center of the right or left edge of the symbol.

Cancelling the Line Drawing Operation

You can cancel a line drawing operation in either of the following ways:

• Press <ESC>. 

• Double-click any part of the drawing area that is not a valid destina-
tion symbol. 

Drawing a Line with Layout Syntax Checking Disabled

The process of drawing a line is the same regardless of whether or not 
syntax checking is enabled. To enable and disable syntax checking, see 
“Turning Syntax Checking On and Off” on page 1786.

When drawing lines with syntax checking disabled, you may intercon-
nect symbols in any way you want.

Re-Routing and Reshaping Lines
Reshaping a line refers to changing the path that the line follows. This 
operation does not affect the endpoints of the line. The flow lines only 
move in either a horizontal or vertical way.
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Re-routing a line denotes changing the ending point of the line from one 
symbol to another symbol.

Reshaping a Flow Line

1. Point to one of the segments of the line. 

2. Press the mouse and, holding down the mouse button, drag the seg-
ment to the required position.

3. Release the mouse button.

Re-Routing a Flow Line

You can move the ending point of a flow line, and reconnect it to any 
valid destination symbol. You can redraw the line either manually or 
automatically.

To move a line’s ending point:

1. Point at the ending point that you want to reconnect. 

2. Press the mouse. Start dragging the ending point. As soon as you 
move the mouse, the line’s last segment follows the mouse motion 
and you can release the mouse button.

3. You can click additional line breakpoints where you like.

4. Click the destination symbol to complete the operation. If it is a val-
id symbol, the line will be re-routed automatically. 

Re-Routing an Interaction Line

You can move any starting or endpoint to and from a symbol and the 
environment.

1. Point to the starting or ending point of the line.

2. Press the mouse and, holding the mouse down, drag it to the desired 
symbol. 

3. If required, click to add line breakpoints at desired positions. 

4. Terminate by clicking on the new symbol. The line is redrawn ac-
cordingly.
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Moving an Interaction Line Breakpoint 

To move a line breakpoint in an interaction page:

1. Point to the breakpoint that you want to move. 

2. Press the mouse and drag the breakpoint to the desired location. 

3. Release the mouse button to redraw the line.

Inserting Breakpoints in an Interaction Line

1. Point at the middle of a line segment. When the line is selected a tiny 
selection square will be displayed at this point.

2. Press the mouse and drag it to shape the breakpoint.

An alternative way to insert breakpoints on an interaction line:

1. Press <Ctrl>

2. Point in a line segment where you want to insert a new breakpoint.

3. Press the mouse and drag it to shape the breakpoint.

4. Release the <Ctrl> key. 

Moving an Interaction Line Segment

You can move a line segment in an interaction page as long as it is not 
a starting segment or ending segment. 

1. Point to the line segment to be moved. 

2. Press the mouse and drag the line segment to the desired location.

Figure 387: Moving an interaction line breakpoint
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3. Release the mouse button. The line segment and the adjacent line 
segments are redrawn accordingly. 

Moving Arrows

Arrows on channels, gates and signal routes denote the orientation of 
flow on that line. They are assigned default locations when creating the 
line.

You can manually move arrows on channels along the line.

1. Point to the arrow.

2. Press the mouse. Still holding the mouse down, drag it until the ar-
row reaches the new place.

3. Release the mouse. The arrow and the signal list are redrawn ac-
cordingly.

To create a non-delay channel you simply drag the arrow to the starting 
or ending breakpoint.

Moving a Line and Its Connection Point

A channel or a signal route may be connected to a connection point 
(usually located close to the line, immediately outside the frame).

Moving the line’s ending point with the connection point unselected 
will move the line only and create a new connection point. The old con-
nection point is removed.

Figure 388: A signal route connected to a connection point.
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To move the line and the connection point:

1. Click on the ending point of the line. Make sure the connection point 
is selected (i.e. the selection rectangle appears).

2. Drag the line’s ending point to the new location. The connection 
point follows the mouse motion as well.

– If the line’s new ending point coincides with a gate symbol and 
the connection point has a name, a dialog is issued. The meaning 
of this message is described in “Connecting a Gate Symbol with 
a Channel or Signal Route” on page 1853.

Moving a Line Text Attribute

A line text attribute is a textual element that is related to a line. The fol-
lowing lines have associated text attributes:

• Gates
• Channels
• Signal routes
• Flow lines after decision, transition option and macro call symbols.

When drawing a line, the SDL Editor positions the text attribute close 
to the source symbol and originating line, so that it is easy to identify 
what line the text attribute is related to. You are however free to move 
the text attribute to any location in the drawing area within the frame.

To move a line text attribute:

1. Point to the border of the text attribute. 

2. Press the mouse, and, still holding the mouse down, drag the text at-
tribute to its new location.

3. Release the mouse button.

Redirecting and Bidirecting Lines
When you add a channel or signal route to an interaction diagram, the 
line is initially drawn in a uni-directional manner, originating from the 
source symbol and pointing to the target symbol.

The only way to draw a line from the environment to a symbol is to first 
draw it from the symbol and then redirect it.
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Redirecting a Line

1. Select the line

2. Choose Redirect from the Edit menu. The line is redirected.

Bidirecting a Line

1. Select the line.

2. Choose Bidirect from the Edit menu. The line is bidirected.

3. Fill in the second signal list.

Figure 389: Redirecting a line

Figure 390: Bidirecting a line

Before redirect...

...and after.

...bidirecting the
channel creates a
new signal list

A uni-directional
channel...
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Uni-Directing a Bidirected Line

1. Select the bidirected line.

2. Choose Unidirect from the Edit menu. A dialog will appear asking 
what arrow to keep. 

Adjusting Lines to the Grid
When you move or reshape interaction lines, the line breakpoints are ad-
justed to the line grid, which cannot be disabled and has a fixed resolu-
tion of 2.5 mm. 

Flow line segments and line text attributes are always placed so that 
they match the resolution of the line grid. 
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Working with Classes
This section describes how Classes are handled graphically.

The class symbol is a graphical syntax for defining SDL data structures, 
instead of writing textual newtype definitions. It is allowed in every di-
agram where textual data definitions are allowed. 

When analyzing the SDL specification, class symbols are translated to 
standard textual newtype definitions, that are used as input to the ana-
lyzer.

It is important to notice that, in a diagram, all class symbols with the 
same class name are treated as if they were a single, merged class. Thus 
two classes, both named “a_class” but defining two separate operators, 
would be the same as a single class named “a_class”, defining both op-
erators.

While attributes and operators may be defined and edited in the SDL 
Editor directly, they may also be edited in the Browse&Edit Class dia-
log, see “Browse & Edit Class Dialog” on page 1877.

The complete definition of all classes may be viewed in the 
Browse&Edit Class dialog, but also, in SDL/PR form, in the Class in-
formation dialog. The Class Information dialog may also be used for 
traversing among the classes that define the SDL/PR code, see “Class 
Information” on page 1876.

Class Information
The complete class may be presented in textual (SDL/PR) form. This is 
done in the read-only Class information dialog.

The dialog can be started from the Windows menu, and will also be 
started automatically in response to a Show symbol request concerning 
a class, e.g Show Error from the Organizer Log. Since the sum of all 
class symbols with the same name is a single class, some information 
may be duplicated. The PR-representation of an error is shown in the 

Note:

Both the Browse&Edit Class dialog and the Class Information dia-
log present the aggregate of all graphical class symbols with the 
same class name.
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class information dialog, and it will be possible to navigate to the sym-
bol(s) that generated the PR-code.

Figure 391 Class Information window

Buttons:

• Show Next Symbol shows the next symbol described by the PR code 
line on which the cursor is placed. The number within brackets 
shows the total number symbols in the current SDL diagram that 
that are described by this line. If a line does not refer to any partic-
ular symbol, Show Next Symbol shows the next symbol belonging 
to the current class. Each time Show Next Symbol is clicked, the next 
symbol that is described by the current line is shown. 

• Edit Class will show the Browse & Edit Class dialog for the current 
class.

If the cursor is moved to another line in the text area, the Show Next 
Symbol button is updated.

Browse & Edit Class Dialog
The Browse & Edit Class dialog is opened when you select Class... 
from the Edit menu. The dialog allows inspection of classes in the SDL 
diagram.

A class is defined as the union of attributes and operators in the class 
symbols, and the purpose of the Browse & Edit Class dialog is to dis-
play this union and ensure consistency when editing this combined in-
formation.
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The Browse & Edit Class dialog is a modal dialog, which is divided into 
two parts. The browsing functionality is placed at the top part of the di-
alog, where all classes in the diagram, and all occurrences of each class, 
are listed in two drop-down menus. Below, in the editing part, the name 
of the class, its attributes and all its operators are listed.

The Browse & Edit Class dialog is available when a single class symbol 
is selected, unless the class name contains incorrect syntax.

Browse

In the topmost part of the Browse & Edit Class dialog, you can browse 
all class symbols within the current diagram.

Edit

In the lower part of the Browse & Edit Class dialog, you can edit the 
name, attributes and operators of a class. Any changes will propagate 
into all class symbols of this class within the SDL diagram. The at-
tributes and operators will be presented in a list. This list contains 
parsed information, derived from the texts in the class symbols. If a par-
ticular text contains syntax errors, attributes and operators contained in 
the same text might be missing from this list.
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The Scope Label

The Scope label is a non-editable text field, indicating which SDL dia-
gram the Browse & Edit Class dialog operates on.

The Classes Drop-Down Menu

The Classes drop-down menu lists all classes within the current SDL di-
agram. When a class is selected from this menu, its attributes and oper-
ators are displayed in the editing part of the dialog.

Figure 392: The Browse & Edit Class dialog
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The Show Symbol in Option Menu

A class can be represented by several class symbols. The Show Symbol 
in drop-down menu lists the name of all pages with occurrences of the 
current class (the current class is displayed in the Classes drop-down 
menu). By selecting a page name in this menu, the corresponding page 
will be shown in the work area.

The Class Name Field

The Class Name field is an editable text field, containing the name of 
the class being edited.

When the OK button is clicked, changes to the Class Name field update 
all occurrences of the class name in all class symbols, within the current 
SDL diagram.

The External Check Box

The External check box is checked when a class is externally defined. 
This means that no PR code will be generated for this class.

When the OK button is clicked, changes to the External check box up-
date all occurrences of the external flag, in all relevant class symbols us-
ing the current class name, within the current SDL diagram.

The Attributes and Operators Buttons

The Attributes and Operators buttons are used to select the contents of 
the attributes/operators list. Clicking Attributes will list all attributes de-
fined for the selected class, while clicking Operators will list all opera-
tors.

The Attributes/Operators List

The Attributes/Operators list lists all attributes or all operators defined 
for the selected class.

The Clear Button

The Clear button is used to remove the attribute or operator currently 
selected in the Attributes/Operators list.
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When the ‘OK’ button is clicked, the selected attribute or operator is re-
moved from all relevant class symbols with the current class name, 
within the current SDL diagram.

The Name Field

The Name text field contains the name of the attribute or operator cur-
rently selected in the Attributes/Operators list, if any.

When the OK button is clicked, changes to the definition of the attribute 
or operator are applied to all relevant class symbols with the current 
class name, within the current SDL diagram 

The Parameters Field

The Parameters field is an editable text field, containing the parameters 
of a class operator. It is only editable when an operator is selected in the 
Attributes/Operators list.

When the OK button is clicked, changes to the parameter list are applied 
to the definition of that operator in all relevant class symbols with the 
current class name, within the current SDL diagram.

The Sort/Returnsort Field

The Sort/Returnsort field is an editable text field that is editable only 
when an attribute or an operator is selected in the Attributes/Operators 
list.

Depending on the selection, the field contains:

• the sort of the selected attribute,
• or the return sort of the selected operator.

When the OK button is clicked, the sort of the selected attribute, or the 
return sort of the selected operator, is updated in all relevant class sym-
bols with the current class name, within the current SDL diagram.

The Body Code Text

The Body Code field is a text field, containing the body code of a class 
operator. It is only editable when an operator is selected in the At-
tributes/Operators list.

The declaration part of the body code is automatically generated, and all 
code should be added between the two comments indicating start and 
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end of the user defined part, respectively. The comments themselves 
should never be edited. For example, the operator myOp:Boolean; will 
have the following default declaration:

operator myOp returns Boolean { 
/* Start of user defined body code */
/* End of user defined body code */
}

When the OK button is clicked, changes to the body code definition are 
applied to the operator in the class with the current class name, within 
the current SDL diagram.

The OK Button

The OK button closes the Browse & Edit Class dialog, and updates all 
appropriate class symbols in the current SDL diagram.

No changes are made in the diagram until the OK button is clicked. This 
makes it possible to specify several changes in the dialog and disregard 
them later, by clicking the Cancel button.

All values are syntactically checked, so it is not possible to add syntax 
errors to your classes by using the Browse & Edit Class dialog. This 
might make it impossible to delete syntactically incorrect text from 
class symbols using the Browse & Edit Class dialog, since the dialog re-
lies on information obtained by parsing the relevant symbol text com-
partments. A syntactically incorrect text must then be corrected by ed-
iting individual symbols.

Once the OK button is clicked, changes cannot be undone.

The Cancel Button

The Cancel button will close the Browse & Edit Class dialog and dis-
card any changes specified in the dialog.
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Syntax and Definition of Class Symbols

Name

The syntax for the name field is <SDL_name>, where <SDL_name> is a 
name in accordance with the SDL lexical rules.

The above class symbol will generate the following newtype definition.

newtype Person
endnewtype;
newtype Ref_Person Ref(Person); endnewtype;
newtype Own_Person Own(Person); endnewtype;
newtype Oref_Person Oref(Person); endnewtype;

The three pointertypes, Ref_Person, Own_Person and Oref_Person, are 
generated for use when creating associations and aggregations.

Attributes

The syntax for the attribute field is <name><sort><end>, where 
<name> and <sort> are names in accordance with the SDL lexical 
rules.

The above class symbol will generate the following newtype definition.

newtype Person struct
  i Integer;
endnewtype;
newtype Ref_Person Ref(Person); endnewtype;
newtype Own_Person Own(Person); endnewtype;
newtype Oref_Person Oref(Person); endnewtype;

Figure 393 Class symbol

Figure 394 Class symbol with attribute
July 2003 Telelogic Tau 4.5 User’s Manual ,um-st1 1883



Chapter 44 Using the SDL Editor 
Operators

The syntax for the operator field is 
<name>[‘(‘<par>{‘,’<par>*’)’][<returns><sort>]<end>

where <par> is defined as

[<kind>]<name>[<colon>]<sort>

and <kind> is defined as

‘in’|’in/out’

The above class symbol will generate the following newtype definition.

newtype Person
  operators
    op: Integer -> Integer;
endnewtype;
newtype Ref_Person Ref(Person); endnewtype;
newtype Own_Person Own(Person); endnewtype;
newtype Oref_Person Oref(Person); endnewtype;

Syntax and Definition of Association Lines

The syntax for the role name of an association is [<name>][<con-
straint>], where <constraint> is in the format ‘{‘name’}’.

Associations can be of a number of types, depending on the constraint:

• if there is no constraint, the type is Ref_<opposite_class_name>

• if the constraint is “own”, the type is 
Own_<opposite_class_name>

Figure 395 Class symbol with operator

Figure 396 Association line
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• if the constraint is “oref”, the type is 
Oref_<opposite_class_name>

• if there is a constraint, but not “own” or “oref”, the type is 
<constraint_name>.

The above association will generate the following newtype definition.

newtype Company struct
  e Ref_Employee;
endnewtype;
newtype Ref_Company Ref(Company); endnewtype;
newtype Own_Company Own(Company); endnewtype;
newtype Oref_Company Oref(Company); endnewtype;
newtype Employee
endnewtype;
newtype Ref_Employee Ref(Employee); endnewtype;
newtype Own_Employee Own(Employee); endnewtype;
newtype Oref_Employee Oref(Employee); endnewtype;

Syntax and Definition of Aggregation Lines

The above aggregation will generate the following PR code.

newtype Company
  a Ref_Division;
endnewtype;
newtype Ref_Company Ref(Company); endnewtype;
newtype Own_Company Own(Company); endnewtype;
newtype Oref_Company Oref(Company); endnewtype;
newtype Division
endnewtype;
newtype Ref_Division Ref(Division); endnewtype;
newtype Own_Division Own(Division); endnewtype;
newtype Oref_Division Oref(Division); endnewtype;

Figure 397 Aggregation line
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Working with Pages
This section describes the more important aspects of page handling.

Each diagram page must have a unique name for identification purpos-
es. This name must be correct in accordance with the naming conven-
tion for pages in SDL. Each diagram must contain at least one page, and 
there is no maximum amount of pages that a diagram may contain. 

The autonumbering facility available for pages relates to automatically 
updating the sequential numbering when pages are added or deleted.

When diagrams are opened, the default way of presentation is that the 
first page of the requested diagram is shown (first in accordance to the 
order in which pages have been added). This default can be overruled, 
and you can go directly to a specific page that has been predetermined. 

Most of the page managing functions are available through the menu 
choices on the Pages menu. 

A number of functions are available through the Edit menu choice in 
this menu:

• Ordering Pages
• Naming Pages
• Adding a Page
• Renaming a Page
• Clearing (Deleting) a Page
• Pasting a Page
• Transferring to a Page
• Printing a Page
• Resizing a Page

Other page functions are also available in the SDL Editor:

• Applying Autonumbering on Page Names
• Removing Autonumbering on Page Names
• Designating the Page to Open 
• Transferring to a Specific Page
• Transferring to the Referring Page
• Transferring to the Next or the Previous Page
• Transferring to the First Page
• Transferring to the Last Page
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Ordering Pages
Within an SDL diagram, page locations are set according to the order in 
which they are added (see “Adding a Page” on page 1888). This order 
is reflected in:

• The Organizer structure

• The listing order for pages in the Edit Pages dialog

To re-order pages, you use the Cut and Paste button.

Naming Pages
Whenever you name a page, the names that you use must strictly adhere 
to SDL naming conventions. If you use unacceptable notation (e.g. 
blank spaces or a semi-colon), you receive a message.

Applying Autonumbering on Page Names

If autonumbering is required, a feature can assign numeric names to the 
pages in the diagram. The page names will be assigned 1, 2, 3 and so 
forth.

1. Select Edit.

2. Select the page to autonumber in the page list.

3. Toggle the Autonumbered toggle button to on in the Edit Pages di-
alog. You are then prompted if you want to autonumber the selected 
page only or all pages in the dialog which is issued.

– If you click Yes, the SDL Editor assigns the page name the high-
est assigned numeric value + 1. You are then returned to the Edit 
Pages dialog.

– If you click All Pages, all pages will be assigned numeric 
names, starting with 1. The numbering will follow the listing or-
der in the page list. You are then returned to the Edit Pages di-
alog.
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Removing Autonumbering on Page Names

The autonumbering feature can be turned off. This must for instance be 
done if you want to assign a specific name to a page.

1. Select Edit.

2. In the page list, select the page to remove autonumbering on.

3. Toggle the Autonumbered toggle button to off in the Edit Pages di-
alog. You are then prompted to confirm the operation in the dialog 
which is issued.

– Clicking Yes transfers you to a Rename Page dialog where you 
assign the page a new name. Autonumbering is removed.

Adding a Page
To add a page to an existing diagram:

1. Select Edit.

2. In the list of existing pages, select the page to precede or succeed the 
new page to be added.

3. Click the Add button. The Add Page dialog is issued.

A faster way to add a page before or after the current page is to select 
the Add menu choice directly. In this case, the Add Page dialog is issued 
directly.

In the Add Page dialog:

1. Enter the required page name in keeping with SDL conventions (the 
name must be unique within the diagram). Otherwise, select Auto-
numbered if you want the pages to be automatically renumbered to 
incorporate the new page.

2. Select the position of the new page – before or after the current 
page.

3. Select the type of page required. The dialog box automatically 
shows the page options that are available to you under SDL rules.

4. Click OK. Control is returned to the Edit Pages dialog.

5. Click Done.
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Designating the Page to Open
When a diagram is opened without specifying a particular page, the de-
fault is that it is opened at the first page that has been added to the dia-
gram, showing the upper left part of the page. 

You can however open a diagram at a specific page in the SDL Editor. 

To specify the page to be opened first:

1. Bring up the Edit Pages dialog.

The Open this page first field, below the toggle button, reflects the 
page to be opened first (page 1 in Figure 398).

2. To specify another page, select the page to be opened first in the 
Edit pages dialog.

3. Turn the Open this page first button on. The identification of the 
page to be opened is then placed under the Open this page first but-
ton.

4. Click Done.

Figure 398: Specifying what page to open first

The open
this page
first button
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Renaming a Page
1. Select Edit.

2. Select the page to rename.

– To rename an auto-numbered page, first click the Autonum-
bered button off. Autonumbering is removed on the selected 
page and the Rename Page dialog is issued. Go to step 4.

3. Click the Rename button. The Rename Page dialog is issued.

4. Fill in the required new name in keeping with SDL naming conven-
tions. Page names must be unique within the diagram. For block and 
process diagrams, an option is available to also change the page 
type.

5. Click OK. Control is returned to the Edit Pages dialog.

6. Click Done.

Clearing (Deleting) a Page
If there is only page in a diagram, you cannot remove it. A message is 
then shown.

1. Select Edit. 

2. Select the page to be deleted in the page list.

3. Click on the Clear option and then on Clear to delete the page.

4. Click Done.

Pasting a Page
1. Open the SDL diagram where to paste the page.

2. Select the Edit menu choice.

Caution!

Clear pages with caution as there is no Undo option available.
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3. In the list of existing pages, select the page to precede or succeed the 
new page to be pasted. Click the Paste button. The Paste Page dia-
log is issued.

4. Enter the required page name in keeping with SDL conventions (the 
name must be unique within the diagram). Otherwise, select Auton-
umbered if you want the pages to be automatically renumbered to 
incorporate the page to be pasted.

5. Select where to paste the page - before or after the current page.

6. Click Paste. Control is returned to the Edit Pages dialog. 

If there are reference symbols on the pasted page all the underlying 
substructure is also pasted. See “Cutting, Copying and Pasting Ref-
erence Symbols” on page 1851.

7. Click Done.

Transferring to a Page
There are several ways to transfer to another page of the current dia-
gram. When you transfer to a page, it will be placed on the top of the 
stack in the window if you are using one window only. Otherwise, that 
page will be displayed in a window of its own.

Transferring to a Specific Page

• Transfer to a page, located not further than two pages from the cur-
rent page, by selecting that page in the Pages menu.

• In the Edit Pages dialog, transfer to a page by clicking on the re-
quired page and then click on the Edit button.

– Alternatively, double-click the page icon in the Organizer.

Transferring to the Referring Page

To transfer to the page where the current page is referenced from (i.e. 
where the SDL reference symbol referring to the current diagram is lo-
cated): 

• Select Edit Reference Page from the Pages menu or the Reference 
Page quick-button.
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Transferring to the Next or the Previous Page

You may transfer to the next or previous page in the diagram. The order 
is specified according to the listing order in the Edit Pages dialog.

To transfer to the next or previous page:

Transferring to the First Page

Select First from the Pages menu. You are transferred to the first page 
of the diagram.

Transferring to the Last Page

Select Last from the Pages menu. You are transferred to the last page of 
the diagram.

Printing a Page
The SDL suite allows to print individual pages from the SDL Editor. 
You can also restrict the scope of printing to a part of the page. A num-
ber of options which affect the resulting printout are possible to specify.

Resizing a Page
1. Transfer to the page to resize.

2. Select Drawing Size from the Edit menu. A dialog is issued, show-
ing the current width and height.

3. Type in the new values. Click OK.

• Use the quick-buttons for Previous Page or Next Page.

Note:

If you enlarge a page so that the page size becomes wider or larger 
than the physical page size defined in the Print Options, your print-
outs will require more pages than before, if you use a fixed printout 
scale.
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Working with Windows
Each SDL Editor window shows one SDL page. The SDL Editor is a 
multi-window tool, allowing you to open new windows on a page and 
close windows that are no longer needed.

A newly opened window is a mirror image of the window from which 
the selection to open a window was made. Multiple windows may be 
opened (one at a time) and they are all identical with the first one. Any 
subsequent modifications made will reflect the same in either the origi-
nal window, or any of the newly opened window(s). This option affords 
the possibility of viewing in more than one window, and can ideally be 
used in conjunction with the scaling factor when looking at a detailed 
page. 

For information on how you open: 

• The Grammar Help Window, see “Opening the Grammar Help 
Window” on page 1906. 

• The Signal Dictionary Window, see “Opening the Signal Dictionary 
Window” on page 1918.

Opening and Closing Windows
Standardized functions for opening and closing windows are provided 
in the Window menu: New Window and Close Window. If you close the 
last window opened by the SDL Editor, the editor will exit.

Hiding and Showing Parts of the SDL Editor 
Window
You can show and hide the various component parts of the SDL Editor 
window. On UNIX, if they are hidden, it increases the drawing area 
available to be used in the creation or modification of pages of a dia-
gram. 

You find all the available options for hiding and showing parts of the 
window in the dialog box accessed via the Window Options command 
on the View menu. You can set all of these options as preferences.

All of these options are turned on and off with a toggle button. Some of 
these options are available with quick-buttons:
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– If you click All Windows it applies the values to all instances of 
the SDL Editor windows.

Editing Text

General
There are several ways of editing text in the SDL Editor, i.e.

• In the drawing area
• In the text window
• In an external text editor

Two support functions are provided, namely:

• Grammar Help, see “Using Grammar Help” on page 1906.
• Signal Dictionary, see “Using the Signal Dictionary” on page 1917.

Editing in the Drawing Area and Text Window
The SDL Editor allows you to edit textual objects directly in the draw-
ing area.

If you select a text attribute to an object in the SDL Editor window, a 
text cursor is inserted directly in the text associated with the object, and 
the text window will be updated to contain the text. This is explained in 
“Selecting a Symbol That Has Associated Objects” on page 1837 and 
“Selecting a Line That Has Associated Objects” on page 1866. 

When you type text in the drawing area, all accelerator keys are inter-
preted as input to the text. As an example, the <Delete> key will in 
text editing mode delete a character, but in non-text editing mode it will 
remove (Clear) an entire symbol. This means that you can only use text 
editing keyboard accelerators like <Home>, <End>, <Ctrl+A> and 
<Ctrl+E> in text editing mode. 

When editing text directly in the drawing area it is possible to select text 
by dragging the mouse over the text or select words by double-clicking. 

• The quick-button for text window on / off or symbol menu on / off.
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You can extend or reduced the selection by clicking while pressing the 
<shift> key.

To edit large texts it might be more convenient to use the Text Window 
to edit the text. If you select more than one text object, the text window 
is not updated. Each line (except for the last line) in the text window is 
terminated by a carriage return, and may consist of any number of legal 
characters. 

Regardless of whether you edit directly in the drawing area or in the text 
window, the SDL Editor makes sure that the contents of both displayed 
texts are consistent.

A context sensitive syntax check is performed on all texts being edited. 
If a syntax error is found a red bar underlining the text will appear where 
the first error occurs in the text. See also “Syntax Rules when Editing” 
on page 1786.

You can also edit text in an external text editor by using the Connect to 
Text Editor command in the Tools menu. This allows you to use the 
Text Editor, the Emacs text editor (on UNIX) or MS Word (in Windows) 
to edit large pieces of text.

The SDL Editor also supports editing text outside its context, by trans-
ferring text to / from a file.

Text Window
On UNIX, the text window is a pane of the SDL Editor window.

In Windows, the text window is a floating, resizeable and moveable 
window that can be placed anywhere on the screen. A single text win-
dow is shared by all instances of the SDL Editor currently running.

The text window contains two menus described in: 

• “The File Menu of the Text Window” on page 1962
• “Edit Menu” on page 1938

Hiding and Showing the Text Window

You can hide or show the text window with the Window Options com-
mand from the View menu, or by using a quick-button.
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In Windows: When visible, the text window will always be placed on 
top of the SDL Editor window.

Basic Text Editing Functions

Delayed Updating of the Drawing Area

When you edit text in the text window, both the text window and corre-
sponding text in the drawing area will be updated. The the drawing area 
will be updated after a slight time delay and this can be set by an editor 
preference.

If you try to type an illegal character, you will be warned by a beep. 

Standardized Text Editing Functions

When you edit text, you can:

• Position the cursor by clicking or by using the arrow keys. 
• Insert characters after the current position of the text pointer.
• Delete one character backward by pressing <backspace>.
• Delete one character forward by pressing <delete>. 
• Replace selected text by typing. 
• Delete selected text by pressing <backspace> or <delete>.
• Select text by dragging or by clicking and <Shift>-clicking.
• Select a word by double-clicking it.
• Select a line by triple-clicking it.

Searching and Replacing Text
In the SDL editor, you can search for and replace text in a page or in a 
diagram. In the Organizer, you can search for and replace text in a dia-
gram or in a diagram structure that is managed by the Organizer. In both 
the SDL editor and the Organizer, there are two search variants:

• Dialog search
• Fast search

Searching for Text in a Diagram using Dialog Search

To search for text in the current page from the SDL editor:
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2. Specify the text to be found in the Search for text field.

– Click the Consider case button on to search case sensitive.

– Click the Wildcard search button on to use wildcard matching, 
where an asterisk (‘*’) matches a sequence of zero or more char-
acters of any kind.

– Turn the Search all pages button on to specify that the scope of 
search should comprise all pages in the diagram. If you turn the 
button off, the scope of search will only comprise the current 
page. 

3. Click the Search button. The object where the next occurrence of 
text is found will be selected and the text window updated accord-
ingly.

– The diagram that the tool is currently processing is displayed to 
the right of the Search In field.

4. Click Close.

Searching and Replacing Text using Dialog Search

1. Open the Search dialog as described in “Searching for Text in a Di-
agram using Dialog Search” on page 1896.

2. Specify the text to be found in the Search for text field.

3. Specify the text to be replaced with in the Replace with text field.

4. Click the Search button to find the first occurrence.

1. Select Search from the SDL editor’s Tools menu or click the SDL 
editor quick-button for Search. The Search dialog is issued.
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5. If the text is found, the object where the next occurrence of text is 
found will be selected and the text window updated accordingly. 
You may use any of the following options:

– Search further by clicking Search repeatedly

– Replace the text by clicking Replace

– Replace and continue search with the Replace & Search button.

– Replace all occurrences with the Replace All button.

6. Close the Search dialog by clicking Close.

Fast Search

Fast search is like dialog search but without the dialog. The setting from 
the last dialog search is used for Wildcard search. Fast search do never 
consider case, and does always search all objects and all pages. To in-
voke Fast search, type ctrl+F when the SDL editor is not in text editing 
mode. If you are in text editing mode, you can click in the diagram back-
ground first to get out of text editing mode.

When Fast search is invoked, the message area displays the text that will 
be searched for. Initially, the text is Search for:. When you type on the 
keyboard with the mouse pointer over the drawing area, the characters 
will turn up in the message area. When you have typed the text pattern 
to search for, press enter or return to start the search operation.

The same search operation as for Dialog search is used. If the search op-
eration finds a match, you can search for another match by pressing en-
ter or return once more. 

To finish the Fast search operation, click in the drawing area or select 
another operation.

The next time Fast search is invoked with ctrl+F, the search text that 
was used the last time is proposed as a search text once more. To use it, 
press enter or return. To use another search text, press ctrl+F once more 
or the delete key several times, to erase the search text.

Editing Text by Using an External Text Editor
Whenever a text object is selected and the text is visible in the text win-
dow, the command Connect to Text Editor in the Tools menu is avail-
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able. This command opens an external text editor containing the text of 
the selected object. Which external text editor to start is defined by the 
preference SDT*TextEditor, which can be set either to the Text Editor 
or to the Emacs text editor (on UNIX).

From this point on, you can only edit the text by using the external text 
editor.

The text in the SDL Editor is updated every time the external text editor 
saves the text. When the text is no longer edited in the external text ed-
itor, the editing control returns to the SDL Editor.

Importing / Exporting Text
The SDL suite allows you to import and export text from / to a file. You 
can, for instance, import text from files that contain SDL/PR into text 
symbols and export the contents of text symbols to files.

Importing Text from a File

You can import the contents of a text file into an object managed by the 
SDL Editor in the following way:

1. Select the object where you want to import the contents of a file. 

2. Select Import from the text window’s File menu.

3. Specify the file to import.

4. Click OK. This replaces the contents of the text window with the 
contents of the file you have specified in the file selection dialog.

Exporting Text from a File

To export the contents of the text window into a file:

1. Select the object which text you want to export to a file. 

2. Select Export from the text window’s File menu.

Caution!

Importing text from a file replaces existing text as well. Use the 
Undo facility to revert to the original text, as long as the symbol is 
selected – deselecting the symbol will disable Undo.
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3. Specify the file to export the text to.

4. Clicking OK possibly creates a new file and replaces the contents of 
the file with the contents of the text window. 

Copying, Cutting and Pasting Text
In the text window, you can cut, copy and paste text between different 
symbols, lines and text attributes. You can also transfer text between 
different applications.

Programmable Function Keys (UNIX only)
On UNIX, the SDL suite allows to tie a function key to a defined text 
string. When you type that defined function key, the programmed text 
string will be inserted at the current cursor location. You can customize 
your own programming of function keys.

Global SDL Suite Resources

The function keys are set up as X resources. It is possible to set up both 
system default and user-defined X resources, allowing you to customize 
your environment. The X resources are defined in a file that is common 
for all SDL suite users, namely

/usr/lib/X11/app-defaults/SDT 

To program the function keys, insert following lines anywhere into the 
SDT file:

/* Any suitable comment */
SDT*XmText.translations: #override \n\
<Key>F1: insert-string(“F1Text”) \n\
<Key>F2: insert-string("F2Text") \n\
<Key>F3: insert-string("F3Text") \n\
<Key>F4: insert-string("F4Text") \n\
<Key>F5: insert-string("F5Text") \n\
<Key>F6: insert-string("F6Text") \n\
<Key>F7: insert-string("F7Text") \n\
<Key>F8: insert-string("F8Text") \n\
<Key>F9: insert-string("F9Text")
/* Note the absence of \n\ on line 9 */

Note:

Omitting to define some of the function keys is permissible.
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User-Defined Resources

You can define your own function keys. You do this by defining the X 
resources described above in a personal copy of the definition file and 
to store that file it into your home directory:

 ~username/SDT

Alternatively, any directory designated by the environment variable 
XAPPLRESDIR can be used. 

Restrictions

• You can only define one line for each function key. If you attempt 
to define more than one line into one function key may cause an un-
predictable result when you press that key.

For instance, it is not certain that the following line will produce the 
expected result:

<Key>F1: insert-string("F1Line1\nLine2") \n\ 
  

• You can define the keys F1–F9.

Changing Fonts on Text Objects 
You may change the font faces and font sizes used in the textual objects 
displayed by the SDL Editor. All textual objects use the same font faces 
and font sizes, meaning that you can neither change them individually 
nor change them during an SDL Editor session. 

There is one exception though – it is possible to use a separate font for 
text symbols. This is useful in process diagrams where you may want a 
proportional font in most symbols to save space, while you may want a 
non-proportional font in text symbols to be able to align words on dif-
ferent lines.

The font faces available depend on the target system on which you are 
running the SDL suite.

Defining What Font to Use

To modify the desired font size and font face, you must use the Prefer-
ence Manager. See chapter 4, Managing Preferences.
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Textual Objects Preferences

When the setting is in effect, the SDL suite will use the font face names 
given by the preference settings

Editor*FontText*ScreenFontFamily
Editor*FontText*PrintFontFamily

to select font face names. Note that in this way you can select different 
font names for screen and for print. 

On UNIX, if you leave the Editor*FontText*ScreenFontFamily prefer-
ence setting empty, you will edit your documents using the SDT Draft 
font, but print them using the font you specified with the Editor*Font-
Text*PrintFontFamily setting.

Text Symbol Preference

For text symbols, the preference Editor*FontText*TextSymbolFont-
Family is used both for on-screen viewing and printing.

Supported Font Faces

On UNIX, the availability of font faces is determined by the version of 
the X Windows server which is running. With a revision 5 or higher 
(X11 R5), scalable fonts are supported. In that case, the available list of 
predefined font faces would be:

• Times
• Helvetica
• Courier
• SDT Draft (mapped to the Schumacher font)
• Other (mapped to a user-defined font)

In Windows, the availability of font faces is determined by the True-
Type fonts that are currently installed on the computer (use for instance 
the Windows Control Panel to determine what is available).

Default Font Face

The default font face is Helvetica. On UNIX, if scalable fonts are not sup-
ported, the font face will be replaced by a Schumacher font (which can 
be used in all circumstances).
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Default Font Sizes

The default font sizes are as follows:

Setting Alignment

Normally the alignment of the text inside symbols are automatically set. 
However, you can use the preference setting Editor*Font-
Text*TaskSymbolLeftAligned to set the alignment for the task symbol, 
procedure call symbol, macro call symbol, create request symbol and 
the save symbol. The default value is “off”, meaning that the text will 
be centered, but if you set it to “on” the text in these symbols will be left 
aligned.

Determining Which Scalable Fonts Your Server Can Access 
(UNIX only)

On UNIX, use the xlsfonts command to list installed fonts. Font names 
containing 0 for width and height are scalable.

How to Determine what Fonts are Available

From the OS prompt, typing:

hostname% xlsfonts | grep “\-0\-O\-“ | more

will return a list of accessible scalable fonts.

Page Font Sizes (except overview pages)

Text Object: Font Size

Kernel heading, texts in reference symbols, channel 
names, signal route names, gate names

12 points

Other text objects 9 points

Overview Page Font Sizes 

Text Object: Font Size:

All texts except signal lists 10 points

Signal list symbol 8 points
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Scalable Fonts Under R5 Servers

To use scalable fonts under X11R5 you must normally first connect to 
a font server.

How to Start the Font Server

1. Start the font server on any local host: 

hostname% fs

2. Connect the server to fs indicating which host the font server is 
running on (which can be the same host that the X server is running 
on): 

hostname2% xset +fp tcp/<hostname>:7000

For further information see the X11R5 documentation or use man fs 
to read the manual page describing the font server you are running.

Disabling Font Scaling (UNIX only)

On UNIX, if the fonts look poor on the screen, a possible work-around is 
to disable the scaling option.

To do this, you should edit the SDT resource file.

1. Open the file SDT in a text editor.

2. Locate the line with the text: SDT*sdtUseScalableFonts

3. Change the line to SDT*sdtUseScalableFonts: false 

4. Save the file and restart the SDL suite environment.

Note:

Disabling font scaling effectively disables WYSIWYG!
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Grammar Help and Signal Dictionary

General
Besides the context sensitive syntax check performed on the texts, there 
is a grammar help support function. It assists you in entering the correct 
text, according to the SDL grammar, in the selected text attribute to an 
object.

Designing using SDL implies to large extent defining, sending and re-
ceiving signals. A signal dictionary assists you in reducing the time it 
takes to find out names and parameters for a signal that you already 
have used somewhere in a diagram. The signal dictionary also incorpo-
rates timers. 

Keyboard Accelerators (UNIX only)
In addition to the standard keyboard accelerators, described in “Key-
board Accelerators” on page 35 in chapter 1, User Interface and Basic 
Operations, the Grammar Help and Signal Dictionary window features 
the following:

Accelerator Command / functionality

g Select the Grammar section if the option is enabled and bring the 
separator into view

u Similar to g but applies on Up.

t Similar to g but applies on This.

d Similar to g but applies on Down.

a Similar to g but applies on All.

m Similar to g but applies on MSC.

e Similar to g but applies on External.

Ctrl+g Toggles the Grammar option on / off (see “Grammar” on page 
1965). When the option is enabled, brings the Grammar separator 
into view and selects it.

Ctrl+u Same as Ctrl+g, but applies on the Up option.
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Using Grammar Help
The Grammar Help window is a multi-functionality window; it can also 
provide signal dictionary capabilities. These functions are further de-
scribed in “Using the Signal Dictionary” on page 1917. What function-
ality is provided depends on the options defined in the Select menu.

Each SDL Editor window has its associated Grammar Help window.

Opening the Grammar Help Window

• Select the Grammar Help menu choice from the Windows menu.

 The grammar help window is issued (see Figure 399 on page 1908).

Requesting Grammar Help

If you select the object you need assistance on, you will see the key-
words and options available for use in given situations, and the corre-
sponding reference to sections of the ITU Z.100 SDL Definition, fol-
lowed by the grammar syntax of the meta language. 

Ctrl+t Same as Ctrl+g, but applies on the This option).

Ctrl+d Same as Ctrl+g, but applies on the Down option.

Ctrl+a Same as Ctrl+g, but applies on the All option.

Ctrl+m Same as Ctrl+g, but applies on the MSC option.

Ctrl+e Same as Ctrl+g, but applies on the External option.

Ctrl+f Finds the last occurrence of the first word in the currently select-
ed object in the SDL Editor drawing area and selects it in the This 
section. 
The first word is defined as the text string from the start of the ob-
ject’s text and until one of the following characters:
‘ ’ (space) ‘,’ (comma) ‘(‘ (left parenthesis) <TAB> ‘\n’ (newline)

Accelerator Command / functionality
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To request grammar help:

• Select the object of interest. The grammar help window contents are 
automatically updated to list the following:

– The nature of the selected object
– The grammar for that object
– The various “use cases”.

Inserting Text

This operation inserts the contents of the grammar help window into the 
SDL Editor text window.

To insert the text related to a given “use case”:

1. Locate the “use case” of interest. The left part of the window pro-
vides a list of situations, named using some abbreviation that asso-
ciates to the situation.

– The first item(s) in the list reads GRAMMAR, possibly with a 
suffix that informs you about the grammar context. You can 
take advantage of the GRAMMAR items either as using the ref-
erences to Z.100 if you need more detailed information about 
the selected sort of object, or if you need to read more about the 
concrete grammar.
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– The next items contains a number of “use cases”. As an exam-
ple, if you select a task symbol, the first “use case” reads 
Assignment, while the second reads Assignment2. This is to be 
interpreted as: 
An assignment statement,
Multiple assignment statements in a task symbol.

Figure 399: The grammar for a task symbol
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2. Click on the item of interest to select it.

3. Select Insert from the Edit menu or double-click the item in the list. 
The contents of the right part of the window are inserted into the 
SDL Editor text window, at the current I-beam cursor position.

4. Finally, replace the formal notation with the appropriate values, 
variables, signals, etc. used in your diagram.

Replacing Text

This operation signifies replacing the contents of the SDL Editor text 
window with the contents of the grammar help window.

• Proceed as described in “Inserting Text” on page 1907, but select 
Replace from the Edit menu.

Customizing the Grammar Help

With the SDL suite, a standard grammar help template file is provided. 
In addition to this, the SDL Editor allows you to use your own templates 
and to merge these with the standard templates.

Figure 400: The Assignment “use case”
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To create grammar help definitions:

1. Copy an existing grammar help file.

2. Edit the file using any text editor (the grammar help file is an ASCII 
file). See “The Grammar Help File” on page 1912 for a description 
of the contents and syntax of the file.

To use another grammar template definitions:

• Select Load from the File menu. In a File Selection Dialog you then 
specify what template definitions to load.

To merge the current grammar template definitions with another one:

• Select Load from the File menu. In a File Selection Dialog, you then 
specify what template definitions to merge with the current.

The Symbol Label

The symbol label field is a non-editable text field that displays the type 
of symbol that is currently selected in the SDL Editor.

The symbol label reads “No single symbol selected” in the following 
circumstances:

• No symbol or line is currently selected in the SDL Editor
• More than one symbol is selected
• The symbol type is not defined in the Grammar Help file.

The Name Field

The name field consists of a scrollable list that contains a list of names 
of templates associated with the currently selected symbol.

Figure 401: The symbol label

The
symbol
label
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The list is updated automatically each time an object in the SDL Edi-
tor’s drawing area is selected, to reflect the templates that are currently 
available for that object. By default, the first item in the list is selected.

The name field is empty in the following circumstances:

• The symbol label reads “No single symbol selected”
• The symbol type information is missing in the Grammar Help file.

When selecting an item in the list, the corresponding template definition 
appears in the grammar field, allowing to check its contents before in-
serting it into the text window (see “Insert” on page 1964 and “Replace” 
on page 1964).

The Grammar Field

The grammar field is a scrollable field from which text can be copied. 
Its contents are updated to reflect the definition for the currently select-
ed item in the name field.

The grammar field is empty if no item is selected in the name field (or 
if the name field is empty).

Figure 402: The name field

The name field
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To copy and paste text from the template definition field to the text win-
dow, you can:

• Use the Insert command, described in “Insert” on page 1964.

• Use the Replace command, described in “Replace” on page 1964.

• Copy and paste by using the graphical environment clipboard func-
tions. 

The Grammar Help File

This section is a reference for the format of the files that contain SDL 
Grammar Help definitions.

The template definition file format is line-oriented, and uses two sepa-
rator characters chosen so as to not interfere with the possible contents 
of templates appearing in the file.

The template definition file is divided into sections defining templates 
for a particular symbol type. A section begins with a Grammar Help 
Declaration part and ends with a Grammar Help Definition part.

Figure 403: The grammar field

Note:

The characters ‘@’ and ‘$’ are separator characters. They are re-
served for that purpose.

The grammar field
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The grammar help declaration of a new section has the following syn-
tax:

@<editortype>@<symboltype>[@[<symbolcomment>]]

<editortype>, <symboltype> and <symbolcomment> are to be replaced 
with the adequate text strings.

Comments in Grammar Help files are also permissible.

Example 305: The Declaration of a Channel Template –––––––––––––

@SDL@CHANNEL@Channel symbol

The declaration is to be interpreted as:

• SDL

Valid for the SDL Editor only

• CHANNEL

A channel line

• Channel Symbol

An informative text that will be displayed to you (see “The Symbol 
Label” on page 1910).

––––––––––––––––––––––––––––––––––––––––––––––––––––––––––  

editortype 

editortype may currently be of one of the keywords: 

•  - The section contains templates relevant for the SDL Editor.

•  - The section contains templates for the Message Sequence Chart 
Editor.

Note:

Grammar Help is currently not supported by the MSC Editor. The 
MSC keyword is reserved for future functionality extensions.
July 2003 Telelogic Tau 4.5 User’s Manual ,um-st1 1913



Chapter 44 Using the SDL Editor 
symboltype 

symboltype is defined per editor and the allowed names are the follow-
ing:

ADDITIONAL_HEADING_BLOCK
ADDITIONAL_HEADING_BLOCK_TYPE
ADDITIONAL_HEADING_PROCEDURE
ADDITIONAL_HEADING_PROCESS
ADDITIONAL_HEADING_PROCESS_TYPE
ADDITIONAL_HEADING_P_AS_SERVICE
ADDITIONAL_HEADING_SERVICE
ADDITIONAL_HEADING_SERVICE_TYPE
ADDITIONAL_HEADING_SYSTEM
ADDITIONAL_HEADING_SYSTEM_TYPE
BLOCKSUBSTRUCTURE
BLOCK_REF
BLOCK_TYPE_REF
CALL
CHANNEL
CHANNELSUBSTRUCTURE
CONNECTION_POINT
CONNECTOR
CONTINUOUS_SIGNAL
CREATE
DECISION
ENABLING_CONDITION
GATE
INPUT
KERNEL_HEADING
KERNEL_HEADING_BLOCK
KERNEL_HEADING_BLOCK_TYPE
KERNEL_HEADING_PROCEDURE
KERNEL_HEADING_PROCESS
KERNEL_HEADING_PROCESS_TYPE
KERNEL_HEADING_SERVICE
KERNEL_HEADING_SERVICE_TYPE
KERNEL_HEADING_SYSTEM
KERNEL_HEADING_SYSTEM_TYPE
MACROCALL
OPERATOR_REF
OUTPUT
CLASS
PACKAGE_REF
PAGENUMBER
PRIORITY_INPUT
PRIORITY_OUTPUT
PROCEDURE_REF
PROCEDURE_START
PROCESS_REF
PROCESS_TYPE_REF
RETURN
SAVE
SERVICE_REF
SERVICE_TYPE_REF
1914 ,um-st1 Telelogic Tau 4.5 User’s Manual July 2003



 Grammar Help and Signal Dictionary
SIGNALROUTE
START
STATE
STOP
TASK
TEXTSYMBOL_BLOCK_SUBSTR
TEXTSYMBOL_MACRO
TEXTSYMBOL_PROCEDURE
TEXTSYMBOL_PROCESS
TEXTSYMBOL_P_AS_SERVICE
TEXTSYMBOL_SERVICE
TEXTSYMBOL_SYSTEM
TRANSITION_OPTION

symbolcomment 

symbolcomment is an optional feature, which allows specification of a 
text to be associated with each symboltype. The text for a specific sym-
boltype appears in the symbol type field of the Grammar Help window 
whenever a symbol of that type is selected in the editor.

Comments 

Also, comments may appear in the file using the following syntax:

@COMMENT@<commenttext>

Grammar Help Definition 

A SDL grammar template has significance only if it is located after a 
valid declaration. The template will be added to the list of templates for 
that section. 

A template definition is started with a line beginning with a ‘$’ sign and 
continues until either:

• A line beginning with a ‘$’ sign is read.
• A line beginning with a ‘@’ sign is read.
• End of file is encountered.

Note:

If the same section appears more than once, all template definitions 
under those sections will be available.

Note:

Such a comment signals the end of the previous section and should 
only be used before another section.
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The syntax of a template definition is simply:

$<templatename>’Newline’
<multiple lines constituting the template 
definition>

Example 306: The definition of a channel example ––––––––––––––––

$GRAMMAR
Z100: 2.5.1 (p.45)
Z100: 2.5.5 (p.50) Signal list

<ChannelName> ::= <Name>
<SignalList> ::=
  ( <SignalName> / ’(’ <SignalListName> ’)’ )”,’
$SignalList
SignalName, SignalName
$SignalList2
SignalName, SignalName, (SignalListName)

––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

File Handling

When a Grammar Help window is opened, the SDL Editor will try to 
locate a SDL grammar help file and to load it, if found. The search order 
is as follows:

1. The SDL Editor starts by fetching the preference value 
Editor*TemplateFile. 

2. If no value is specified for the preference parameter, it will use the 
default file name sdt.tpl. 

3. The directories where the SDL Editor will search for the file are:

– The current directory
– Your home directory ($HOME on UNIX and %HOME% in Win-

dows)
– The installation directory ($sdtrelease on UNIX)

4. If no file can be located, either with a specified name or the default 
name, you get the option of searching manually (i.e. from a File Se-
lection Dialog) for files with the standard file name extension .tpl. 

Note:

Neither leading nor trailing newlines will be added to the template 
definition. These can be added to the template simply by adding a 
leading empty line and/or a trailing empty line in the template defi-
nition.
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5. If you decline by clicking Cancel, the Grammar Help window will 
appear without contents. You can now locate a grammar help file by 
choosing Load (or Merge, which will have the same effect in this 
case).

Using the Signal Dictionary
Messages from a Message Sequence Chart and signals from an external 
signal dictionary may be included into the SDL Editor’s signal dictio-
nary.

All functionality is provided in the signal dictionary window. Each SDL 
Editor window has its associated Signal Dictionary window.

Note:

The signal dictionary function requires a file with grammar help 
templates (sdt.tpl) in order to function properly. See “The Gram-
mar Help File” on page 1912.

Figure 404: The Signal Dictionary window (on UNIX)

The symbol
label

The signal
list

The signal
definition list
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Signal Dictionary Update

The signal dictionary function stores information about signals in an in-
formation server. The information server updates its contents each time 
an SDL diagram is saved. When the diagram is saved by the SDL Ed-
itor, the SDL Analyzer is invoked and produces a mirrored image which 
is an SDL/PR description of the SDL/GR diagram. That information is 
then loaded into the information server which serves the SDL Editor 
with information upon request. All of this is done automatically.

Opening the Signal Dictionary Window

• Select Signal Dictionary from the SDL Editor Windows menu. The 
signal dictionary window is issued (see Figure 404 on page 1917 
and Figure 405 on page 1918). 

Setting the Mode to Graphical or Textual (UNIX only)

On UNIX, the signal dictionary window can take advantage of your com-
puter’s font capabilities to present the information in a graphical way, 
using SDL-like notation. This is the default mode.

Figure 405: The Signal Dictionary window (in Windows)

Note:

In order to extract signal information from a diagram, the SDL suite 
requires the diagram to be syntactically correct in the sense that 
SDL/PR code can be generated from the SDL/GR diagram without 
encountering errors. 

The symbol
label

The signal
list

The signal
definition list
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If the information is presented using strange characters, your terminal 
does not support the font family used by the signal dictionary window. 
You should use the textual mode.

To turn the mode to textual:

1. Set the environment variable SDLENOGRAPHICS

– If you are to run several Signal Dictionary sessions in this mode, 
you may want to set the environment variable in a file that you 
will automatically source (e.g. .cshrc)

2. Exit all SDL suite tools.

3. Restart the SDL suite to have the environment variable affect the be-
havior.

Requesting Signal Dictionary Services

When you select an object where a reference or definition of a signal 
makes sense, the signal dictionary window is automatically updated to 
reflect the signals and signal conveyors1 that are available according to 
what options you have selected.

The signal dictionary function responds when selecting the following 
objects (see “Object” on page 1929 for more details):

• channel
• signal route
• connection point
• gate
• signal input
• signal output
• priority input
• save of signal
• text symbol

Updating the Signal Dictionary

The signal dictionary is automatically updated each time you save an 
SDL diagram or an MSC that is referred to in the Organizer’s SDL Sys-
tem Structure chapter.

1. The term signal conveyor denotes a communication path that conveys signals; a 
channel, signal route, a gate or connection point.
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When modifying an SDL diagram, you may have unintentionally intro-
duced SDL constructs that are incomplete and thus cause the signal dic-
tionary to fail in providing signal information for that diagram. 

Where the signal dictionary fails on a diagram, a bug symbol (on UNIX), 
or an error message (in Windows) will appear after the diagram name in 
the signal list. Correct the source of error and save the diagram again. 
For a reference on signal dictionary errors, see “Error Notification” on 
page 1935.

Specifying the Signal Dictionary Options

You can customize the signal dictionary to fit your needs, by restricting 
or extending the amount of information that is presented through a set 
of options that you can activate or deactivate.

Depending on the method you are following when designing with SDL, 
you should activate the required options. 

Next follows a guide for when to use the available options.

To enable an option:

1. Activate the Select menu. 

2. Toggle the appropriate option on by selecting it (an option which is 
enabled is indicated with an asterisk preceding the option name). 
Selecting the option once again disables it.

– Alternatively, select the Options menu choice and toggle the 
buttons on or off. When satisfied, click OK.

Bellow follows a few general guidelines for enabling the various op-
tions, depending on the approach you are following when designing 
with SDL.

Working Top-Down

This expression means starting by designing the root diagram (e.g. the 
system diagram) and continuing with the block diagrams, next the pro-
cess diagrams and so forth.

Note:

The more options are enabled, the more information is computed by 
the SDL Editor and the more time it takes.
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If you follow this approach, selecting the Up option will enable access 
to signals used one level up in the SDL hierarchy. This option is enabled 
by default.

– You may also type <Ctrl+u> to toggle the option. Typing u 
brings the Up option into view (if enabled).

Working Bottom-Up

Following this method means starting with the diagrams at a deeper lev-
el (e.g. procedures) and working upwardly in the SDL hierarchy.

If you work bottom-up, select the Down option to enable access to sig-
nals used one level down in the SDL hierarchy. This option is enabled 
by default.

– You may also type <Ctrl+d> to toggle the option. Typing d 
brings the Down option into view (if enabled).

Working with Local Signals

If you look for entities that are used locally in a diagram, select the This 
option. Remember, a diagram needs to be saved in order to update the 
signal dictionary.

– You may also type <Ctrl+t> to toggle the option. Typing t 
brings the This option into view (if enabled).

– To find the definition of the signal in the This section, you may 
select an object in the drawing area that uses the signal and type 
<Ctrl+f>.

Listing all Signals

You can list all signals that are visible according to the SDL scope rules 
by turning the All option on. For instance, a signal that you declare on 
the system level will be available in all diagrams in the SDL hierarchy.

– You may also type <Ctrl+a> to toggle the option. Typing a 
brings the All option into view (if enabled).

Using Packages

If you want to gain access to signals that you have declared in a pack-
age, you should enable the All option.
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Using Diagram Types

If you use the diagram type concept, you should enable the All option to 
gain access to the signals that are defined in the diagram types.

Listing MSC Messages

If you describe the dynamic behavior of an SDL diagram using the MSC 
Editor, you may take advantage of this by turning the MSC option on.

Importing an External Signal Dictionary

You may import an external signal dictionary into the SDL suite 
through the Postmaster interface. This is described in “Load External 
Signal Definitions into the Information Server” on page 680 in chapter 
13, Using the Telelogic Tau Public Interface.

Note:

Messages used in an MSC will be available in the signal dictionary 
only if it is associated with an SDL diagram, i.e. linked into the SDL 
diagram structure.
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Locating the Source Diagram

Note: Signal Dictionary and OO

If you are looking for a source diagram that is an SDL-92 type (sys-
tem type, block type, process type or service type) and that you ac-
cess through an instance of the type, the following conditions must 
be respected in order to have the signal dictionary window list the 
diagram and list all of the signals and signal conveyors that are used 
in the diagram:

• The type diagram must be referred in the same diagram as 
where it is instantiated. In the signal dictionary window, only 
the type will be listed, not the instance. Figure 406 shows an ex-
ample of this. 

– As a consequence of this, you will not be able to look into 
the instance of a type that is defined in a package diagram 
and used in the current SDL system.

• In the case the type is inherited from a supertype, the entities that 
you are looking for must be defined in the child type. 

The main cause of this limitation is that channels and signal routes 
are connected to the instance, not to the type.

Figure 406: The type is referred where instantiated

The process type Controller is instantiated as Cl. The process instance Cl will be 
visualized as the process type Controller, and you can list signals conveyed on the 
gates A, B, C, D and E.
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To locate the source diagram (i.e. the diagram where the signal is used 
or where the signal conveyor is available):

1. Locate the section (Up, This, Down, All, MSC and External) by 
scrolling up or down. The sections are listed in that order and the 
start of each section is identified with a separator with the corre-
sponding name.

– You may also use the keyboard accelerators <Ctrl+u>, 
<Ctrl+t>, <Ctrl+d>, <Ctrl+a>, <Ctrl+m> and 
<Ctrl+e> to toggle the respective option on and off.

– Use the keyboard accelerators u, t, d, a, m and e to bring 
the respective section into view.

2. Identify the source diagram by its type and name. Diagrams are list-
ed alphabetically by their name. The diagram type is identified ei-
ther by a graphical SDL-like symbol (see Figure 414 on page 1931) 
in the left margin (UNIX only), or by a text string that consists of the 
diagram type. 

Updating the Text in the Target Diagram

Once you have located the source diagram your next task is to insert the 
text belonging to the object you have selected in the target diagram (the 
diagram where the change is to be done).

Updating a Signal / Timer Output, Input, Priority Input or Save

This operation makes sense only on pages where the implementation is 
described, i.e. the flow pages.

1. Locate the matching signal or timer in the signal list. 

– Signals are identified graphically with the SDL signal input 
and/or signal output symbol (UNIX only), or with the characters 
‘I’, ‘O’ or ‘?’ (see “Signal and Signal List” on page 1933.

– Timers are identified with the MSC timer symbol (UNIX only), 
or the character ‘T’ (see “Timer” on page 1935).

2. Make sure the signal output, input, priority input or save symbol to 
be updated is selected in the target diagram.
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3. Select the signal or timer item in the signal list. Use Insert or Re-
place from the Edit menu to update the symbol contents. The target 
symbol is updated with the signal name and its formal parameters.

– Alternatively, double-click the signal or timer.

4. Update the signal’s formal parameter type with a current parameter.

Updating a Signal Conveyor 
(Channel, Signal Route, Connection Point or Gate)

1. Locate the signal conveyor that constitutes the corresponding item 
that interfaces to the channel, signal route or gate that you are to up-
date in the current diagram.

– In graphical notation on UNIX, these entities are identified 
graphically by a symbol which has the appearance of the corre-
sponding SDL concept (see Figure 415 on page 1932, 
Figure 416 on page 1932 and Figure 417 on page 1933). 

– Channels, signal routes and gates are identified textually with 
the abbreviations CH, SR and GA, respectively.

2. Make sure the signal list is selected in the target diagram. 

3. Select the signal conveyor. Use the Insert or Replace from the Edit 
menu to update the signal list contents.

– Alternatively, double-click the signal or timer.

Figure 407: Selecting the signal Display
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4. In the case of a bidirectional conveyor, you will see lines of text in 
the right window, each one corresponding to a signal list (as in 
Figure 408, above). You should copy each line of text to the corre-
sponding signal list. Select the signal list in the SDL Editor and a 
line, then use Insert or Replace to update the signal list.

Updating a Text Symbol

When updating a text symbol, you are likely to declare signals and tim-
ers that you have referred to in the current diagram or referred to in the 
SDL hierarchy descending from the current diagram.

1. You should make sure the Down and This options are selected. 

2. Remember to add a SIGNAL or TIMER keyword in the text sym-
bol, before the enumeration of signals.

3. Locate all diagrams of interest. Look for signals / timers that you 
want to declare. Double-click each signal, and insert the necessary 
commas to create a syntactically correct declaration. Terminate the 
operation by inserting a semicolon.

Finding a Definition

When you select an object in the SDL Editor’s drawing area and then 
type <Ctrl+f> the first occurrence of the first word in the object is 
looked for and selected in the This section. 

Figure 408: Selecting the Channel cPanelToControl:int:int
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Closing the Signal Dictionary Window

You close the signal dictionary window by selecting Close from the sig-
nal dictionary File menu. 

The Symbol Label

The symbol label field is a non-editable text field that displays the type 
of object that is currently selected in the SDL Editor.

The symbol label reads “No single symbol selected” in the following 
circumstances:

• No object is currently selected in the SDL Editor
• More than one object is selected.
• The symbol type is not defined in the Grammar Help file.

The Signal List

The signal list is a selectable list where all occurrences of signals that 
are found according to the current selection criteria are listed.

Figure 409: The symbol label

The
symbol
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Figure 410: The signal list (on UNIX)

Figure 411: The signal list (in Windows)

The signal list

The signal list
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The signal list is empty when:

• The symbol label reads “No single symbol selected”

• The signal dictionary function does not make any sense on the se-
lected object. i.e. the selected object does not refer/define a signal. 

The following objects are recognized as carrying signal information:

Signal List Notation and Syntax

Each line in the signal list follows a notation that informs about the var-
ious diagrams and symbols where signals are used and also about the 
context. 

In Windows, this notation is purely textual.

On UNIX, the notation that is adopted is an SDL-like graphical notation. 
It is also possible to select a textual notation if the font face used in the 
graphical notation is not supported by the computer. You select the tex-
tual notation by setting the environment variable SDLENOGRAPHICS be-
fore you start the SDL suite.

Object Usage

channel line
channel name
signal list in channel

Reference to signal

connection point Reference to signal

gate
gate name
signal list in gate

Reference to signal

input Reference to signal

output Reference to signal

priority input Reference to signal

save Reference to signal

signal route line
signal route name
signal list in signal route

Reference to signal

text Declaration of signal
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Each item in the signal list is one of the following:

• Separator
• Diagram Identifier
• Gate
• Channel
• Signal Route
• Signal and Signal List
• Timer

Separator

The signal list is divided into several sections. The top of each section 
is clearly marked with a separator, having the appearance of a thick line 
(graphical notation on UNIX) or a number of hashes (“###...###”) 
preceding and following a text that identifies the section.

  

Each of these sections corresponds to an option that is enabled in the Se-
lect menu (see “Select Menu” on page 1964). Their meaning and order 
of appearance in the signal list is as follows:

• Grammar

SDL Grammar Help section. See “Using Grammar Help” on page 
1906 for more information about this topic.

• Up

A list of all SDL signals that are available1 by looking one level up 
in the SDL hierarchy. The Up section is empty when working on the 
top diagram (e.g. a system diagram).

• This

All SDL signals that are available by looking at the current diagram, 
i.e. this diagram.

Figure 412: A signal list separator (graphical notation on UNIX)

Figure 413: A signal list separator (textual notation)

1. The term “available” means defined and / or referenced.
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• Down

All SDL signals that are available by looking at all diagrams one 
level down in the SDL hierarchy. The Down section is empty if the 
current diagram has no diagrams below it in the hierarchy.

• All

All defined SDL signals that are visible for the current diagram ac-
cording to the SDL scope rules.

• MSC

Signals that have been exported from a Message Sequence Chart 
into the SDL Editor signal dictionary facility. An MSC must be As-
sociated with an SDL diagram in the Organizer’s diagram structure 
in order to include its signals into the Signal Dictionary (see “Asso-
ciate” on page 97 in chapter 2, The Organizer).

• External

Signals that have been imported from an external signal dictionary. 
An external signal dictionary is imported through the public Post-
Master interface of the SDL suite. See “Load Definition File” on 
page 625 in chapter 12, The Telelogic Tau Public Interface.

Diagram Identifier

In the graphical notation on UNIX, diagrams are identified with an SDL 
Reference symbol in the left margin which identifies the diagram type, 
followed by the diagram name:

The textual notation reads <diagramtype diagramname> 

All information that is listed after a diagram identifier is related to that 
diagram, until the next diagram identifier or separator.

Figure 414: Diagram type symbols (graphical notation on UNIX)

service type
service
package
procedure or operator
system type or block type
process type
block, substructure or system
process

macro
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Gate

In the graphical notation on UNIX, gates are identified by an arrow 
pointing into or out from the frame, followed by the name of the gate:

The textual notation reads:

GA <Gatename>:<In>|<Out>|<In:Out>

Signals on a gate are the lines that appear after the gate and before the 
next gate, channel, signal route or diagram identifier. The lines consist 
of all signals or signal lists that are conveyed on the gate, the signals 
sent to the diagram appearing first and the signals sent from the diagram 
appearing last. 

Signals are listed according to the order of appearance in the respective 
signal lists.

If you select a gate in the list, one or two lines is displayed in the signal 
definition list. In the case of a bidirectional gate, the first line holds the 
signals sent to the diagram while the second line holds the signals sent 
from the diagram.

Channel

In the graphical notation on UNIX, channels are identified by an arrow 
between the frame and a block symbol (in the case of a channel to/from 
the environment), alternatively with an arrow between two block sym-
bols (an internal channel):

Figure 415: Gate symbols (graphical notation on UNIX)

Figure 416: Channel symbols (graphical notation on UNIX)

In gate
Out gate

In/out gate

In channel

Out channel

In/out channel

Internal channel

Internal channel (bidirectional)
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The textual notation of a channel is:

CH <Channelname>:<In>|<Out>|<In:Out>|<Int>|<Int:Int>

Channels are present on package, system, block, block substructure and 
system type diagrams only.

The lines of information that follow a channel consist of the signals that 
are conveyed on it. The appearance is similar to listing signals on a gate. 
See “Gate” on page 1932 for information about listing order.

Signal Route

In the graphical notation on UNIX, signal routes are identified by an ar-
row between the frame and a process symbol (a channel to/from the en-
vironment), alternatively with an arrow between two process symbols 
(an internal signal route).

The textual notation of a signal route looks like this:

SR <Signalroutename>:\
<In>|<Out]>|<In:Out>|<Int>|<Int:Int>

Signal routes are present on block and block type diagrams only.

The lines of information that follow a signal route consist of the signals 
that are conveyed on it. The appearance is similar to listing signals on a 
gate. See “Gate” on page 1932 for information about listing order.

Signal and Signal List

Signals and signal lists can appear in the following contexts:

• Signal Definitions (i.e. declarations in text symbols)

• Signal References on Lines (i.e. references in gates, channels and 
signal routes)

Figure 417: Signal route symbols (graphical notation on UNIX)

In signal route

Out signal route

In/out signal route

Internal signal route

Internal signal route (bidirectional)
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• Signal References in Flow Diagrams (i.e. references in flow dia-
grams; processes, process types and procedures).

The notation that is adopted differs slightly depending on the context.

A signal definition appears directly after the diagram identifier where 
the signal is declared. The signal is identified by its name and its loca-
tion to distinguish it from other items. 

The indentation is filled with blank space (see Figure 418).

A signal reference on a line uses a similar notation as for signal defini-
tions. The indentation consist of an arrow that identifies the direction of 
the signals (see Figure 419).

Signal references in flow diagrams are listed along with the context 
the signal is used. This is indicated by the following attributes (multiple 
attributes can be set): 

• Input1 
• Output 
• Reference to an undefined signal.

Figure 418: Signal definitions

Note:

Each signal appears only once within a diagram. If a signal is refer-
enced at least once within the diagram, it is not listed in the signal 
definitions section for that diagram, only references are listed.

Figure 419: Signal references on a line

1. Save of signal is also considered as input by the Signal Dictionary function.
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In the graphical notation on UNIX, these attributes are shown using SDL 
input and SDL output symbols, and a question mark for showing that 
the signal is not declared:

The textual notation uses the characters:

[I][O][?]

These characters appear at fixed positions. Where an attribute is not set, 
this is indicated with a hyphen (‘-’). See Figure 421.

Timer

A timer is handled identically as described in “Signal and Signal List” 
on page 1933. To indicate that the item is a timer, the graphical notation 
on UNIX uses the MSC symbol for timer.

In the textual notation, a ‘T’ appears as the rightmost attribute.

Timers can appear in the following contexts:

• Definitions of timers
• Set statements
• Reset statements
• Active statements.

Error Notification

If the SDL suite fails in extracting signal information from some SDL 
diagrams, the information contained in that diagram is not available to 
the signal dictionary function.

Figure 420: Signal symbols (graphical notation on UNIX).

Figure 421: An undeclared signal which is input and output

Figure 422: Timer symbol (graphical notation on UNIX).

?

Signal input
Signal output
Undeclared signal
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In the graphical notation on UNIX, this is indicated in the signal list by 
a “bug” symbol located to the right of the diagram names.

In the textual notation, this is indicated by an error message following 
the diagram name:

<diagramtype diagramname> :GrPrError

These error situations are either caused by:

• Syntactically incorrect SDL which causes the SDL suite to fail 
when converting the SDL/GR diagram to SDL/PR. 

• Syntactically incorrect SDL which causes the information server to 
fail when parsing the contents of the SDL/PR file. When possible, 
the signal definition field will contain a graphical reference to the 
source of error. Double-clicking that graphical reference will dis-
play the source of error in an SDL Editor window.

The error reports are listed in the Organizer low window. See also “Sig-
nal Dictionary Update” on page 1918.

Figure 423: Errors were detected when extracting signals 
(graphical notation on UNIX)

The SDL suite failed in extracting signal information from the process type dia-
grams Door, DoorLock and the block type diagram Doors (one level down in the 
SDL hierarchy)

Figure 424: Errors were detected when extracting signals

The current diagram (This diagram) is process type Door. The SDL suite could not 
convert this diagram to SDL/PR.
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The Signal Definition

The signal definition contains the following information:

• If a signal or timer is selected in the signal list, the signal or timer is 
listed with its parameters (see Figure 425).

• If a channel, signal route or gate is selected, the signal definition 
holds one or two lines of information. Each line contains a list of all 
signals that are conveyed (see Figure 426).

– The first line contains the signal list to the parent diagram

– The second line contains the signal list from the parent diagram.

• If a signal list1 is selected, the signal definition holds one line of in-
formation containing a list of all signals contained in the signal list. 
The syntax is

SignalListName = Signal1, Signal2,...,SignalN

Figure 425: Selection of a signal

The signal Display is selected. The signal definition shows the signal along with its 
parameters - one parameter of type Charstring in the example.

Figure 426: Selection of a gate

The gate D, which is an in/out gate is selected. The signal definition shows one line 
with all in-signals (Door, Display) and one line with all out-signals (OpenDoor, 
DoorNo) in relation to the parent diagram (Controller)

1. A signal list is identified with its name within parentheses, such as
(SignalListName)
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Menu Bars
The SDL Editor’s menu bar provides commands available in menus and 
menu choices for editing diagrams and pages of diagrams. Most of the 
functionality that the SDL Editor offers is contained within the com-
mands from the menu bar. The menu bar provides the following menus:

• File Menu
• Edit Menu
• View Menu
• Pages Menu
• Diagrams Menu
• Window Menu
• Tools Menu
• Help Menu

The File menu is described in “File Menu” on page 8 in chapter 1, User 
Interface and Basic Operations and the Help menu in “Help Menu” on 
page 15 in chapter 1, User Interface and Basic Operations.

In addition, other menus may appear; one is the Simulator menu which 
appears when you set breakpoints in the SDL Editor (see “Connect-To-
Editor” on page 2082 in chapter 50, The SDL Simulator).

Edit Menu
The Edit menu provides editing functions that you can perform on the 
objects in the drawing area. The Edit menu functions that are available 
differ depending on the type of diagram you edit, either:

• Interaction Diagrams
• Flow Diagrams
• Overview Diagrams

The Edit functions are as follows:

• Undo
• Cut
• Copy
• Paste
• Insert Paste (available on flow diagrams only)
• Paste As
• Clear
• Collapse/Expand
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• Redirect
• Bidirect/Unidirect
• Class...
• Flip
• Split Text
• Dash/Undash
• Mark as Important/Mark as Detail
• Mark Types...
• Drawing Size
• Select All
• Insert signal
• Complete Word
• Select Tail (available on flow diagrams only)
• Symbol Border Color > Set Color...
• Symbol Border Color > Set Default
• Symbol Border Color > <Color>
• Symbol Border Color > List All Colors...
• Symbol Fill Color > Set Color...
• Symbol Fill Color > Set Default
• Symbol Fill Color > <Color>
• Symbol Fill Color > List All Colors...
• Symbol Visibility > Hide
• Symbol Visibility > Show
• Include Expression

Undo

With this command you restore the content of the drawing area to its 
state prior to the operation you performed most recently. It is only avail-
able for operations on symbols, lines and text attributes. You can undo 
the following operations:

• Cut, Paste and Clear
• Flip, Redirect, Bidirect/Unidirect
• Adding Symbols
• Moving Symbols
• Resizing Symbols
• Drawing Lines
• Re-Routing and Reshaping Lines
• Resizing a Page
• Tidy Up.
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Cut

This command removes the current selection from the drawing area or 
text window, and saves it in the clipboard buffer. Also see “Deleting an 
Object” on page 461.

In text editing mode the command will work on the current text selec-
tion. 

Copy

This command makes a copy of the current selection, and saves it in the 
clipboard buffer. 

In text editing mode the command will work on the current text selec-
tion.

Paste

This command inserts the contents of the clipboard buffer into the draw-
ing area or text window.

No lines will be drawn between the pasted symbols and the symbols al-
ready present in the drawing area.

You can interrupt the Paste operation by pressing <Esc>.

Also see “Pasting an Object” on page 461.

In text editing mode the text contents from the clipboard buffer will be 
inserted at the current text insertion point.

Note: Undo for text editing

You can undo text editing operations in the text window, such as Im-
port, Cut, Paste, and Clear. There is also an Undo function available 
for text entered via the Grammar Help or Signal Dictionary func-
tions. See “Undo” on page 1964.

Note: Undo for Class Symbols

If a class symbol is cut and thus also cleared, Undo will be enabled. 
If the Undo command is used, operators will be restored, including 
their body code.
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Insert Paste

This function has the similar functionality as the Paste function, but is 
only available for flow pages. It inserts necessary space after the select-
ed symbol before pasting the clipboard buffer and connecting the two 
flows.

The function requires that the clipboard is not empty and that you have 
selected exactly one symbol or line. Otherwise, the menu choice is 
dimmed. The menu choice is also dimmed if connecting the two symbol 
flows would violate the Z.100 syntax rules.

The functionality differs depending on if you have selected a symbol or 
a line. If you have selected a symbol the pasted symbols are inserted fol-
lowing the selected symbol. If for example you have selected a decision, 
the Insert Paste command will create a new branch. Also if a line fol-
lowing the selected symbol joins another line and the selected symbol 
only can have one follower, the inserted symbols will be placed follow-
ing both the lines. 

If you have selected only a line the pasted symbols will be inserted onto 
that line. For example if a line following a decision is selected, the in-
serted symbols will be inserted into the selected decision branch.

Before inserting the selection, the SDL Editor allocates the necessary 
space by pushing the required objects downwards. If this is not possible, 
a dialog is displayed.

• Clicking Increase Page in the dialog transfers control to the Draw-
ing Size dialog, where you can specify the new width and height of 
the SDL page. The SDL Editor then carries on the operation and in-
serts the selection.

Note: Cut, Copy and Paste for Class Symbols

When a class symbol is cut or copied, defined body codes are saved 
on the clipboard, along with their operators. When a class symbol is 
pasted, previously copied body codes are inserted as well, unless an 
operator already has defined another body code.

If any operator will be deleted as a result of the operation, a warning 
is shown, the command is canceled and a dialog similar to the one 
in “Cutting, Copying and Pasting Class Symbols” on page 1851 is 
shown.
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Paste As

Pastes the currently copied object (from the OM or Text Editor) as an 
SDL object in the drawing area. The object is transformed and a link is 
optionally created between the copied and pasted objects.

The Paste As dialog is opened. See “The Paste As Command” on page 
448 in chapter 10, Implinks and Endpoints for more information.

Clear

This command removes the current selection from the drawing area or 
text window. The content of the clipboard buffer is not affected by this 
menu choice.

Also see “Deleting an Object” on page 461 in chapter 10, Implinks and 
Endpoints.

In text editing mode the current text selection will be removed.

Collapse/Expand

This command is available for symbols that can be clipped. These are 
the package reference symbol, additional heading symbol, text symbol, 
comment symbol and text extension symbol. A collapsed symbol has 
the minimum size and an expanded symbol will automatically adjust its 
size to the text.

Redirect

This command changes the direction of a selected channel, signal route 
or gate. The new direction is denoted by changing the orientation and 
position of the arrow, leaving the arrowhead pointing in the opposite di-
rection. Subsequent redirections result in the signal list toggling be-
tween two directions.

Note: Deleting Class Symbols

When deleting a class symbol, a warning dialog is shown if an op-
erator will be deleted as a result of this operation. See “Cut, Copy 
and Paste for Class Symbols” on page 1941.
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Bidirect/Unidirect

This command changes the selected channel, signal route or gate to be 
bidirectional/unidirectional. The Bidirect command will generate a new 
arrowhead and an empty signal list. The Unidirect command will show 
a dialog asking what signal list that should be kept.

Class...

This command opens up the Browse & Edit Class Dialog. The com-
mand is available only when a single class symbol has been selected. 
The command is not available if the class name contains incorrect syn-
tax.

Flip

This command creates a vertically symmetrical copy of the symbol(s) 
you have selected. It is valid on the following symbols only:

• Input symbol 
• Output symbol
• Priority input symbol
• Text extension symbol
• Comment symbol

The flow lines connected to a mirrored text extension symbol or com-
ment symbol are redrawn in order to reconnect them to the opposite 
side. 

Split Text

This command splits the text from a symbol and its associated text ex-
tension symbol (if any) into two parts, where the first part is placed in 
the symbol itself, and the second part in an associated text extension 
symbol. The split is done where the text insertion marker is, in the se-
lected symbol.

Note:

The only way to draw a channel from the environment to a symbol 
is to:

1. Draw a channel from that symbol to the environment
2. Redirect the channel.
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To place all text in an associated text extension symbol, place the text 
insertion marker first in the text for a normal symbol and invoke this op-
eration.

To remove an existing text extension symbol associated with a normal 
symbol, place the text insertion marker last in the text extension symbol 
and invoke this operation.

Dash/Undash

A dashed reference symbol is used in an SDL subtype when referring to 
an object that is defined elsewhere in one of the supertypes of the cur-
rent subtype. 

In a similar fashion, a dashed gate indicates that the gate is already de-
fined in one of the supertypes in the inheritance chain.

The Dash/Undash command is available on the following diagrams:

• System Types
• Block Types
• Process Types
• Service Types

The Undash is a toggle command.

Mark as Important/Mark as Detail

In the high-level view, only symbols which are marked as “important” 
will be shown. For more information, see “Show High-Level 
View/Show Detailed View” on page 1949.

Figure 427: A dashed process reference symbol and a dashed gate
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Symbols that are marked as “important” will be shown with border and 
fill colors different from ordinary symbols. These colors can be changed 
through the Preference Manager.

The Mark as Detail command sets the view status of a symbol to “nor-
mal”, meaning that it will only be shown in the detailed view.

Mark Types...

This command brings up a dialog with a list of symbol types. The se-
lected symbol types will be visible in the high-level view, while unse-
lected symbol types will only be visible in the detailed view.

Drawing Size

This menu choice sets the size of the drawing area for the current SDL 
page. A dialog is issued where you can type in the width and height. The 
values are saved on file when you save the diagram.

Select All

This command selects all of the text contained in the text window or all 
objects within the drawing area.

Insert signal

When an input or output symbol is selected this menu-choice will show 
a sub-menu with a list of signals available to the system. If an input 
symbol is selected it will list input signals and if an output symbol is se-
lected output signals will be listed. Selecting a signal will place it in the 
symbol.

Note:

Enlarging the drawing, the current SDL page may not fit any longer 
into the paper that is defined with the Print preferences; the result 
may be an SDL page that requires multiple sheets of paper when 
printed.
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Complete Word

Word completion helps you complete long words that have already 
been used in the same context. Type the beginning of the already used 
word and invoke word completion to get the rest of the word. If there 
are several ways to complete the word, the word completion operation 
will initially give you the common part of the possible completions. If 
you invoke word completion again, you will get one of the alternatives. 
To get another alternative, invoke word completion once more.

Word completion takes the word closest to the current cursor position 
and tries to complete that word by adding characters at the end of the 
word.

The word completion operation uses the following sources to look for 
already used words:

• The current diagram page.

• Pages in the beginning of the diagram. The number of pages that the 
word completion operation examines is determined by the prefer-
ence Editor*CompletionMaxPages.

• The names of entities listed in any running index viewer. This 
makes it possible to reuse names from other diagrams than the cur-
rent diagram.

• All words listed in the file .../sdt/include/keywords/sdl.txt in the in-
stallation. As default, this file contains SDL keywords.

Select Tail

This command selects the currently selected symbol and all objects be-
neath it within the tree (following the flow lines). 

Symbol Border Color > Set Color...

This command calls the color dialog where it is possible to set a custom 
color for the selected objects.

Note:

You can also complete a word by having the mouse pointer in the 
drawing area and pressing the tab key, provided that the preference 
Editor*TabEqualsCompletion is true.
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Symbol Border Color > Set Default

This command restores the default color for the selected objects. De-
fault color for Symbol borders are set by the Preferences.

Symbol Border Color > <Color>

This command sets <Color> for the selected objects. Default available 
choices are Black, Blue, Green, Cyan, Red, Magenta, Yellow, and 
White. Custom colors are added to the menu when they are first used. 
The most recently used color is moved to the top of the list.

Symbol Border Color > List All Colors...

This menu choice becomes available when a maximum of 20 used col-
ors has been surpassed. When you select List All Colors a dialog is is-
sued containing all colors that has been used in the current SDL Editor 
session and you have the possibility to set them for the selected objects.

Symbol Fill Color > Set Color...

This command calls the color dialog where it is possible to set a custom 
color for the selected symbols.

Symbol Fill Color > Set Default

This command restores the default color for the selected symbols. De-
fault fill color is set by the Preferences.

Symbol Fill Color > <Color>

This command sets <Color> for the selected symbols. Default available 
choices are Black, Blue, Green, Cyan, Red, Magenta, Yellow, and 
White. Custom colors are added to the menu when they are first used. 
The most recently used color is moved to the top of the list.

Symbol Fill Color > List All Colors...

This menu choice becomes available when a maximum of 20 used col-
ors has been surpassed. When you select List All Colors a dialog is is-
sued containing all colors that has been used in the current SDL Editor 
session and you have the possibility to set them for the selected sym-
bols.
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Symbol Visibility > Hide

This command hides the selected symbols. The hidden symbols will be 
replaced with a thick vertical line. The flow line structure will not be al-
tered. The [Screen, Print]Z100Symbol preferences makes the replace-
ment line as this as the flow line. See also Show hidden symbols and In-
clude Expression.

Symbol Visibility > Show

This command restores the selected symbols.

Include Expression

This command displays a dialog, where it is possible to specify the in-
clude expression that is presented above the top left corner of a symbol, 
for the selected symbols.

The include expression is a name of a boolean variable (or external syn-
onym). The value of the include expression is checked before analyzing 
an SDL system, when SDL/GR is converted to SDL/PR. Only those 
symbols that...

• have no include expression
• have an include expression that evaluates to true

...are included in SDL/PR and are visible for the analyzer and the code 
generator.

As default, all boolean variables have a value of false. To change a bool-
ean value to true, an external synonym file (a plain text file with exten-
sion *.syn) must be created and placed close to the SDL system in the 
Organizer. The external synonym file closest to the SDL system will be 
used. An external synonym file contains lines of name value pairs. For 
instance:

DEBUG true
VERSION1 false
VERSION2 true

Note that all lines going to a symbol that is removed, will also be re-
moved. An exception to this rule is that flow lines going to a symbol that 
will be removed, are reconnected to the first following symbol that will 
not be removed, if there is one and only one such symbol.

It is also possible to decide if SDL/GR symbols should be included or 
excluded in SDL/PR by hiding symbols. See “Analyze” on page 111 in 
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chapter 2, The Organizer, Symbol Visibility > Hide and Symbol Visi-
bility > Show.

View Menu
The View menu provides rescaling functions and access to various op-
tions that affect the behavior of the SDL Editor.

The following menu choices are available in the View menu:

• Set Scale
• Show High-Level View/Show Detailed View
• Temporary Colors > Remove
• Temporary Colors > Make Permanent
• Window Options
• Diagram Options
• Editor Options

Set Scale

Issues a dialog where you can adjust the scale.

Show High-Level View/Show Detailed View

The high-level view shows only symbols which are marked as “impor-
tant”, whereas the detailed view shows all symbols (normal view). This 
makes it possible to work with a less detailed version of the SDL dia-
grams.

By selecting the high-level view, only symbols which are either marked 
as “important”, or belong to one of the types selected in the Mark Types 
dialog, will be visible. Also, a tidy up operation will be performed, and 
the diagram will be read-only - all editing has to be done in the detailed 
view.

By selecting the detailed view, the diagram is reverted to the original, 
detailed view, where all symbols can be seen and edited.

Temporary Colors > Remove

Temporary colors are colors that are not saved in the SDL diagram. 
These colors are used by certain operations, such as SDL trace from 
SDL simulators and Compare Diagrams in the SDL editor, to highlight 
symbols of interest. Before doing a new operation that relies on color, 
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it might be useful to remove already existing temporary colors. This can 
either be done by using this menu choice or by closing down the SDL 
editor.

Temporary Colors > Make Permanent

Temporary colors are explained in Temporary Colors > Remove. This 
menu choice is used to convert temporary colors into permanent colors 
that can be saved in diagram files for future use.

Window Options

This menu choice issues a dialog where you set the options that affect 
the window properties.

• OK applies the options as defined in the dialog to the current win-
dow only.

• All Windows applies the options as defined in the dialog to all win-
dows opened by the SDL Editor.

• Tool Bar determines whether the tool bar should be displayed or 
not.

• Status Bar determines whether the status bar should be displayed or 
not. 

• Symbol Menu determines whether the symbol menu should be dis-
played or not.

• Text Window determines whether the text window should be visible 
or not.

• Page Breaks determines whether physical page breaks, with the ap-
pearance of dashed horizontal and vertical lines, should be dis-
played or not in the drawing area. These page breaks are defined by 
the print preferences; they show where the print utility will break the 
diagram into multiple printout pages.

• Show Grid determines whether the current symbol grid points are 
shown as small markers.

Diagram Options

This menu choice issues a dialog where you set the options that affect 
the editing properties applied on the current diagram.
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Interaction and Flow Diagram Options

A dialog with the following options is displayed on interaction and flow 
diagrams.

• Use Grid

This option determines whether or not the symbols that are added, 
resized or moved should adhere to the symbol grid or not. By default 
the symbol grid is active. 

By disabling the symbol grid, the SDL Editor will use the minimum 
grid of 5 * 5 mm.

• Layout syntax check

This option determines whether the SDL Editor should adhere to the 
formal SDL syntax rules regarding symbols and the connection of 
symbols. Ideally the layout syntax check should always be on. 

– Turning syntax checking off allows you to insert any symbol 
displayed in the symbol menu into the drawing area. In this 
mode, symbols can be interconnected in any manner. Further-
more, the connector symbol will always be treated as an incon-
nector in this mode. Therefore the Analyzer will detect errors 
when trying to analyze the diagram. To avoid problems turn off 
the syntax checking only if you want to draw diagrams that nev-
er should be analyzed.

• Textual syntax check

This option determines whether the SDL Editor should perform a 
syntax check on all the texts in the diagram. Ideally the textual syn-
tax check should always be on. 

– Turning syntax checking off disables the textual syntax check 
except for the kernel heading and the reference symbols which 
are always checked. 

• Additional Heading only on first page

Note:

Turning the switch from off to on will not perform a retroactive syn-
tax check for not allowed or interconnection of symbols. Only the 
objects that you add while syntax checking is enabled are checked. 
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This option determines whether the SDL Editor should present the 
Additional Heading symbol on each page. When the option is on, 
only the first page in the diagram will show the Additional Heading 
symbol.

The diagrams options are also saved on file when the diagram is saved.

Overview Diagram Options

A dialog with the following options is displayed on overview diagrams.

• Show line names

This option governs whether the names of lines (such as channels 
and signal routes) should be displayed or not.

• Show signal lists

This option governs whether the signal lists associated to channels 
and signal routes should be displayed or not.

The diagrams options are also saved on file when the diagram is saved.

Editor Options

This menu choice issues a dialog where you can customize the behavior 
of the SDL Editor.

The options are controlled by toggle buttons. They are:

• Always new Window

This option indicates whether or not a new window should be 
opened whenever you select the New or Open command or any 
command from the Pages menu. 

The default behavior is not to open a new window.

• Sound

This option indicates whether or not improper actions in the SDL 
Editor, such as attempting to overlap symbols, should be brought to 
your attention by producing an alert sound. 

The default value for this option is on.

• Show link endpoints
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This option indicates whether endpoint markers should be displayed 
for symbols having link endpoints. Regardless of the setting of this 
option, link endpoints are never shown when printed.

• Use tab key for word completion

See “Complete Word” on page 1946.

• Show hidden symbols

This option indicates whether hidden symbols should be displayed 
as a vertical line. If this option is selected hidden symbols will be 
displayed normally but filled with a grid pattern.

• Use informal view

This option sets the editor in Informal mode. In informal mode the 
content of the symbols is substituted with the content of the attached 
comment symbol, if any. The comment symbols are hidden. Sym-
bols without an attached comment symbol are displayed normally. 

• Show signal declaration

This option decides if the signal declaration including parameters 
should be shown in the message area when a signal name is selected 
by clicking on it in the drawing area. Turn this option off if you 
think it takes too long for the editor to find the signal declaration. 
There is a preference deciding the default value of this option: Edi-
tor*ShowSignalDeclaration.

Pages Menu
The Pages menu contains the following menu choices:

• First
• <Page Name>
• Last
• Add
• Edit
• Edit Reference Page

First

This menu choice opens the first page contained in the diagram. The 
first page is defined according to the order of appearance in the Edit 
Pages dialog. If the page is already opened, its window is displayed.
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<Page Name>

Activating the Page menu presents up to four menu choices that consist 
of the names of the two pages that are sequentially right before and after 
the page you edit. If you edit the first page of the diagram, the next four 
sequential pages are shown. If you edit the last page of the diagram, the 
previous four pages are shown.

When you select one of these page names, that page is opened or re-
stored in the SDL Editor. Use the Edit menu choice if you want open 
other pages.

Last

This menu choice opens the last page of a diagram. See “First” on page 
1953 for more information.

Add

This menu choice is a shortcut for adding one page to the current dia-
gram. The Add Page dialog is issued and when you click OK the new 
page is shown.

Edit

This menu choice opens a dialog where you can Add, Rename, Move up, 
Move down, Clear, Cut, Copy and Paste an SDL Page. See “Page Edit-
ing Functions” on page 1967.

Edit Reference Page

This menu choice opens (or, if already active, simply restores) the page 
in the parent diagram where the name of the current page is referred. 

This menu choice is dimmed when the current page is one of the pages 
contained in the Organizer Root Document (in which case there is no 
parent diagram) or the diagram being edited is not known by the Orga-
nizer. 

Diagrams Menu
The Diagrams menu records all diagrams and pages that are opened by 
the SDL Editor. 

• Back
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• Forward
• <Diagram Name>
• List All

Back

This menu choice opens the diagram that was previously visible in the 
same window.

Forward

This menu choice opens the diagram that was displayed in the window 
before you pressed the back button.

<Diagram Name>

The last edited page always goes to the top of the list, and subsequently 
moves the other diagrams and pages down a position. A maximum of 9 
open pages can be shown. A tenth one will be put at the top of the list, 
but any subsequent opening of a diagram or page will only show the last 
9 that have been opened. Another option – List All (at the bottom of the 
list) – is available to list all the open diagrams in the SDL Editor.

Each item in the menu provides information about the diagram type, its 
name, a slash (‘/’) followed by a page name, a hyphen and, possibly, the 
file it is stored on. A diagram that is preceded by an asterisk (‘*’) de-
notes that it has been modified during the SDL Editor session.

List All

This menu choice becomes available when a maximum of 9 open pages 
has been surpassed. When you select List All a dialog is issued contain-
ing all diagrams and pages that are currently open in the SDL Editor and 
you have the possibility to display them.

Window Menu
The Window menu contains the following menu choices:

• New Window
• Close Window
• Grammar Help
• Signal Dictionary
• Class Information
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• Entity Dictionary
• <Window Name>
• List All

New Window

This command opens a new window containing a new view on the SDL 
page contained in the source window from where you selected this 
menu choice. You can edit the SDL page in any window.

Close Window

This option closes the open window, but, does not close the diagram. 
All but the last open window can be closed, the last one you must close 
from the File menu, possibly in conjunction with saving information 
(see “Close Diagram” on page 14 in chapter 1, User Interface and Basic 
Operations).

Grammar Help

This menu choice opens the Grammar Help window, see “Grammar 
Help and Signal Dictionary” on page 1905. Its purpose is to assist you 
in editing SDL textual elements that are correct according to the SDL 
grammar. 

Each SDL Editor window has its associated Grammar Help window.

The SDL Editor tries to open a file with grammar help templates when 
opening the Grammar Help window (which file to open by default may 
be specified as an SDL Editor preference). If the file cannot be located, 
a dialog is issued where you can choose to select it manually. The filter 
in the file selection dialog will be set to *.tpl.

Signal Dictionary

This menu choice opens the Signal Dictionary window, see “Using the 
Signal Dictionary” on page 1917. It gives access to information about 
what signals are defined in an SDL hierarchy. Each SDL Editor window 
has its associated Signal Dictionary window.

Class Information

Opens the Class Information window. See “Class Information” on page 
1876 for more information.
1956 ,um-st1 Telelogic Tau 4.5 User’s Manual July 2003



 Menu Bars
Entity Dictionary

Opens the Entity Dictionary window. See “The Entity Dictionary” on 
page 434 for more information.

<Window Name>

If more than one editor window is open the other windows are listed 
here. The behavior of this list will be similar with the diagrams list in 
the Diagrams menu. The only difference is that the menu items will not 
provide the diagram file information. 

List All

This menu choice is available only if more than 9 editor windows are 
open, and has the same functionality as the List All menu command in 
the Diagrams menu.

Tools Menu
The Tools menu contains the following menu choices:

• Show Organizer
• Link > Create
• Link > Create Endpoint
• Link > Traverse
• Link > Link Manager
• Link > Clear
• Link > Clear Endpoint 
• Search
• Spelling > Comments
• Spelling > All Text
• Tidy Up
• Connect to Text Editor
• Navigate
• Show > Definition of X
• Show > Use of X
• Show > Definition or Use of X
• Show > Next (Definition or Use of) X
• Show GR Reference
• Create Bookmark
• Compare Diagrams
• Merge Diagrams
• Add Differences
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• Generate PR

Show Organizer is described in “Show Organizer” on page 15 in chap-
ter 1, User Interface and Basic Operations and the Link commands are 
described in “Link Commands in the Tools Menus” on page 442 in 
chapter 10, Implinks and Endpoints.

Search

This menu choice opens a dialog that allows you to search for a text in 
the current diagram or document in any editor. You can search many di-
agrams and documents at the same time with this menu choice.

For more information about searching, see “Search” on page 140 in 
chapter 2, The Organizer and “Searching and Replacing Text” on page 
1896.

Spelling > Comments

Check the spelling of comments in the current diagram. For more infor-
mation about the spelling operation, see “Spelling > Comments” on 
page 144 in chapter 2, The Organizer.

Spelling > All Text

Check the spelling of all text in the current diagram. For more informa-
tion about the spelling operation, see “Spelling > Comments” on page 
144 in chapter 2, The Organizer.

Tidy Up

This menu choice rearranges the graphical layout of the entire SDL di-
agram, using default layouting algorithms when calculating the location 
and size of graphical objects. Before the tidy up operation is started, a 
dialog appears where you can adjust parameters to the operation:

• Start transition on new page. Decides if a state symbol representing 
the beginning of a new transition should be placed on the same page 
as already placed symbols, or on a new page.

• Use extra space after comment and text extension. Decides if a sym-
bol in a flow, after a symbol with an associated comment or text ex-
tension, should be moved below the associated symbol or not.
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• Format input and output text. Decides if text in input and output 
symbols should be reformatted or not. If the text is reformatted, the 
signal name is placed in the symbol, while any parameters are 
placed in a text extension symbol.

• Replace textual comments with comment symbols.

• Place comment symbols to the left.

• No text extension for state. Decides if text extensions should be used 
or not if the state name does not fit in the state symbol.

• No text extension for decision. Decides if text extensions should be 
used or not if the decision text does not fit in the decision symbol.

• Sort states and transitions. Decides the order state symbols (More 
precise: state and input symbol combinations) will be presented in 
the resulting diagram. 

Connect to Text Editor

This command issues an external text editor and creates a temporary file 
from the currently selected text. After this you can only edit the text 
from the external editor. The SDL Editor is updated every time the ex-
ternal text editor saves the temporary file. When you no longer edit the 
temporary file the editing control returns to the SDL Editor. 

Which external text editor you are to use is defined by the preference 
SDT*TextEditor.

Navigate

This command navigates to another diagram or to another symbol with-
in the current diagram, depending on the selected symbol. It is available 
for the following symbols:

• For a reference symbol it will show the diagram being referenced.

• For an instantiation symbol it will show the corresponding type di-
agram. If there is more than one diagram that matches the type 
name, a dialog will appear where you can select one of the dia-
grams.

• For a create request symbol the process diagram for the created pro-
cess will be shown. If the diagram is ambiguous a selection dialog 
appears.
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• For a procedure call symbol the procedure diagram will be shown. 
If the diagram is ambiguous a selection dialog appears.

• For a macro call symbol the macro definition will be shown.

• For a state symbol another state or nextstate symbol using the same 
state name in the same diagram will be shown. A selection dialog 
will appear if there are more than one occurrence of the name.

• For an inconnector symbol the corresponding outconnector symbol 
will be shown. If more than one outconnector exists a selection dia-
log appears.

• For an outconnector symbol the corresponding inconnector symbol 
will be shown.

• For a class symbol, another class symbol, using the same class name 
in the same diagram, will be shown. If there is more than one occur-
rence of the name, a select dialog is shown.

Double-clicking a symbol will have the same effect as using the Navi-
gate command. This applies to all navigable symbols, except class sym-
bols.

The Show Sub-menu

All menu choices in the Show sub-menu require a running index viewer 
loaded with an up-to-date cross reference file. You can get this for all 
SDL systems that passes through the SDL Analyzer, by pressing the 
Generate Index quick-button in the Organizer.

Show > Definition of X

This command takes the name of the word closest to the current cursor 
position as input. If the name represents an SDL entity listed in the in-
dex viewer, the SDL Editor will navigate to one of the definitions of that 
entity. Usually there is only one definition to show, but for states, each 
state symbol is considered to be a part of the definition and one of them 
is shown. If you invoke this command once more for the same state 
name, another state symbol is shown (if there are several).

Show > Use of X

This command takes the name of the word closest to the current cursor 
position as input. If the name represents an SDL entity listed in the in-
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dex viewer, the SDL Editor will navigate to one of the uses of that enti-
ty. If you invoke this command once more for the same word, another 
use of that entity is shown (if there are several uses),

Show > Definition or Use of X

This command takes the name of the word closest to the current cursor 
position as input. If the name represents an SDL entity listed in the in-
dex viewer, a dialog is opened, allowing you to navigate to one of the 
definitions or uses of that SDL entity.

Show > Next (Definition or Use of) X

This command repeats the last Show > Definition of X, Show > Use of 
X or Show > Definition or Use of X command using the same word as 
last time as input.

Show GR Reference

This command issues a message where the graphical SDT reference for 
the object you have currently selected is displayed.

The syntax of the graphical references used in the SDL suite environ-
ments described in chapter 19, SDT References.

Create Bookmark

This command creates a bookmark in the Organizer for the object you 
have currently selected.

Compare Diagrams

With this menu choice you can compare the contents of two SDL dia-
grams. See “Comparing and Merging Diagrams” on page 1970.

Merge Diagrams

With this menu choice you can compare the contents of two SDL dia-
grams and create a new diagram by merging the two SDL diagrams. See 
“Comparing and Merging Diagrams” on page 1970.

Add Differences

With this menu choice you can merge two SDL diagram versions into 
one. The SDL diagram that is visible in the editor when the operation is 
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invoked will be updated with information from the other version, for all 
differences. Symbols from the other diagram might be placed slightly to 
the left of the original place, to avoid overlapping symbols.

Differences are marked with temporary color, except for complete page 
differences when a complete page is missing in the other diagram. The 
reason for this is to support merging of a complete diagram (the SDL 
diagram in the editor) with diagram parts (containing a subset of all pag-
es in the complete diagram) that might be slightly different.

In the Add Differences dialog, it is possible to specify the other diagram 
to compare with, either by specifying a file name or by specifying an-
other editor buffer. The Add Differences dialog also makes it possible 
to specify the temporary colors to use for highlighting differences.

Generate PR

This command will generate SDL/PR/CIF for the current diagram. A di-
alog with the following options appears:

• PR file

The name of the PR/CIF file to create.

• Generate GR references

This option will generate GR references that can be used to trace the 
PR code back to the GR diagram. 

• Generate CIF

CIF is the standard defined in ITU recommendation Z.106 to be 
used when transferring SDL/GR diagrams preserving the graphical 
layout. With this option set, CIF comments will be generated to-
gether with the PR.

The File Menu of the Text Window
The File menu provides functions that transfer text from a file to the text 
window and vice-versa. The basic intention is to provide you the possi-
bility to edit larger portions of text with a more suitable text editor (for 
instance signal definitions in text symbols). Another possibility to edit 
text externally is to use the Connect to Text Editor command in the 
Tools menu. 
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Import

Import imports the contents of a file into the text window and inserts the 
contents of the file at the text cursor position, possibly replacing select-
ed text in the text window. In the file selection dialog, the filter is set to 
*.txt by default.

Export

Export exports the selected text to a file. If no text is selected in the text 
window, the entire text window contents will be exported to the file. In 
the file selection dialog, the filter is set to *.txt by default.

Menu Bar in Grammar Help Window and Signal 
Dictionary Window
These menu bars contains the following menus:

• File Menu
• Edit Menu
• Select Menu
• Tools Menu

File Menu

The File menu contains menu choices that access files that contain SDL 
Grammar Help templates. 

These commands are useful only when requesting Grammar Help sup-
port. 

Load

This command opens a file selection dialog, where you can select and 
load the file with grammar help definitions. 

Grammar template files normally have the file extension .tpl. With the 
SDL suite, a standard template file, sdt.tpl, is enclosed. The SDL Ed-
itor attempts to locate a .tpl file each time you invoke the Load com-
mand. 

Any template definitions that are already loaded will be replaced by the 
contents of the selected grammar help definition file.
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Merge

Merge extends the current loaded grammar definitions with the contents 
of a grammar help definition file. 

This command issues a file selection dialog, in which you can select and 
add a set of custom templates to the basic set provided in the SDL suite.

Any template definitions that are already loaded will be extended with 
the contents of the merged template definition file.

Edit Menu

The Edit menu provides two utility functions that you can use when 
copying text from the Grammar window or the Signal Dictionary win-
dow to the SDL Editor’s text window. 

Undo

You can revert changes with the Undo command.

Insert

This menu choice copies the entire contents of the Grammar field or the 
signal definition and copies it into the text window at the current I-beam 
cursor location. Selected text will thus be overwritten.

A shortcut for Insert is to double-click on the template name in the name 
field.

Replace

This command replaces the contents of the text window with the con-
tents of the grammar field. This function is a shortcut for the following 
sequence: 

• “Select All, Clear and Insert” (Grammar Help) 

• “Select All and Insert” (Signal Dictionary)

Select Menu

The commands on the Select menu define what functionality the Gram-
mar Help window and the Signal Dictionary window should provide.
1964 ,um-st1 Telelogic Tau 4.5 User’s Manual July 2003



 Menu Bars
Each of the options can be individually turned on and off. In addition, 
an Options menu choice (see “Options” on page 1966) allows you to en-
able and disable multiple options in one command only.

The options that are currently enabled are indicated by an asterisk (‘*’) 
preceding the corresponding menu choice. 

When you invoke the Grammar Help, the Grammar option is enabled, 
while the remaining options are disabled.

These functions restrict or extend the scope of search for signals. The 
Signal Dictionary functionality can be extended to provide access to 
MSC Messages and an external signal library. 

Grammar

This toggle option, when set to on, will enable the SDL Grammar Help 
function. 

Up

This toggle option enables the Up option provided in the Signal Dictio-
nary window. This option displays the SDL signals that are available 
when looking one level up in the SDL hierarchy. 

This

Turning This on lists all signals that are used in the current diagram. 

Down

This option displays the SDL signals that are available when looking 
one level down in the SDL hierarchy. 

All

This option displays all signals that are defined and are visible accord-
ing to the SDL scope rules, starting from the root document (see “Root 
Document” on page 41 in chapter 2, The Organizer) in the SDL System 
Structure chapter.

MSC

This option displays all messages that are available in the Message Se-
quence Charts that are submitted as input to the Signal Dictionary func-
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tion. Each message is mapped to an SDL signal, with its parameters 
mapped to SDL signal parameters.

An MSC is submitted as input to the Signal Dictionary if associated to 
an SDL diagram that is present in the Organizer’s diagram structure.

External

This option displays all signals that have been imported from an exter-
nal signal dictionary. Importing external signals is done through the 
Telelogic Tau Public Interface. See “Load Definition File” on page 625 
in chapter 12, The Telelogic Tau Public Interface.

Options

Issues a dialog where you can turn on and off all options individually 
(see “Select Menu” on page 1964 for a description of the options). 

The default options for the Signal Dictionary are Up and Down.

Tools Menu

The Tools menu provide various convenience functions.

Show Editor

This command displays the parent SDL Editor window.

Show Definition

An SDL Editor comes up showing the definition of the item which is se-
lected in the signal list.
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Page Editing Functions
When you select Edit from the Pages menu, the Edit Pages dialog will 
be opened. In this dialog, you can add, rename, clear, cut, copy and 
paste an SDL page. The items in the dialog will be described below:

The Page List
This list includes all SDL pages in the SDL diagram. The operations 
available in the dialog, are only possible to perform if a page is selected 
in this list.

Edit 
This button opens the selected page in the SDL Editor.

Cut 
This button removes the selected SDL page from the diagram and saves 
it in the clipboard buffer. The information in the Organizer that is de-
pendent on this page, will also be removed.

If the page contains reference symbols and these have an underlying 
structure in the Organizer this structure will be restored when you paste 
the page in a new position. See “Cutting, Copying and Pasting Refer-
ence Symbols” on page 1851.

The button is dimmed if the object you have selected is not an SDL 
page. 

Copy 
This button copies the selected page to the clipboard buffer.

The button is dimmed if the object you have selected is not an SDL 
page.

Paste 
This button pastes a previously cut or copied page into the current dia-
gram. 

The Paste button will be dimmed if:
July 2003 Telelogic Tau 4.5 User’s Manual ,um-st1 1967



Chapter 44 Using the SDL Editor 
• The clipboard buffer is empty. 

• The current clipboard contents would lead to a syntax violation in 
the target diagram.

The SDL Editor checks that the contents of the page are syntactically 
correct. If required a warning will be issued. Then a new dialog is dis-
played, where you should assign the page a new name. You can specify:

• The new name of the page (two pages with the same name are not 
allowed within a diagram)

• Possibly, an autonumbered name (see “The Autonumbered Option” 
on page 1970)

• If the new page should be pasted before or after the current page

Clear 
This button removes the selected SDL page from the diagram. A confir-
mation dialog will be issued before the page is removed, and the SDL 
Editor will automatically rename autonumbered pages.

If the page contains reference symbols and these symbols have a sub-
structure, this substructure will be removed from the Organizer. As 
there is no undo for the Clear Page command, a warning will be issued 
and it is possible to keep the substructure as a new hierarchy instead.

Move up
If an SDL diagram page is selected and you click the Move up button, 
the page will be moved up.

Caution!

As stated in the dialog, Clear on a page cannot be undone.

Note:

The undo function in the Organizer and in the SDL Suite will have 
no effect on page moves. It is, however, easy to undo a page move 
operation by just moving the page back again.
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 Move down
If an SDL diagram page is selected and you click the Move down button, 
the page will be moved down.

Add 
This button opens a dialog where you can change some settings before 
new page is created:

• If autonumbering is turned off, you may specify any pagename, 
which must be in keeping with SDL conventions.

• If autonumbering is on (the default), the page is automatically 
named using the next available sequential number within the dia-
gram (1, 2, etc). 

• If the page is to be inserted before of after the current page.

• If you add a page to a process or process type diagram, you can se-
lect if the new page should be a graph page (the default) or a service 
interaction page.

• If you add a page to a block or block type diagram, you can select if 
the new page should be a block interaction page or a process inter-
action page.

New pages are listed in the same order that they were added.

Rename 
This button opens a dialog where you can rename the selected SDL 
page. If the page is part of a block or block type diagram, you can also 
change the page type (process interaction page or block interaction 
page) in this dialog.

Autonumbered pages cannot be renamed, unless you turn the option The 
Autonumbered Option off first.

Note:

The undo function in the Organizer and in the SDL Suite will have 
no effect on page moves. It is, however, easy to undo a page move 
operation by just moving the page back again.
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The Autonumbered Option
If the option Autonumbered is on, a numeric name (1, 2, etc) will be ap-
plied to the selected page. In a dialog, you can select to auto-number the 
selected page or all pages in the diagram.

The Open This Page First Option
If the option Open This Page First is on, the selected page will be the 
page that will be displayed by default when you open the diagram. Only 
one page at the time can have this option set.

Comparing and Merging Diagrams

Figure 428: The Compare Diagrams dialog
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When you select Compare Diagrams or Merge Diagrams from the 
Tools menu, a dialog will be opened where you can select the SDL dia-
gram to compare with. (It is also possible to compare more than one di-
agram pair in one operation, but to do this you should use the corre-
sponding menu choices in the Organizer. See “Compare SDL Dia-
grams” on page 146 in chapter 2, The Organizer and “Merge SDL 
Diagrams” on page 149 in chapter 2, The Organizer.   

Specifying the Diagram to Compare With
There are two ways for specifying the diagram that should be compared 
with the currently displayed diagram:

• You may specify the file in the Compare with file field.

• You may specify another diagram already opened the SDL Editor in 
the Compare with editor diagram field. When you click the folder 
button, a dialog will be opened with a list of all diagrams opened in 
the SDL Editor (except for the currently displayed).

Figure 429 The Merge Diagrams dialog
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The option Compare with editor diagram has the two restrictions:

– It can only be used if more than one diagram is opened in the 
SDL Editor.

– The folder button can only be used if more than two diagrams 
are loaded into the SDL Editor.

Selecting the Report Type
In the Compare Diagrams dialog, there are six alternatives for reporting 
differences between diagrams: Ignore white space and double space in 
text symbols, Textual Difference Report: Summary, Textual Difference 
Report: Details, Graphical Difference Report (with Merge Facility) and 
Select and Print Differences.

The Merge Diagrams dialog does not allow you to get a textual differ-
ence report. Instead, you always get a graphical difference report and 
the only option available is Auto-merge using original file.

Ignore white space and double space in text symbols

When this option is on, differences caused by different usage of white 
space are ignored when comparing texts. One space character is consid-
ered equal to two space characters.

Textual Difference Report: Summary

This option is only available when comparing using the Compare Dia-
grams menu choice.

A summary of how many differences that has been found is presented 
in the Organizer log. The summary may look like this:

Comparing /home/lat/x.spr
     with /home/lat/y.spr
27 differences (16 symbols, 11 lines) :
  7 changed objects (7 symbols, 0 lines)
  13 removed objects (6 symbols, 7 lines)
  7 added objects (3 symbols, 4 lines)

When you read this report, notice the following:

• 27 is the total number of found differences in this diagram pair. This 
is the total of all changed, removed and added objects.
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• An object is considered to be changed if you have moved or resized 
it, or if you have changed a text associated with the object.

If at least one of the two compared diagrams has more than one page, 
then a summary is also presented for each page pair. It may look like 
this:

Comparing /home/lat/version1/registeredcard.spt
     with /home/lat/version2/registeredcard.spt
5 differences (1 symbol, 4 lines) :
  1 changed object (1 symbol, 0 lines)
  2 removed objects (0 symbols, 2 lines)
  2 added objects (0 symbols, 2 lines)

Page details:

Page ValidateCard
5 differences (1 symbol, 4 lines) :
  1 changed object (1 symbol, 0 lines)
  2 removed objects (0 symbols, 2 lines)
  2 added objects (0 symbols, 2 lines)

Page RegisterMode
0 differences

Textual Difference Report: Details

This option is only available when comparing using the Compare Dia-
grams menu choice.

This option will print information about each found difference in the 
Organizer log. This makes it possible to navigate from the Organizer 
log to every found difference by using the Show Error operation in the 
Organizer log. See “Organizer Log Window” on page 179 in chapter 2, 
The Organizer.

The detailed textual difference report may look like this:

Comparing /home/lat/d1/db.sbk
     with /home/lat/d2/db.sbk

Comparing page 1

#SDTREF(SDL,/home/lat/d1/db.sbk(1),119(50,35))
ERROR This symbol has been changed...
#SDTREF(SDL,/home/lat/d2/db.sbk(1),119(50,40))
ERROR ...and now looks like this.

#SDTREF(SDL,/home/lat/d1/db.sbk(1),176(95,60))
ERROR This symbol has been removed.
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#SDTREF(SDL,/home/lat/d2/db.sbk(1),182(60,60))
ERROR This line has been added.

Graphical Difference Report (with Merge Facility)

The merge facility is only available when merging with the Merge Di-
agrams menu choice, but you can get a graphical difference report both 
when comparing with the Compare Diagrams menu choice and when 
merging with the Merge Diagrams menu choice.

Two SDL Editor windows, named Source 1 and Source 2, displaying 
the two diagram versions and their differences, and one dialog will be 
opened. For merge, there will be a third SDL Editor window, named Re-
sult, showing the merge result.

The Compare Diagrams dialog is similar to the Merge Diagrams di-
alog. The difference is that the Compare Diagrams dialog is missing 
the first row of buttons. (“<<“, Accept1, Accept2 and “>>”.)

In the dialog that will be opened, you can:

– Navigate between difference groups with the Next and Previous 
buttons.

– (Merge Diagrams only.) Navigate between unresolved (not-yet 
merged) difference groups with the “<<“ and “>>” buttons.

– (Merge Diagrams only.) Do a merge, i.e. update the merge re-
sult diagram with information from the current difference group 

Figure 430: The Merge Diagrams dialog
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and one of the compared diagram versions, with the 
Accept1/Reject1 and Accept2/Reject2 buttons.

– Compare or merge a text in a text symbol in the current differ-
ence group.

– Print the current difference found in the current page pair.

When the second compare dialog is closed, the editor windows are 
restored to how they appeared before the compare operation.

Comparing text in text symbols

When two text-symbols differ the CompareText button will be available 
in the Text Compare dialog and it will be possible to enter the text-com-
pare dialog.

The Text Compare dialog consists of two lists of text that are placed 
side by side with a “gutter” that will contain extra information about the 
differences. This gutter-information consist of:

– A “-” indicates that there is no corresponding line in the text 
compared to the other text. 

– A “|” character indicates that this line differs in the two texts. 

The current difference is indicated with a highlight. Buttons make it 
possible to navigate to Previous and Next difference item.
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Merging text in text symbols

When manual merges are conducted the option to merge text-symbols 
will always be available in the navigation dialog. When merging a but-
ton TextCompare button is available as in the compare function. When 
a text-symbol is selected there will be an option to select either symbol 
or merge the text in the symbols into a new symbol. 

If the text merge is selected a text-merge dialog is presented with three 
text-lists, the two source texts and the result text. It is possible to navi-
gate between the unresolved differences or between all differences.

Figure 431: The Compare Text Symbols dialog
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This works in the same way as in the normal merge. The buttons “<<“ 
and “>>” will jump between the unresolved differences and the Previ-
ous and Next buttons will jump between all differences.

The use of Accept 1/Reject 1, Accept 2/Reject 2 buttons will select nei-
ther, either or both the texts for merge. The selections from the source 
files are presented in the result-list the gutter will show what version is 
selected. Additional symbols in the result list are:

– A “|” character indicates that this line differs in the two texts.

– A “=” character indicates that the selected text are equal in both 
versions.

– A “>” character indicates that the right text has been selected for 
merge.

– A “<” character indicates that the left text has been selected for 
merge.

It is also possible to edit the result line-by-line by selecting a line and 
edit it below the list. Clicking the Change button will replace the 
changed line in the result list.

Figure 432: The Merge Text Symbols dialog
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Ignore moved or resized objects

If this option is on, the compare operation tries to ignore differences 
only caused by moved or resized symbols. You should only use this op-
tion if the two compared diagrams originates from the same diagram. 
(For instance, you have used Save as on the original diagram to get the 
second copy.) This option will not work well if you create two diagrams 
from scratch and compare them, because the operation uses object IDs 
to match moved or resized objects.

Select and Print Differences

If this option is on and there are differences, then a print dialog will pop 
up when the first dialog is closed. Only SDL diagram pages containing 
differences will be printed, and the differences will be highlighted with 
selection markers. If the same page containing differences can be found 
in both compared diagrams, then the two pages will be printed after 
each other, beginning with the page from the diagram that was visible 
in the editor when the compare operation was invoked.

Auto-merge using original file

This option is only available in the Merge Diagrams dialog. It allows 
you to specify the original diagram file that both the diagram versions 
that are compared originates from. If you specify the original diagram 
file, then the merge operation can auto-merge all non-conflicting chang-
es for you. Note that if you give the wrong original diagram, then the 
auto-merge operation may merge the two versions in the wrong way. If 
you do not specify an original diagram, then the merge operation leaves 
all merging of differences to you.

Differences That Will Be Reported
When you use Compare Diagrams or Merge Diagrams, all visual object 
differences will be found:

• An object that has been moved, resized, removed, added or painted 
in a different color.

• A text, associated with an object, that has been changed

An object is considered to be moved if it has been moved relative to the 
upper left corner of the diagram frame. This means that if you move the 
frame, it will have no effect.
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Diagrams are compared one page pair at a time. A page pair is one page 
from the original diagram and one page from the other diagram where 
both pages have the same name. If there is no page with the same name 
in the other diagram, then the complete page is considered to be a dif-
ference.

Difference Groups
Differing objects from the same page pair are grouped into difference 
groups. Two differing objects are placed in the same group if:

• The objects are from the same diagram and they are connected to 
each other. For instance, a flow line connected to a task symbol.

• The objects are from different diagrams and they would overlap if 
they were in the same diagram, that is, it would be impossible to 
place the two objects in the same diagram without changing the po-
sition within the diagram for one of them.

• The objects are from different diagrams and the difference opera-
tion can conclude that it is the same object that has been moved.

Color and the Current Difference Group
In the graphical difference report, all differing objects are given tempo-
rary background colors as specified in the initial dialog. As default, the 
color is green in the original diagram and magenta in the other diagram. 
Temporary colors are not saved in diagram files. How temporary colors 
are removed is described in “Temporary Colors > Remove” on page 
1949.

The dialog that will be opened during the graphical difference report, al-
lows you to navigate between difference groups using previous and next 
buttons. All objects in the current difference group are selected.

Normally, version 1 of the compared diagrams (the diagram that was in 
the SDL editor when the compare operation was invoked) is shown in a 
window in the top left corner of the screen. Version 2 (the diagram that 
was specified in the first compare dialog) is shown in the top right cor-
ner off the screen. For complete page differences (a difference where a 
page can not be found in the other diagram), the window that misses the 
page is hidden.
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Note that it is possible to manually edit the compared diagrams while 
the compare operation is ongoing. This can be seen as a light-weight al-
ternative to the full merge operation (described next).

Merging
During a merge operation, three windows are used in addition to the 
second merge dialog:

• The top left corner of the screen is used to show version 1 of the 
compared diagrams, in the editor window named Source 1. This is 
the diagram that was visible in the SDL editor window when the 
merge operation was invoked. 

• The bottom left corner of the screen is used to show version 2 of the 
compared diagrams, in the editor window named Source 2. This is 
the diagram that was specified in the first merge dialog as the dia-
gram to compare with.

• The right part of the screen is used to show the merge result dia-
gram, in the editor window named Result. This is a new diagram 
that has been created from the two compared diagram versions.

The second Merge dialog does not only have previous and next buttons 
to navigate between differences. It does also have Accept/Reject buttons 
and “<<“ (fast backward) / “>>” (fast forward) buttons. 

• Pressing Accept 1 (2) will add symbols to the merge result diagram. 
It is the symbols from version 1 (2) of the current difference group 
that will be added.

• Pressing Reject 1 (2) will remove symbols from the merge result di-
agram. It is the symbols that can be found in version 1 (2) of the cur-
rent difference group that will be removed.

• Pressing “<<“ (fast backward) will navigate to the previous unre-
solved difference group. An unresolved difference group is a differ-
ence group where both version 1 and version 2 are not accepted.

• Pressing “>>” (fast forward) will navigate to the next unresolved 
difference group.

Note that it is possible to manually edit diagrams while a merge opera-
tion is ongoing. This can be useful if you want the merge result diagram 
to look different from both version 1 and version 2 of the compared di-
agrams.

When the second merge dialog is closed, the editor will ask you to save 
the merge result by displaying a save dialog above the window with the 
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merge result diagram buffer. When the save dialog is closed, the editor 
windows are restored to how they appeared before the merge operation 
was invoked.

GR to PR Conversion
It is possible to convert diagrams from SDL/GR to SDL/PR. In the con-
version, SDL diagrams are translated from the binary files into PR files, 
possibly containing CIF information. All graphical symbols in that dia-
gram will be replaced by their corresponding keywords and any text in 
the symbols will be copied to the output file. When possible, the defini-
tions in the output file will appear in the same order as in the input. 

The conversion is used by the SDL Analyzer as the first step in the anal-
ysis process, and also by the SDT2CIF Converter to convert to PR that 
preserve the graphical layout information. You can also convert to PR 
by the Generate PR command in the Tools menu, or by using the Public 
Interface (see “GRPR” on page 626 in chapter 12, The Telelogic Tau 
Public Interface). 

The PR/CIF files produced by the SDL suite fill various purposes:

• As a way to export information to other SDL tools

• As a temporary storage format that is used as input to the static and 
semantic analyzer

• As a format that is suitable for reading by the user. To produce this 
format, the PR file should be pretty printed.

Mapping between GR and PR
The following list defines the mapping between the GR and PR forms:

• In general, when symbols of the same type are converted, symbols 
are ordered first of all by the page ordering within the diagram. 
Within the same page symbols are ordered such that a symbol with 
a low y-coordinate (closer to the top) will be converted first. If two 
symbols have the same y-coordinate the symbol with the lowest x-
coordinate is treated first.
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• When analyzing systems using macros, all macros are converted to 
PR before they are expanded. This restricts the usability of macros, 
for instance the number of inlets and outlets must be 0 or 1.

• A merge symbol (a flow line connected to another flow line) is 
translated to PR using join and label constructs. The labels intro-
duced will be named grst0, grst1, and so on, starting on grst0 at each 
diagram. In macro diagrams, the labeling is grst0%MACROID... If 
the label already exists in the GR diagram, the sequential number is 
incremental until the label is unique.

• A block diagram may contain a block substructure diagram without 
its frame and heading if the block diagram does not contain any def-
initions but the substructure. This rule is applied to all the pages in 
the block diagram that are of the block interaction type.

• When specifying a header in GR, it must be specified according to 
the PR syntax and the valid input signal set should be written into 
the heading symbol and not in a text symbol as specified by the GR 
syntax.

• References to graphical symbols, which will be used by the Analyz-
er in error messages, are stored in the PR file using SDL comments 
beginning with the character “#”. It is therefore recommended that 
you do not write comments beginning with “#”.

• To be able to perform a correct conversion of SDL/GR Substructure 
diagrams to SDL/PR, the enclosing diagram type, block/channel or 
block type, must be known. For a channel going to the environment, 
a name outside the frame must be a gate name, generating the via 
construct, if the enclosing diagram is a block type, and a channel 
name, generating connect statements, for other cases.

If nothing is known about the enclosing diagram type, it is assumed 
that the diagram is a block.

To resolve the ambiguity, a qualifier can be used in the kernel head-
ing to determine the enclosing diagram type. Alternatively the An-

Note:

The order in which text symbols are converted may be of impor-
tance when it comes to code generation issues. This is, in particular, 
applicable when using the SDL to C Compiler. Therefore, you 
should use one text symbol only for type definitions.
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alyzer directive #BLOCKTYPE can be used to indicate that the en-
closing diagram is a block type diagram. This directive should be 
added to the diagram kernel heading. 

Differences when generating CIF

In general the PR generated as input to the analyzer will be the same as 
generated for CIF but for some constructs there are differences due to 
language limitations or to get a better error detection.

• The conversion of a graphical comment symbol differs dependent 
on if the translation is made to CIF or not. When converting to CIF, 
the PR generated is the <comment> PR construct; in other cases, 
including when performing Analysis, the graphical comment is con-
verted to “/* text inside graphical comment symbol */”. 

• The SDL editor supports the possibility to place the comment sym-
bol without connecting it to another symbol. When generating PR 
without CIF this comment will be converted to PR as described 
above. When generating CIF the CIF comment will be
/* CIF Comment (500,100) Right */
/* text in unconnected comment */
This standalone nonstandard CIF construct will be recognized by 
the CIF2SDT application such that the original comment symbol 
will be restored in the diagram.

• In the SDL editor you can connect many comments to the same 
symbol. This is an extension to the SDL language. For this graphical 
construct there is no immediate translation to PR. When generating 
PR without CIF the comments are generated according to the note 
above and there will be no problems. However, when generating 
CIF the comment will be generated using the <comment> PR con-
struct. As there only can be one <comment> to each symbol there is 
no direct possible translation in PR for many comments. In this case 
the extra comment symbols are handled as if they were unconnected 
to the symbol. This means that when regenerating a diagram from 
the CIF code, the diagram will not be exactly the same as the origi-
nal diagram as the extra comments will now be unconnected.

• When generating non-CIF all unattached comments will be attached 
to a symbol that is closest to the comment. In this way the comment 
text will be generated as if the text belongs to this symbol.
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• There is a difference also for graphical connections. If a channel C1 
has a graphical connector to the outer channel outerC and another 
channel C2 also has a graphical connector to outerC, but the points 
where outerC is drawn is not the same, the conversion for CIF will 
contain two connect statements:

  /* CIF ... */
  connect outerC and C1; 
  /* CIF ... */
  connect outerC and C2; 

This PR will produce a semantic error according to SDL-92, but will 
be correct when using SDL-96.

When using non-CIF conversion, the two graphical connections 
will be combined into one statement, provided that the two texts 
specifying outerC are lexically the same, thus writing outerC in one 
text and out_\nerC in the other (\n is a newline) will not be treated 
as the same text. They are still considered the same if only the case 
differs.

connect outerC and C1,C2; 

• When PR is generated for a macrodefinition the macro inlet and 
macro outlet symbols will differ whether CIF is generated or not. As 
there are no corresponding PR to these symbols nothing will be gen-
erated when generating CIF except of course for the CIF statements 
itself. For non-CIF a note will generated indicating that these sym-
bols are present in the diagram.

/* Macro Inlet Symbol  */

A task having no text or having only a note/comment is allowed in 
GR. The correct PR correspondence is the compound statement 
construct having an empty statement

task { };

As this PR will restrict the use of the simulator command Next-
Symbol the PR generated for non-CIF is an empty informal text 

task ’’;

For CIF the compound statement will be generated.

• CIF generation for the class symbol is not supported. The genera-
tion for non-CIF is described in “Class Information” on page 1876.
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Error and Warning Message
This section contains messages that may be produced during the GR to 
PR conversion. 

When the Telelogic Tau Public Interface performs the conversion from 
GR to PR, the messages will be displayed in the Organizer log. The re-
ply message on the service will indicate that the conversion has been 
done and it will also contain the number of errors produced.

If the conversion for some reason fails, the reply message will contain 
a text stating the kind of problem that has occurred. See further the 
GRPR service in the Public Interface.

ERROR 5001 Unexpected end of flow

This message indicates that a symbol has been found that has no follow-
ing flowline and according to the SDL syntax there must be one. In ad-
dition to the error message the following line is generated in the PR:

***** Unexpected end of flow *****

WARNING 5002 More than one line entering macro outlet

This message indicates that inside a macro there are more than one line 
entering the macro outlet symbol. This situation should be avoided as 
this can lead to syntax errors (which are hard to track) if this macro is 
expanded inside decision branches.

The easiest way to avoid this situation is to add a no-action task symbol 
with the text ‘’ and use this as the last symbol in the macro. Let all lines 
enter this task symbol and add a single line between this task and the 
macro outlet.
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